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Viz World Client and Server User’s Guide

1 Introduction

This is the user’s guide for Viz World Client and Server.

This guide is designed to fit people with no or little experience in using Viz World, and
aims to help new users become familiar with the system.

This section contains information on the following topics:

e Related Documents

e Customer Feedback and Suggestions

e Customer Support Request

See Also

e About Viz World

1.1 Related Documents

For additional information, see the following documents:

* Viz World Classic User’s Guide : Information on how to create map templates using
Viz World Classic.

* Viz Artist User’s Guide: Contains information on how to create graphics scenes and
animations in Viz Artist.

e Viz Engine Administrator’s Guide: Contains information on how to install the Viz
Engine software and supported hardware. Viz Engine is the output engine used for
playout of graphics, video, images, SDI sound and sound effects.

e Viz Trio User’s Guide: Information on how to create real-time character generated
content based on templates and how to play out pages in shows based on these
templates..

e Viz Pilot User’s Guide: Information on how to create content based on templates and
how to play out elements in playlists based on these templates.

¢ Viz Multichannel User’s Guide: How to install, configure and use Viz Multichannel.

¢ Viz NLE Administrator’'s Guide: Information on how to use your graphics in a non-
linear editing tool.

¢ Viz Weather User’s Guide: Information on how to create real-time generated
weather information and interactive shows using branded maps.

For more information about all of the Vizrt products, visit:

e www.vizrt.com

¢ Vizrt Documentation Center

e Vizrt Training Center

e Vizrt Forum

1.2 Customer Feedback and Suggestions

We encourage suggestions and feedback about our products and documentation.
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To give feedback and, or suggestions, please identify your local Vizrt customer support
team at www.vizrt.com.
Click on Contact (top of page).

2. The Vizrt office which is nearest to your location will be shown, or select from the
list of Vizrt offices.

3. Click on the Contact button for the office you want.
Complete the required details in the window that opens.

Note: If this message is for Customer Support, and there is a Support Contract in
place, then click on the ‘For support requests, please visit our support portal’ link
in the message window.

A Vizrt representative will contact you as soon as possible.

1.3

1.3.1

1.3.2

Page 16

Customer Support Request

Support Requests are supported by Vizrt if Customers have a valid Service Agreement
in operation. Customers who do not have a Service Agreement and would like to set up
a Service Agreement should contact their regional sales representative (see Customer
Feedback and Suggestions).

When submitting a Support Request relevant and correct information should be given
to Vizrt Support, to make sure that Vizrt Support can give the quickest and best
solution to your Support Request.

This section contains information on the following topics:

e Before Submitting a Support Request

e Submitting a Support Request

e System Log Files

Before Submitting a Support Request

Before a Support Request is submitted make sure that you:

Read:

¢ The relevant User Guide or Guides (see Related Documents).

¢ The release notes

and Check:

¢ That the system is configured correctly

e That you have the specified hardware, tested and recommended versions

Always refer to your Vizrt Service Level Agreement document.

Submitting a Support Request

When completing a Support Request, add as much information as possible.

Content of a Support Request
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1.3.3

The report should contain information about these topics:

Problem description: Include a good description of what the problem is and how
to reproduce it. Remember to use simple English.

Screen shots and illustrations: Use to simplify the message, and/or
Scene archive: Use the scene to demonstrate the issue.
System log files: Send the System Log Files.

System dump files: Send the system dump files from the crash (e.g. Viz Artist
program folder <viz install directory>).

Note: Check: If the operating system is Windows 7 and up, dump files can be
stored at: <userdir>\AppData\Local\VirtualStore\<viz install directory> (check
user rights).

System Config file: Send the system config file (e.g. Viz Artist program folder <viz
install directory>).

Note: If the operating system is Windows 7 and up, the config file can be
stored at: <userdir>\AppData\Local\VirtualStore\<install_directory> (check
user rights).

Software configuration: Add exact versions of software (-build) used.
Hardware configuration: Add exact versions of hardware (-build) used.

System setup: Describe differences in the installation, if any, from the
recommended setup.

System Network: Add a description of how the network, bandwidth, routers, and
switches are configured.

Always refer to your Vizrt Service Level Agreement document.

To submit the Support Request:

vk wN e

On the www.vizrt.com page, click on Support.

Click on Report a case.

Click on LOG IN to login to the Customer and Partner portal.

At the top of the Case Management page, click on Report a Case.

In the online form complete the required minimum information (shown by a red
asterisk) and click SAVE.

In the saved Support Case that opens, complete the various text boxes and upload
any required documents, files, etc. (see Content of a Support Request).

To track the status of open support tickets, login to the Customer and Partner portal.
Add information or communicate about the cases directly with the support team.

System Log Files

The location of Viz log files is shown in the Viz Configuration, Local Settings.

sty

Verb
[ veise outpt 7 Include Date and Time | OpenéL Error Output (AMD) |

Plugin Temp. Folder ciftemp ™
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Check the Log Directory path (1) for the Viz Log files location.

2. If the path is empty the log files will be located in the Viz Artist program folder
<viz install directory>.

Note: Check: If the operating system is Windows 7 and up, log files can be
stored at: <userdir>\AppData\Local\VirtualStore\<install_directory> (Check
user rights).

Viz Render Log

* Name: VizRender_<timestamp>.log

* Purpose: Information on current status of the engine

Viz Trace Log

« Name: VizTrace_<timestamp>.vlog

* Purpose: Command trace that facilitates playback for error reproduction, contains
at most the last 500 commands

Viz Gui Log

* Name: VizGui_<version>.log
¢ Purpose: Information on Viz Gui errors

Viz Shaders Log

¢« Name: VizShaders.log
¢ Purpose: Information on shader compilation

Viz Console Log

* Name: Viz_<timestamp>.log

e Purpose: Log console output to a file when the engine is started without console (-
C option)

Viz Gui Connection Log

This Log is created if ‘Write GH Connection Log’ is active (see Viz Configuration, Local
Settings).

* Name: VizGuiConnection<timestamp>.log

¢ Purpose: Information on the Viz Graphic Hub database connection
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2 About Viz World

For many years Viz World Classic (formerly called Viz Curious Maps) was the
broadcast industry’s number one tool for the creation of branded 2D maps and
geographic animations

Now Viz World takes this to a new level by adding support for real-time 3D maps and
adding the option to extend it to a client-server solution.

Viz World takes branded map imagery and provides it to different clients that are
embedded within Vizrt’'s control applications like Viz Trio and Viz Pilot. Templates
created within Viz World can also be accessed by Viz Weather, Viz Artist, and even NLE
systems.

This tight integration allows users to seamlessly create branded, animated maps and
add them to graphic templates or insert them directly into a 3D scene. In addition,
high-resolution satellite imagery from around the world can instantly be browsed,
download and incorporated.

Viz World Client (WoC) integrates Viz World’s mapping ability and database into Viz
Artist and Viz Engine graphics. By utilizing a set of geographic referencing plugins and
the maps produced by WoC, the creation of location based graphics using maps, 3D
objects, texts, and so on, is seamless.

WoC includes a set of Viz Artist plugins and the Viz World World Map Editor (WME).
The editor is integrated into Vizrt products, simplifying production and control of the
graphics.

The WoC also includes the Map Designer for creating map templates on-the-fly, as well
as the Map Builder for creating animated scenes with single or multiple destinations.

Usage of WoC clients requires one or more Viz World Servers (WoS) installed,
running and connected to the network. WoS is a software module used for creating
template based maps and managing client requests. All the map styles, map projects
and designs are stored on the server. The server’s license determines the number of
concurrent client connections and the available data sets.

This section contains information on the following topics:

e Workflow
* New Features

2.1

Workflow

The basic workflow from design of templates to playout is as follow:

1. First step of the process is to create a single (or multiple) in-house map project
template that sets the look and feel of all the produced maps later in the
production chain. This is done using Viz World Classic (VWC), selecting for
example style and color on the selected map area, type of border lines, label fonts
and available marker icons.

2. The designed map project template is made available to users of Vizrt client
software via the Viz World Server (WoS).

3. A graphic designer creates Viz scenes that include maps, based on the same
map project template now residing on the Viz World Server. The designer has the

Copyright © 2016 Vizrt Page 19



Viz World Client and Server User’s Guide

option to create 2D or 3D labels and markers inside Viz, instead of using the ones
exposed in Viz World Classic.

4. Based on the Viz scenes, graphical templates can be made for other Vizrt

applications.

5. An editor opens a template, from for example the Viz Pilot or Viz Weather system,

and creates a map to fit the main news or weather story of today.

2.2

Page 20

New Features

¢ New database from Collins Bartholomew.
* DigitalGlobe Online:

* New DigitalGlobe Online service allowing access to global high resolution
imagery.

¢ FirstLook option - access to crisis event imagery from DigitalGlobe from inside
the Viz World workflow.

¢ Better support for online departments, allowing easy APIs into the Viz World Server
and Viz World data. This can be used to produce branded maps for the website.

* Atlas plugin now works with the Globe geometry plugin.
o Traffic:

¢ Improved street labeling with Street Labels.

» Traffic feed from Inrix.

¢ Improved server redundancy options:
e Priority mechanism for server.
¢ New low-cost backup server.

¢ Compensation for dead server licenses which allow other servers to use licenses
for servers that for some reason are not online/running.

* A secondary cache for failover or static local cache for improved loading time.
¢ Multi-language support:

¢ Unlimited number of languages.

* Switching language on the fly from WME’s context menu.
* New Viz World Plugin API.
* New Map Name Editor for quick editing of user names and languages.
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3 Requirements

This section describes the prerequisites such as the licensing, software and hardware
requirements.

This section contains information on the following topics:

e License Requirements

e Software Requirements

e Server System Requirements

e Ports and Connections

See Also

¢ |nstallation
e Configuration

3.1 License Requirements

The following licenses are needed to run Viz World Server and Viz Engine:

¢ A USB dongle license for Viz World Server
e A USB dongle license for Viz Engine

If you are using the old green Sentinel dongles, please update your Sentinel Super
Pro drivers to the latest version. If you are using the Aladdin dongles (usually blue),
please install the Aladdin Hard Lock driver.

The drivers are available in the Installers directory:

¢ 32 bit: c:\Program Files\Curious Software\Curious World Maps\Installers
* 64 bit: C:\Program Files\vizrt\Viz World\Installers

Note: Viz World Server is a feature included in the license file. If the server has
additional features enabled, make sure the new license covers those features as
well.

3.2 Software Requirements

To run the Viz World Client and Server, the following software is required:

¢ Viz World Client (Map Editor) 16.0

¢ Viz World Server 16.0 - It is recommended to install the server on a separate
machine.

¢ Viz World database 16.0
¢ Microsoft Visual C++ 2010 Redistributable Package

¢ Microsoft .NET Framework 4 or later is required for the Map Designer, Map Builder
and World Map Editor.
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For graphics design the following software and version numbers are needed.

e Viz Artist 3.3 or later

For a newsroom/control room the following application versions are required:

e Viz Trio 2.12 or later
¢ Viz Pilot 5.7 or later
e Media Sequencer 1.23 or later

3.3 Server System Requirements

Minimum configuration:

e CPU: Intel Core2 CPU, 2.0 GHz
* Memory: 4GB

* Hard disk space: A full installation requires 1.3 GB free disk space. Optional data
packages will require between 4GB to 500GB free disk space.

Recommended configuration:

e CPU: 2 x Intel i7 CPU (or equivalent Intel Xeon processor)
* Memory: 16GB

* Hard disk space: A full installation requires 1.3 GB free disk space. Optional data
packages will require between 4GB to 1000GB free disk space.

Note: When more than one server will be run on a single machine it is necessary
to use the recommend system configuration described above. See Server
Allocator Configuration.

Server Operating Systems:

¢ Microsoft Windows XP SP3 (32-bit)
e Microsoft Windows 7 (64-bit, 32-bit)
e Windows 2008/2003 server

Also note that fast and multiple CPU cores are the most important component of WoS.

3.4 Ports and Connections

The following describes all connections and default listening port numbers that are
important for any system/network administrator to know of. However, it is, if possible,
recommended to run the system on a network without firewalls.

102 (TCP) is a Viz World Server listener port for Viz World Client connections when
Server Allocator is not in use or only has one Viz World Server running.

103 (TCP) is a Viz World Server listener port for configuration tool connections to
the first Viz World Server instance (as configurations are controlled by the first server
instance).

10100 (TCP) is a Server Allocator listener port for Viz World Client connections, and is
only used in order for clients to get connection details about Viz World Server(s). The
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first client connection will always be diverted to port 102. In case of Multiple server
instances port numbers are assigned according to a predefined schema. In case there
is no Server Allocator, Viz World Server will itself switch to port 102.

10100 (UDP) is a Viz World Server listener port for Server Allocator communication.
10200 (UDP) is a Server Allocator listener port for Viz World Server communication.

Both UDP ports are internal ports used between the servers.

Multiple server instances

If a machine is running multiple Viz World Server instances every extra instance
(second and above) opens other ports by this formula:
* Viz World Server listener port (TCP): 10100 + ID - 1.

e Server Allocator listener port (UDP): 10200 + ID - 1 (this is an internal port
between servers) (where ID indicates the instance, e.g. 3rd server, ID = 3).

If four Viz World Server instances are configured, the following listener ports will be
used:

* 102 (TCP): 1st instance

e 10101 (TCP): 2nd instance

e 10102 (TCP): 3rd instance

e 10103 (TCP): 4th instance

e 10100 (TCP) : Viz World Client(s) connection to the Server Allocator.

e 103 (TCP): Configuration tool connection to the Viz World Server.

Internal ports used by Server Allocator and Viz World Server(s) to communicate
between themselves:

e 10100 (UDP): Server Allocator

e 10200 (UDP): 1st instance

* 10201 (UDP): 2nd instance

e 10202 (UDP): 3rd instance

e 10203 (UDP): 4th instance
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4

Installation

This section describes how to install and remove the components of Viz World Server
(WoS) and Viz World Client (WoC).

This section contains information on the following topics:

¢ Downloading the software

¢ Installing Viz World Server

¢ |nstalling Viz World Client

¢ |nstalling Photoshop Plugin

4.1 Downloading the software
Whilst you have an active map support contract, you have a personal login to the Vizrt
FTP server (first year support is included).
¢ Download the software from the Vizrt FTP at ftp://download.vizrt.com/ under the Viz
World folder.
Note: You will need to use an FTP Client to access this site and not a regular
web browser.
Please use the FTP server to find the latest Vizrt software releases, documentation,
help files, drivers and more. You can also use the FTP to upload and exchange files with
Vizrt.
4.2 Installing Viz World Server

Note: Before starting an installation, ensure that the Viz World Server USB license
dongle and license file are available.

For 64-bit systems, the Viz World Data and Viz World Server installers are required. For
32-bit systems, the Viz World Data, Viz World Classic and Viz World Server installers are
required.

This section contains information on the following topics:

¢ To install Viz World Data
e To install Viz World Classic

e To install Viz World Server

To install Viz World Data

1. Start the Viz World Data installer

2. Click Next

3. Click Install to begin the installation
4. Click Finish
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To install Viz World Classic

HwWw N

12.
13.
14.
15.
16.
17.

18.

19.

20.

Start the Viz World Classic installer

Click Next

Click Yes to accept the license agreement

Select destination directory, and click Next

* 32 bit: c:\Program Files\Curious Software\Curious World Maps
* 64 bit: C:\Program Files\vizrt\Viz World

Choose the components to install, and click Next

Select a start menu group, and click Next

Click Next to start the installation

Click Next to accept the Sentinel SuperPro Drivers installation
Confirm the installation of the Sentinel SuperPro Drivers

Click Finish

Optional: Install QuickTime if it is not previously installed.

* If a newer version of QuickTime is installed the installation will be stopped.

Tip: If you do not already have QuickTime installed you can download the
installer from the Apple website.

Click Next to continue

Choose setup language, and click OK

Click Yes to accept the license agreement

Choose destination folder, and click Next

Configure file and MIME types, and click Finish

Place the relevant Natural Earth files in the following location:

e 32 bit: C:\Program Files\Curious Software\Curious World Maps\MapData
\NaturalEarth

* 64 bit: c:\Program Files\vizrt\Viz World\MapData\NaturalEarth
Place any relevant street data in the following location:

e 32 bit: C:\Program Files\Curious Software\Curious World Maps\MapData
\StreetData

* 64 bit: c:\Program Files\vizrt\Viz World\MapData\StreetData
Place the large DEMGIlobal90m folder in a location of your choosing.

e Once Viz World Classic is up & running point the application to the data via
View\Options\Map Data\Locations\CDEM Data

Optional: Install the dongle driver in the following location:

* 32 bit: c:\Program Files\Curious Software\Curious World Maps
\Installers\AladdinHardLock
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* 64 bit: C:\Program Files\vizrt\Viz World\Installers\AladdinHardLock

» Installing the driver will allow Viz World Classic to detect and work with the
provided Vizrt dongle.

21. Start Viz World Classic.

To install Viz World Server

1. Run the installation file: VizWorldServer_x.x.x.exe
2. Click Next

3. Click Next to start the file transfer

4. Click Finish

4.3

Installing Viz World Client

Viz World Client (WoC) is used to integrate maps and geographical data into scenes. Its
components are the Map Designer , Map Builder, World Map Editor, Map Editor Classic
and design plugins.

Viz World Client (WoC) installs new components in two places.

¢ 32-bit system:

e Viz 3.x (C:\Program Files\vizrt\viz3\)

¢ Common files (C:\Program Files\vizrt\common\)
* 64-bit system:

¢ Viz3.x (C:\Program Files (x86)\Vizrt\Viz3\)

¢ Common files (C:\Program Files (x86)\Vizrt\Common\)

Select the installer settings that correspond to your Viz Engine (ie. 32 or 64-bit).

Use the bundle installer (which includes both 32 and 64-bit) for easier installation of Viz
Trio/Viz Pilot/Viz Weather clients when combining with a 64-bit Viz Engine.

There are two ways of installing the client; a standard installation which requires the
user to perform and confirm all actions during the installation, or a silent installation
that enables the user to install Viz World Client without using the installer’s dialog
boxes.

This section contains information on the following topics:

e To install Viz World Client

¢ To install the Server Configuration Tool

e To install Viz World Client in silent mode

¢ To remove Viz World Client

To install Viz World Client

Double-click the VizWorldClient_x.x.x.x.exe installer to start the installation
In the Setup Type window, select Typical, and click Next

Select the Yes, | want to restart my computer now option

Click Finish.

P w N
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To install the Server Configuration Tool

Double-click the VizWorldClient_x.x.x.x.exe installer to start the installation.
In the Setup Type window, select Custom, and click Next.

In the Select Features window, select the Viz World Server Config option, and
click Next.

Select the Yes, 1 want to restart my computer now option
5.  Click Finish.

To install Viz World Client in silent mode
A silent installation can be performed in two ways;
* a standard silent mode installation is performed by setting the /s flag before running

the installer.

¢ an advanced silent installation enables the user to perform a custom installation, by
creating an InstallShield Silent Response (ISS) file, should a Typical installation not fit
the requirements.

Installing Viz World may be done using Install Shield Silent setup files (i.e. *.iss).
* /r: Creates the response file. Default location for the setup.iss file is in the Windows
system folder.

e /s: Runs the installation in silent mode. Default location for the setup.iss file is in the
Windows system folder.

» /f1: Allows you to specify a different save and read location for the setup.iss file
(e.q. /s /f1“C:\Temp\setup.iss”). Always use an absolute path.

* [f2: Allows you to log the silent installation. Using /f2 you may also specify a
different log location (e.g. /s /£2“C:\Temp\setup.log”). Always use an absolute
path.

Before installing the client in silent mode you must record an installation:

Start Windows' command prompt
Go to the installer’s save location (e.g. ed C:\Temp\)
Enter the name of the installation file followed by /r
VizWorldClient x.x.x.xxxx.exe /r /£f1"C:\Temp\setup.iss"
4. Once recorded you can use the silent.iss file to install the client in silent mode:

VizWorldClient x.x.x.xxxx.exe /s /£f1"C:\Temp\setup.iss" /£2"C:\Temp
\setup.log"

IMPORTANT! Any unexpected events during silent installation may result in a
failure. Unexpected events can be, for example, needing to restart the computer
or Viz not installed in the default path.

To remove Viz World Client

1. Start the Client installer by either:

1. Start Add or Remove Programs and click the Change/Remove button next to
the Vizrt Viz World Client item, or

2. Run the VizWorldClient_x.x.x.x.exe installer file
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2. Select the Remove Installed Files option and click Next
3. Click Finish

4.4

Installing Photoshop Plugin

The Viz World Photoshop Plugin is used to integrate Viz World and Adobe Photoshop
files. Maps created with the Photoshop plugin will create a new file with separate layers
for every feature and detail on the map.

The scripts which are installed as part of the plugin are used to:

* Configure the different settings of the Photoshop Plugin.

e Open Map Editor Classic to select the desired map.

¢ Create the final Adobe Photoshop file and layers, based on the selection and
configuration.

Installed Files
The Photoshop plugin is installed under:

* C:\Program Files\Adobe\Photoshop\Plug-ins\Import-Export Or
* C:\Program Files (x86)\Adobe\Photoshop\Plug-ins\Import-Export

The file that is installed is
* VizrtMapImport.8ba
The scripts are installed under:

* C:\Program Files\Adobe\Photoshop\Presets\Scripts Or
* C:\Program Files (x86)\Adobe\Photoshop\Presets\Scripts

To install the Photoshop Plugin

Install Viz World Client (see Installing Viz World Client)
2. Double click the VizWorld-Photoshop-xxx.msi

Note: In order to support Adobe Photoshop 32 bit and 64 bit, there are two
different installers, (i.e. x86 and x64). Ensure you have the installer which
matches your Photoshop version.

3. Click Next
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5 Configuration

This section describes how to configure Viz World Server, Viz Engine, and Viz Artist, as
well as some useful cache settings.

This section contains information on the following topics:

e Server Configuration

¢ Viz Engine Configuration

¢ Viz Artist Configuration

e Cache Configuration

5.1 Server Configuration

The Server Configuration Tool is used to remotely configure the Viz World Server
settings.

The configuration tool is included when Installing Viz World Server and can also be
installed when Installing Viz World Client. From the Windows start menu, select:

¢ Server: Programs > Vizrt > Viz World Server > Server Configuration tool
¢ Client: Programs > Vizrt > Viz World Client > Server Configuration tool

Caution: The server is locked when using the configuration tool; hence, no client
connection will be accepted.

Note: When using Server Allocator with multiple servers, each machine running
the servers must be configured separately. Use the configuration tool to connect
to all the servers and configure them.

This section contains information on the following topics:

e User Interface

e Template

* Locations

* Logins

e License

* Maps

» Standalone Clients
e Symbols

e Timeouts
* Proxy Server
* Server Logging

See Also

e Server Launcher
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5.1.1 User Interface

s Viz World Server Configuration Tool EI@

File View
Map Server: <hostname:| Connect | |Disconnect

Locations
=I-Logins

- License
—I-Maps
- Database
- Database Features
- Disputed Regions
- Default Projection
- Map Legend
- Locations
- User DEMs
- Attribution
- Virtual Earth
- Digital Globe
- Display
- Street Admin
- Imported Data
- Roads & Chicklets
- Plugins
- Place Finder
—- Standalone Clients
‘- Export Folder
Export Formats
- Symbols
- Timeouts
- Proxy Server
- Server Logging

Ready

The server configuration window has two panes, the left pane displays the
configuration sections and the right pane displays the parameters of the selected
section.

Before using the configuration tool, a connection to the server must be established.
When a connection is established, the Connect button will be disabled and the
Disconnect button will be enabled. The right pane will be populated with the
parameters of the selected section.

When connected, the main configuration window appears as follows:

There are currently 0 other users [ Send Logoff Message ] [ Force Logoff ] [ Restart ]

Ready Ll |

¢« Send Logoff Message: Sends a logoff request will to the server. The server will
end the session normally.

¢ Force Logoff: Sends a logoff message to the server, ending the session
immediately.

* Restart: Restarts the server instantly. The configuration tool will be disconnected
from the server. When a Map Server is defined (see Server Launcher Configuration
tool), and more than one instance of Viz World Server is defined, all instances will be
restarted.

Note: Most configuration changes requires a server restart before they take
effect.
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Caution: When Viz Maps Server Config tool is running the server is locked. No
client connection will be accepted.

To connect to the server

e Enter the server name or IP address in the Map Server field, and click Connect.

5.1.2 Template

Project Template
The project template is used to specify the image size

and available styles for all dients. You should create
a template file using Curious World Maps.

C:\Program Files\Curious Software\Cu

Project Template Folder

The project template folder is used to contain
templates which any user can open.

C:\Program Files\Curious Software\Cu

* Project Template: Defines the default project that will be used by the server when
initially asking for a map or the client requests a project that does not exist.

* Project Template Folder: Defines the folder in which the project templates are
stored. When the user clicks the Open New Template button on WME's Map Tool
Options toolbar, the displayed templates list will be fetched from the template files
in the Project Template Folder.

5.1.3 Locations

The Locations section defines the path to required software components.

Locations for the installed components.

kML | C:\Program Files\Curious Software\Curious Wi

¢ Root: Defines the installation folder.
¢ Licenses: Defines the license file(s) folder.
* Settings: Defines the path to the settings folder.

5.1.4 Logins

The Logins > Users section displays the users configured on the server. Viz World
Clients use the pre-defined Guest user to log on to the server.

The Logins > Guest screen is used to set some of the guest user permissions.
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Allow Guest
Allow Guest Projects

Guest Project | ¢ \program Files\Curious Software\Curious We

Folder

Guest KML . i i " i 0 -
= C:\Program Files\Curious Software\Curious Wi

Allow <user name>: Allows the user to connect to the server when running WME
or Viz.

Allow <user name> Projects: Allows the user to access projects defined in the
<user name> Project Folder.

<user name> Project Folder: Defines the path to a folder containing the user’s
projects.

License

Thu Feb 11 11:37:33 2010 S

Viz CMS 10.0.0,2554 RC (Map DE v10.0)

00226490 PC [ License key: A392F PC

Hardware key found correctly.

537 queries sent to dongle. w

<

<

[ Add License From File... ] [ Dump License Info... ]

The License section displays information about the current server license and enables
the user to load other license files.

Add License From File: Opens a file browser that enables the user to load
additional license features from a different license file and to add it to the system.
After a new license file is added, the Apply button is enabled.

Dump License Info: Saves the license information, that is displayed in the text
box, to a file.

Apply: Applies the new license information to the system'’s license file.

To manually add a license file

Locate the License file (*.lic), copy and paste it into the Licenses folder:

32 bit: C:\Program Files\Curious Software\Curious World Maps\Licenses

64 bit: C:\Program Files\vizrt\Viz World\Licenses

To add a license file using the Maps Server Configuration tool

P w N

Start the server configuration tool.
Select the License section.
Click the Add License From File ... button.

Locate and select the file and click Open to add the new license file.
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e The license becomes visible in the Edit License window.
5. Click Restart to start the server with the new license.

To add a license file using Viz World Classic

iz Word Classic is unable to run as you do not appear to have a cument, valid
bcense.

To purchase a icense for this software, or request a time-imited
EVALUATION kicense enabling all features, please vist us at
www.vizr.com

BhemetID:  [a4badbfdd2 PC

License key: BIACT145B653C Viz
Hardware key found comecity

Hardware Key:

Ty

When starting Viz World Classic without a license, a window appears informing that a
valid license cannot be found.

Start the Viz World Classic application

Click the License button to open the Software License window

Click the Edit License File ... button to open the Edit License window

Click the Add License from a File ... button to browse for the License file (*.lic)

vk wiN e

Select the License file and click Open
* The license becomes visible in the Edit License window

o

Click OK to save the License. The license is saved to the License folder
Exit the application and run the Viz World Server.

5.1.6 Maps

The Maps section is used to define the following general map settings:

¢ Database
e Database Features

¢ Disputed Regions

» Default Projection
e Map Legend

* Locations

e User DEMs

e Attribution

* Bing

* Digital Globe

* Events

* Display

e Street Admin
* Imported Data
e Plugins

Copyright © 2016 Vizrt Page 35



Viz World Client and Server User’s Guide

¢ Place Finder

Database

Datal | Combination Database M

Shared User Map Data

User Map Details and Alternate Names are loaded from
text files created with Curious World Maps.

User Map Details are added using the New Detail button

C:\Program Files\Curious Software\Cu

Alternate Mames for map details can be setin the Map
Details Properties tab

C:\Program Files\Curious Software\Cu

Abbreviations

C:\Program Files\Curious Software\Cu

« Database: Select the data base type. It only displays location entries that are visible
in the map area.

* Shared User Map Data: Defines the source of data used by the database.

Database Features

Accented characters

() Remove non latin-1 accents on database load

() Remove non latin-1 accents if not supported by font

(%) Display Mull character where font does not support accented character
Database Features

The detailed databases contain additional features from sources that
may not accurately align with the base data. Reset this switch to hide
these features.

Use all data sources for searching

* Accented characters: Handles accent characters in labels such as ~ in Espaia.

¢ DataBase Features: Defines whether the WME search tool will use additional
databases in the system or only the Viz World database.

Disputed Regions

Region | Arunachal Pradesh M
Configuratior | Default M

* Region: Displays a list of the disputed regions defined in the system. Select one of
the disputed regions to be configured.

« Configuration: Displays a list of region and border options related to the selected
disputed region in the Region parameter. Select an option from the list and the
graphic display will change according to the selected option.
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Default Projection

[refault Projection

The default Frojection iz uzed when a client opens a template that
doesn't have a map layer

Globe v

Globe projection

Supports Geotiff export

Sets the default projection for when a client opens a template that does not have a
map layer. The following options can be set:

* Globe: Sets a globe projection.

¢ Cylindrical Equidistant: Sets an unprojected map. Longitude and latitude are
mapped directly into X and Y coordinates.

¢ Miller Equidistant (37 30): Relative distances are correct. Angles are correct
around 37 degrees 30 minutes North.

« Miller Equidistant (43): Relative distances are correct. Angles are correct around
43 degrees North. Minimum scale distortion over continents.

* Miller Equidistant (50 28): Relative distances are correct. Angles are correct
around 50 degrees 28 minutes North.

* Gall Isographic: Relative distances are correct. Angles are correct around 45
North.

 Lambert Cylindrical Equal Area: A cylindrical equal area projection which uses
the equator as the parallel of no distortion.

« Behrman Cylindrical Equal Area: A cylindrical equal area projection which uses
30 degrees North as the parallel of no distortion.

¢ Tristan Edwards: A cylindrical equal area projection which uses 37 degrees 38.3
minutes North as the parallel of no distortion.

¢ Peters: De-emphasizes area exaggeration in high latitudes.

* Gall Orthographic: A cylindrical equal area projection which uses 45 degrees
North as the parallel of no distortion.

« Balthasart Cylindrical projection: An orthographic projection onto a cylinder
secant at the 50 degrees parallels. It is cylindrical equal area, but distortion of
shape increases with distance from the standard parallels. Scale is true along the
standard parallels and constant between two parallels equidistant from the equator.
This projection is not equidistant.

¢ Mercator: Mercator projection. Scale and angles correct only at the equator. Very
distorted at the poles.

* Miller: Distances and angles are only correct on the equator. Shapes and areas are
distorted, especially at the poles - but less than with Mercator.

* Albers Equal Area Conical: A conical projection which is useful for maps which
are wider than they are high, such as the continental United States.

e Stereographic, Polar Stereographic (North and South): A projection which
has minimal distortion at the center of the map. Most useful for maps that are
zoomed to show whole countries.

* Transverse Mercator: A projection which has minimal distortion at the center of
the map. Most useful for maps that are zoomed to show whole countries.
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Map Legend

Default unit tittes for Map Legends
Km | km
Miles | miles
Metres | metres
Yards | yards

Feet |feet

Sets the default unit titles for map legends.
Locations

Locations for the installed components.
Changing these settings will require a server restart.

[ support Legacy Databases (World/Europe/USA)
World Data
Europe Data
USA Data
Combination | C:Program Files\Curious Software \Curious We
Relief Data | C:'\Program Files\Curious Software\Curious We

Street Data | C:'\Map_extras'Licensed Street Data
Disputed
Regions

CDEM Data | C:'\Program Files\Curious Software\Curious Wt

= Installed Imagery...

C:\Program Files\Curious Software\Curious Wt

The Locations parameters define the path to folders containing relevant data for the
specified parameters.

5| Natural Earth Imagery ===

Datasets
\:’ Microsoft Virtual Earth Ef:?r:;":iﬂogk View Dependent
I:l DigitalGlobe ..ine (Platinum) [resolstion s View Dependent
l: DigitalGlobe ... (US Domestic) f;:eor::tgng'ié View Dependent
Overlays
ﬂ 15m-BASE-N...m-Japan-CMR 17588 x 31841 11 Meters/Pixel | ''© color couection

% 45¢m-Minam...a-Japan-CMR 20748 x 12250 0.40 Meters/Pixels

? 45cm-Sendai-Japan-CMR 27646 x 36536 0.39 Meters/Pixels

g |:] ] Show all

Path: C:WWiet Software\Viz Curious Maps\JAPAN-CMP A 5 BASE Mothermn-Japan-CMBMT | Bt

The Natural Earth option can be used to add, remove and color correct global and/or
local CMR (Curious Multi Resolution) imagery. Global imagery is what is typically used

as base maps, whereas local imagery are more detailed imagery of local places (e.g.
coastal areas and cities).

See Also

¢ Open Street Map Downloader
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User DEMs

Imported DEM (Digital Elevation Model) Data
Imported Relief Data is stored in a directory as mipmap

files and can be shared amongst users if placed in a
shared directory.

C:'Program Files\Curious Software\Curious World Map:

Max undo disk usage (MB) 100 =

»

The User DEMs (Digital Elevation Model) define the path to a folder containing
elevation data.

Attribution

Set the position of the on-screen attribution by dragging
it to the desired position:

Qutput Attribution in this font: w

Defines where the attribution should be placed on the screen.

* Attribution image (gray rectangle): Sets the location of the attribution image on
screen.

¢ Output Attribution Font: Sets the font used for the on screen credit.

To position the attribution image

* Drag the gray rectangle that represents the attribution image area to the desired
position.

Bing

Bing Cache
Use this option to change the location of the Bing cache.

F:\MapData\PlanetObserver 15 Browse. ..
Empty Cache

Bing Connection

Test Connection

Bing Maps Platform (previously known as Virtual Earth) is a set of images (satellite and
others) stored on Microsoft’'s Bing Maps Platform servers. The images can be used by
Viz World Classic, but requires a credit mark (Attribution image) to be displayed on
screen.

* Bing Cache: Defines a cache folder for the images retrieved from the Bing Maps
Platform server.
« Empty Cache: Deletes all files from the cache folder.

« Bing Connection: Allows you to test that the Bing Maps Platform server is online.

Note: Microsoft Bing requires an internet connection and will not work without a
license.
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Digital Globe

Digital Globe Setting

Use this option to change the location of the Digital

Globe cache.

W \MapDataMaturalEarth\DigitalGlobe_Cache | Browse. ..
Empty Cache | Expiration Time 30

Use this option to change Digital Globe Url,

https:/services. digitalglobe. com fearthservice finmtsaccess @

Test Digital Globe Connection |

Use this option to change First Look Url,
http: ffwww. digitalglobe. comfirstiookrss/events.rss @

| Test First Look Connection ]

« Digital Globe cache: Sets the location of the digital globe cache. For reference,
see the Bing section.

+ Digital Globe URL: Set the URL of Digital Globe, allowing you to configure new
parameters if Digital Globe’s API changes.

¢ First Look URL: Sets the URL of First Look

Note: Digital Globe requires an internet connection and a license. If used without
a license a watermark will appear.

Events

Event Cache

Use this option to change the location of the event imagery cache.
C:\Program Files\Curious Software\Curious World Maps\Ma| |Browse...

Empty Cache

Providers

Digital Globe First Look Service /| Enabled

Test Connection

First Look Service by Digital Globe ® is an on demand access to fresh imagery taken
hours or days after an event happens. The Viz World Server fetches a complete list of
available event imagery from the service when Viz World Server is starts. From the Map
Editor’'s Images Tab you can search for, buy and add events images to the map.

* Event Cache: Sets the cache location for the event imagery files

¢ Providers: Lists the available event imagery providers. The check box Enabled
allows you to enable and/or disable the selected service. The button Test Connection
allows you to test the connection.

Proxy Settings
The Viz World Server should be allowed to access the following servers:

e http://www.digitalglobe.com
* https://services.digitalglobe.com
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Display

Alternate Label Display

Use this option to choose the order in which alternative
place and region names are presented.

M-Language v| |User v| |Standard v] |Abbreviaﬁon v| [Alternahe -

Street Data
[¥] Draw streets with square ends

[V¥] square ends for pre-connected data, round otherwise

Street Addres Format: -

Auto Feature Preview

Allow features from types
[¥] Country [¥] 5ub Region

[¥] other Road
| Primary Road

[¥] Main Road

[¥IRegion [#] Town 1K [¥] secondary Road

More Label Setting
[V] Automatically scale map labels - based on the default template size

|| Prefer Region Capital Label

[V] Fit Map By Width

* Alternate Label Display: Sets a custom language and defines the labels’ source
priority, effecting the list of label options displayed to the user. For creating multi-

language files and using them see the Map Name Editor and the Using the Map
Name Editor sections.

* Street Data: Defines the visual properties of street edges when drawn on the
maps.

Auto Feature Preview: Defines what features will be previewed in Viz World’'s Map
Editor (WME) when pressing the auto features button.

* More Label Setting:

* Automatically scale map labels: When this option is checked, changing the
size of a project or TPL label styles will also scale the labels proportionally. Note:

This only applies to label styles created in Viz World Classic and used with the
Map Editor Classic.

* Prefer Region Capital Label: When turned ON the auto-features will force

the type of feature to "Region Capital" instead of based on the feature size (e.g.
Town 1K, Town 1M) which is the default

* Fit Map by Width.
See Also

¢ Map Name Editor
¢ Using the Map Name Editor
e Maps Configuration
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Street Admin

Australia
Belgium
Denmark
Finland
France
Germany
Great Britain
Ttaly
Luxembourg
Metherlands
Morway
Portugal
Russia

Spain
Sweden
USAD7.02.01

O O O O 3 O B 3 I 3 R o e

The Street Admin section is used to display information about the loaded roads data in
the system and road data licensing information.

Re-Scan: When pressed, the configuration tool will check the loaded street data and
refresh the display.

Imported Data

Allows you to add shape files (shapes, lines, names and so on) which later can be
imported to Viz Artist through the Map Editor ( WME) and added to your map.

Plugins
A.wve | Plugin MName Version
Yahoo.wwp Yahoo PlaceFinder 1.00

Plugin : Yahoo PlaceFinder

Config :

| Active
A list of plugins that are used for searching the web (not the Viz World database).

Place Finder

Project and Style
Project Mame:
Style:

Map Size

Map width: Map Height:

Framing

Frame Map By: Search Result -
Degault Map Size [Deg):

Fegions and Labels
Add Regions: Disabled -
Full Description Labels

Add Search Label
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Viz World Server allows receiving maps of locations/features, same as the Place Finder
plugin. This can be used by Escenic or any other web application, or for demonstrations
of Viz World. For more information, see the Place Finder section.

51.7 Standalone Clients

A standalone client is an application running WME on machines without a Viz
installation.

« Export Folder: Defines the save path for standalone client applications.

Configuration for standalone dients

Export Folder | C:\Program Files\Curious Software \Curious We

* Export Formats: Image formats are presented to users when saving images. Add a
format for each combination of file format and compression options you wish to use.
The Options button allows you to set color (black and white, grayscale, 256 colors
etc.), and filter options.

Image formats are presented to users when saving images. Add a format for
each combination of file format and compression options you wish to use.

Export Formats | JPEG - Best (*.jpg)
IPEG - High (*.jpa)
JPEG - Medium (*.jpg)
BMP {*.bmp)

SGI Image (*.sqi)
Photoshop (*.psd)
Compuserve GIF (*.gif)
PICT (*.pct)

PMG (*.png)

TGA (*.tga)

QuickTime Image (*.qtif)
Compressed Tiff (* tif)

Geotiff (* 4if)
MName:
v
[ Georeferenced
|:| 3D Terrain w
Width 5 Height &5

5.1.8 Symbols

Symbols are created and exported from Viz World Classic, and can be imported using
the server configuration tool such that client users can add them to their maps.

See Also

e Symbols Tab
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5.1.9 Timeouts

User Timeouts
Users are automatically logged off after
10 2= minutes inactivity (Plugins)

£3
10 21| minutes inactivity (interactive navigator)

Periodic Restart

The server will only automatically restart when there
are no users connected.

Restart server periodically
(®) After 12 % hours

O atTme 00100 || time

This section is used to set server timeout values.

¢ User Timeouts: Sets the timeout values for clients logged onto the server:

¢ Minutes Inactivity (Plugins): Sets the timeout for client connections when the
WME is opened through the CMWClient plugin. If no map requests are sent to

the server during the period of time (in minutes) specified in this parameter, the
server will disconnect the client.

¢ Minutes Inactivity (Interactive Navigator): Sets the timeout for client
connections when an interactive Navigator scene is used. If no map requests
are sent to the server during the period of time (in minutes) specified in this
parameter, the server will disconnect the client.

* Periodic Restart: Enables automatic restarts of the server. It is mainly targeted
at 24/7 stations, where Viz Engines are up and constantly requesting maps. The
Automatic restart enables the server to restart at the specified time or after a
defined period of time, disconnecting all clients and clearing used memory. This is
important when the server is used heavily and a lot of maps are generated.

* Restart server periodically: Sets the server to restart periodically based on
the After or At Time parameters.

¢ After: Sets the amount of time (hours) for how long the servers should be
running before the server should be automatically restarted.

¢ At Time: Sets the time for when the server should be restarted.

5.1.10 Proxy Server

Proxy Account
MName:

Password:

This section is used to define the proxy server connection settings. Viz World Server will
connect to the internet to fetch data from Bing Maps Platform or Imagery on Demand
servers. If the system uses a Proxy Server that requires authentication, this page is
used to provide the login details for the Proxy Server.

¢ Name: Sets the user name.

* Password: Sets the user password.
See Also

* Bing
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¢ Digital Globe

5.1.11 Server Logging
Server Debugging
|:| Qutput messages in server log
This section defines whether or not the server will log system messages to a log file.
5.2 Viz Engine Configuration

For the Viz World Client to be able to connect to Viz World Server, a Viz Engine must be
present. Viz Engine has its own configuration tool (Viz Config) that is used to configure
the connection to the Viz World Server.

Before proceeding with the procedures, make sure that the following are installed:

¢ Alicense file (*.lic)
¢ A USB hardware dongle

Provided that project templates are available, the Viz Config window, after a successful
configuration, will look something like the picture below. It is recommended to set a
default project; however, this is not required. Project templates are made in Viz World
Classic by designers, offering different sets of maps, label styles and so on.

To configure Viz Engine

Map Server Active

Server bgooranged

Project VizDefProject.tpl

VizDetProject.tpl
VizDefProject' .tpl
Available VizDemol_CYL.tpl
VizDemol_MRC.tpl
WeatherNemn.tnl

Map Size Width ilﬂ Height ilﬂ
Cache Directory J

Memory (Images) “ilﬂ On disk (Days) ilﬂ

Wiz World Version 11.1 And Above

2nd Cache Directory

Priority “ilﬂ Network Monitor Active

Virtual Earth Attribution Dynamic Static
Attribution Font

Bold [on
Italic ﬂ
On Top ﬂ
On Right LOff |

1. Start Viz Config

2. Select the Maps section, and click the Active button to activate the configuration
window and connection.
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3. Enter the Server name of the map server (hostname or IP address).

¢ In a Server Allocator setup, with multiple servers and/or full redundancy, add
the map server names only separated by commafs).

Click Save and restart Viz Config.

Select the Maps section again, and select a Project template from the Available
project template list.

e This becomes the default map setting when using Viz World Client. It is
possible, in Viz World Client, to select alternative project templates.

6. Set the Default Width & Height which will set the default image size for the
maps.

¢ The image size can be changed by the CWMClient plugin in Viz Artist.
7. Save and close Viz Config.

5.3
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Viz Artist Configuration

This section contains information on how to configure the Viz Artist render engine.

Maps Configuration

Server

Project

Available

Attributions

Attribution Font Verdana
! Italic Off
off On Right Off

¢« Map Server: Enables or disables Viz World Server (WoS) connection for Viz World
Client (WoC).

¢ Server: Sets the Viz World Server host.

Note: If a Server Allocator is used, it should point to this location. See Server
Allocator Configuration.

* Project: Sets the default map project that will be opened with the client
application.

* Available: Lists all available Viz World Server projects.
¢ Map size: Sets the default map size that will be used with the client application.

e Cache: Enables caching of maps for faster preview and fetching of maps. Especially
useful for journalists and operators using Newsroom Component and Viz Trio
respectively.
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Cache Directory: Sets the cache directory for cached maps which can be a local
drive, mapped drive or a Universal Naming Convention (UNC) path.

IMPORTANT! Make sure the Cache Directory folder is configured with read and
write access rights.

Memory (Images): Sets the number of images to keep in memory.

On disk (Days): Sets the number of days to save images on disk.

2nd Cache Directory: Enables a second cache (see Cache above). The main
purpose of the second cache is to enable redundancy in those cases where a main
cache directory is on a different computer and for some reason fails. Another use
case is to use it as a local cache to save loading time (e.qg. if you load all borders for
the entire world you would have 100MB+ of cached files). In order to shorten load
time you can copy large static files to the correct local cache folder. In the 3D Map
Setting Plugin plugin you will also find a Sync Local Cache Folder button which will
copy all the needed files to your local cache. Note that the second cache directory
settings can only be used by Viz World version 12.0 and later.

Priority: Sets the machine’s connection priority to the Viz World Server (WoS).
Setting a number, where 1 is the lowest and 100 is the highest you may override
connection priorities set by other machines. The configuration interface will allow
you to prioritize client connections from Viz Artist and On Air Viz Engine’s used
for preview and program output. Viz Engines must be in On Air mode for them to
be prioritized. For Viz World’s Map Editor you can set it from the Context Menu. To
enable this behavior on the server side you need to enable WoS to prioritize its
connections/logins. For more information, see the Server Launcher Configuration
section. If the configuration option is not visible, please read how To add the
VizWorld.ini file and set the priority.

Network Monitor: Enables you to monitor relevant network connections (server
and cache folders). If you do not monitor the network and you try to connect

over a “disconnected network”, connecting to a server or a UNC path, it will take
time before the system reports back (e.g. 30 seconds or more). Enabling network
monitoring will avoid such connection issues. Note that the network monitor will
only monitor a cache folder that use a UNC path (not mounted/mapped drives). If
the configuration option is not visible, please read how To add the VizWorld.ini file.

Languages: Sets the current language to be used on labels fetched from Viz World
Server. For more information, see the Display section.

Attributions: Adds an attribution to the map. Alternatives are; Static and Dynamic.

¢ Dynamic: Displays the attribution when a licensed imagery is in view and
disappears when the image is out of view.

¢ Static: Displays the attribution as long as there is a licensed imagery in the
scene.

Attribution Font: Sets the font for the attribution.

Bold: Sets the attribution font to bold.

Italic: Sets the attribution font to italic.

On Top: Places the attribution image to the top in the screen. Default is bottom.
On Right: Places the attribution image to the right in the screen. Default is left.

To add the VizWorld.ini file

1.

Create a and save a VizWorld.ini file to the following location:
C:\ProgramData\vizrt\viz3\Maps
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2. Open the file and enter the following:

Monitor=1
Priority=1
Language=[my Language ID]

3. Save the file and start e.g. Viz Config to see the configurable parameters

Monitor enables network monitoring. See the Network Monitor setting, listed above.

Priority sets Viz’' connection priority to the Viz World Server. See the Priority
setting, listed above, and the Server Launcher Configuration section on how to enable
prioritized connections on the server side.

my Language ID refers to the order of languages in your list of languages (e.g. English
= 0, Arabic = 1, Hebrew = 2 and so on). See the Languages setting, listed above.

5.4

54.1
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Cache Configuration

When working with Viz World in a server/client environment, a cache is used to reduce
the load time of scenes in Viz. The cache is a shared network storage folder, common
to all Viz Engines in the system. The cache is managed by the Viz Engine machines.

Note: In complex environments, Viz Engine machines can be grouped so a
different cache is defined for each group.

This section contains information on the following topics:

* Map data flow
e Cache Location

¢ Defining the Cache

e Cache Folder Structure

e Caching - Viz Trio
e Caching - Viz Pilot

Map data flow

The maps data stored in the cache is produced by the Viz Engine machines, running
World Map Editor applications. When WoC is launched, it connects to the server and
enables the user to select a map and add information to the map. When the user
accepts the selected map (by pressing the OK button in the maps editor (WME)), the
map information will be sent to the scene (and to the relevant WoC plugins used in the
scene) from the server. WoC plugins will load the received data and then store it in the
cache. Now, when a scene is initialized, the WoC plugins will look for the data in the
cache and load it, without connecting to the server.

Since the most time-consuming task in this process is generating the maps, using the
cache reduces that time to a minimum and the maps are generated only once.

Note: Before setting a cache folder in a server/client environment, a shared
network drive, mapped on all Viz Engine client machines should be created. The
cache folder is defined on the shared drive, so all machines will have access to the
cache.
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5.4.2

5.4.3

Cache Location

The following are some simple guidelines that will ensure caching is optimized when
using one or several Viz Engines.
¢ One: Set the cache location local to that renderer.

« Two or more: Set the cache location to the map server (or other shared network
drive) so that one renderer is not favored over others.

Defining the Cache

The client cache is defined using Viz Engine’s configuration tool (Viz Config). When
configuring the cache environment make sure that the following parameters are
identical on all Viz machines:

e Cache Directory
¢ On Disk (Days)

Tip: Control clients should have their cache location(s) set to the same location as
defined by the Viz Engine(s).

To configure the cache directory

(Cache Directory c:ftemp/mapscachel

Memory (Images) 32 ;F On disk (Days)

1. Start Viz Config or open the configuration interface by clicking the Config button
on the main menu in Viz Artist

Select the Maps section

Set the Cache Directory to the defined shared network drive and the folder used
as the cache’s main folder

Note: The Cache Directory has to be identical on all Viz Engines that share
the cache. UNC paths are also supported.

4. Setthe Memory (Images) to the required value (default is 32). This parameter
defines the maximum number of map images stored in Viz memory when
initializing a playlist

IMPORTANT! Set the number of images to zero (or a low value) on control
machines used in the system. The control machines are inferior to Viz Engine
machines and it makes no sense to load a large number of images when it is
only used for preview.

5. Set the On Disk (days) parameter to the maximum number of days that the
images will be stored in the cache. When Viz is launched, it will clean the cached
map images that are older than the value defined in the On Disk (days) parameter

6. Click Save

To configure the 2nd cache directory

2nd Cache Directory c:ftemp/mapscache2

Priority =l MNetwork Monitor m
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1. Start Viz Config or open the configuration interface by clicking the Config button
on the main menu in Viz Artist

Select the Maps section

Set the 2nd Cache Directory to your local computer or a defined shared network
drive and the folder used as the cache’s main folder

Optional: Enable network monitoring
Click Save

See Also

¢ Viz Artist Configuration

Cache Folder Structure

When using cache in a client/server configuration, WoC plugins will manage the cache
and sort generated data in several folders under the cache folder. The cache folder
hierarchy is created automatically. Only the cache root directory is configured in Viz.
The defined cache folder for all clients is the root cache folder. Under the root cache
folder, a version sub folder is created using the WoC plugins version. Under each
version folder, several sub folders are created, according to the requested data:

+ 3DLine-Cache: Stores lines from the WME as OpenGL vertices.

+ 3DBorder-Plugin-Cache: Stores selected borders based on the Region-Cache
data.

* 3DRegion-Plugin-Cache: Stores selected regions based on the Region-Cache
data.

« AtlasCacheFolder: Stores Downloaded images from Microsoft to enable a smooth
animation and faster response time during navigation. Images are stored under sub-
folders according to the texture compression used.

« BorderManagerFullWorld-Cache: Stores unselected borders based on the
Region-Cache data.

¢ CWMClient-Cache: Stores map images and label information that is reused by Viz
when loading the scene.

* Region-Cache: Stores region vector data.
* Street-Cache: Stores street vector data.

+ StreetManager-Cache: Stores unselected streets based on the Street-Cache data.

Note: The 3DBorder, 3Dregion and BorderManagerFullWorld cache is based on
Region-Cache data after a projection is set, and converted to an OpenGL format.

Example: The country Norway will only have one cache file under Region-Cache
(since there is only one Norway), but could have many under other folders with
different projections.

General Caching Rules

The CWMClient-Cache folder is cleaned when Viz is launched (any of the Viz Engines
using the cache), according to the On Disk parameter value.
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5.4.5

5.4.6

The data in the cache folders (except for the CWMClient cache) are not deleted when
cleaning the cache since it does not change and it can be reused all the time.

See Also

¢ To configure the cache directory

Caching - Viz Trio

This section describes Viz Trio specific commands/actions that influence how map data
is cached when Loading pages, Initializing all pages and performing a Direct Take.

IMPORTANT! Set the same cache directory for the local Viz, and program and
preview channels.

Loading pages

Opening a scene for preview generates all cache files needed for the scene in the file
cache. Any change to the page through Viz Trio (CWM location, hop locations, labels,
selected regions and so on), immediately generates all required cache files. When
pressing Take, Viz Engine will load to memory all needed map cacheable elements
through the file cache that the preview machine just generated without the need to
connect to the map server.

Initializing all pages

The Initialize All button/command will load all scenes to memory (program & preview
renderers). All necessary map data will be loaded from the cache files.

Note: It is assumed that each page has been loaded in preview once before, and
that cache files have been created.

Direct Take

The Direct Take button/command will immediately load the scene into Viz Engine. All
necessary map data will be loaded from the cache files that the preview has generated
once.

Note: It is assumed that each page has been loaded in preview once before, and
that cache files have been created.

See Also

¢ To configure the cache directory

Caching - Viz Pilot

Caching of map data can be achieved by running Viz Pilot’s Thumbnail Generator on
the same machine as your Viz Engine.
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See the Viz Pilot User’s Guide on how to setup and configure the Thumbnail Generator.

When running Viz Pilot in a non-preview configuration, any change to any map element
that requires caching will not create cache files. This will result in longer loading time
of the Viz Engine because data maps, labels and polygon data has to be requested
from the map server. It is important to request at least a single image preview, such
that cache files will be created.

IMPORTANT! If you are running a local Viz, set the same cache directory for the
local Viz as for the program and preview channels.

See Also

¢ To configure the cache directory
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6 Server Operation

This section describes how to start Viz World Server (WoS) and how to use the Server
Launcher to start, stop and configure the WoS and Server Allocator.

This section contains information on the following topics:

e Starting Viz World Server

e Server Launcher

6.1 Starting Viz World Server

To start the Server

1. Double-click the desktop shortcut, or
2. Select the program from the Start menu.
* All Programs > Vizrt> Viz World Server

A console window appears that loads the database. When done, the server is ready to
receive requests from clients.

6.2 Server Launcher
( @ Viz World Server Launcher 12.0 EI_IéJ\

Viz World’s Server Launcher is a tool used to start, stop and configure the Viz World
Server and Server Allocator. In addition it will also start a process that generates
thumbnails of map templates used by the Viz World Client’s Map Designer tool.

This section contains information on the following topics:

e Using Server Launcher

e Server Launcher Configuration

e Server Allocator Configuration

6.2.1 Using Server Launcher

The Server Launcher is an application installed as part of the Viz World Server, and can
be found on the programs menu. The Server Launcher is run as a service by default.

When the Server Launcher is configured, the Server Allocator distributes client requests
between the registered servers and server machines, balancing server loads and

the number of client requests. When configured in a complex environment, multiple
map servers with multiple Server Allocators can be used to allow full redundancy and
optimal resource distribution.
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Starting a single instance of the maps server can be done from the program menu or
by using the desktop icon.

Starting the Server Allocator, in order to setup a redundant system and/or configure
more than one instance of the map server on one server, is done using the Server
Launcher.

When the Server Launcher is running it will typically be floating on top of the desktop;
however, it can be minimized to the tray.

Desktop Icon
B

The status of the Server Launcher is indicated by the color of the icon:

¢ Normal icon + green led = Licensed, running
¢ Normal icon + grey led = Licensed, not running

¢ Greyed icon + green led = Not Licensed, running (this only applied to Service
Allocator, since it is not licensed)

¢ Greyed icon + grey led = Not Licensed, not running

Tray Icon
The tray icon allows you to minimize the application to the tray and restore it.

Minimize To Tray
Stop Server

Options

Exit Launcher

Exit & Shutdown Server

* Restore / Minimize To Tray: Restores or minimizes the Server Launcher from or to
tray.

» Start / Stop Server: Starts and Stops the Server Allocators and the Viz World
Server without exiting the Server Launcher application.

¢ Options: Opens the Options window for configuring the number of Viz World
servers and Server Allocators. See Server Launcher Configuration for more
information.

« Exit Launcher: Closes the Server Launcher application. Server Allocator and Viz
World server will still be running.

¢ Exit & Shutdown (Not Recommended): Closes the Server Launcher application.
Stops all Server Allocator services and the Viz World server.
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6.2.2

Server Launcher Configuration
opions

rPreferences —————————
Local Server Count: |2 'l

[V Enable Priority lagin

Launch Options
7 Service

¥ | statt on sysbem startup

' Console Application
¥ Run Server Allacator

Mote ; Yiz World Server will stop if console is

r~ Controlled Wib'S

Count | Priority | Instances |
N I -

Machine

Machine | bgoarangez

hgoorangez

— El
Count z =
Priority I 1 =~ l —I
Instances I All Set

oK I Cancel |

Viz World Server is configured using the Server Launcher.

Click the Server Launcher’s Options button in order to configure the map server.

¢ Preferences: Allows the user to set the local
Allocator.

server count and enable the Server

¢ Local Server Count: Defines the number of server instances that will run on

the machine simultaneously. Default value

is 1. When setting the number of

instances for each machine, machine hardware should be considered. Every
server instance requires physical memory (RAM) and makes intense use of the
CPU. Do not abuse this parameter, since client and server performance will be

affected.
* Enable Priority Login: Enables Viz World

Server to prioritize its inbound

client connections. Viz’ configuration interface will allow you to prioritize client
connections from Viz Artist and On Air Viz Engine’s used for preview and program
output. Viz Engines must be in On Air mode for them to be prioritized. For the
Map Editor you can set it from the Context

Menu. For more information on how to

set priorities see the Maps Configuration section.

¢ Run Server Allocator: When disabled (not selected), the Server Allocator
will not run on the machine. When enabled (selected), the Server Allocator will

run and use the parameters defined in the

Server Launcher’s Options window.

Default mode is disabled. Server Allocator does not require any license and can

be run on any machine.

as a service, or in console mode. If run as a service, the system can automatically
start all server instances when the machine starts without the need to login. If run in
console mode, all instances must be manually started.

¢ Controlled WoS: When enabled (see Run Server Allocator), the Controlled WoS
settings allows the user to configure the controlled WoS instances.

¢ Machine: Sets the name of a machine running Viz World Server.

¢ Count: Sets the number of instances running on the machine. Default is 1.

e Priority: Sets the machine’s priority. If more than one machine is defined, the

priority must be set for each machine.
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¢ Instances: Sets the number of instances that are controlled by the machine.
If the machine has more than one instance running, it is possible to open the
Instance Control (click Set) To set the controlled instances.

Note: When the Server Allocator allocates a server to a client, it will pass this
name to the client, hence, its hostname/ip address must be accessible to all
clients.

Setting Priorities

Normally all servers will use the same priority (1). In more complex scenarios a lower
priority can be used, for example when two servers are running two instances each and
an allocator.

One server is typically dedicated to an On Air engine and another to a Viz Artist
(designer) client such that a designer client will not steal a token from an On Air
engine.

Example setup:

e Map server A is for the On Air engine and it controls two instances on map server A
with priority 1, and two instances on map server B with priority 2.

* Map server B is for the Viz Artist designer and it controls two instances on map
server B with priority 1, and two instances on map server A with priority 2.

The Server Allocator will not redirect any clients with map server A as default to map
server B if it can give them an instance on map server A because map server B has a
lower priority. So, only if the instances on A are out of license tokens, or not responding,
the Server Allocator will direct clients to map server B. And the same for B.

Another example is in a scenario where there are two allocators (one in Location 1 and
another in Location 2), all clients from Location 1 should be connected to the server

in Location 1, and all clients from Location 2 should be connected to the server in
Location 2, and only if any thing goes wrong should clients be allowed to connect from
Location 1 to Location 2.

Configuring the Server

To add or remove instances

e Click the + or - buttons in the Options window to add or remove instances.

To set the controlled instances

Instance Control |

Instance | Controlled |
1 Controlled
2 Mot Controlled

Cancel |

Click the Set button in the Server Launcher’s Options window.

Double-click the instance to set the control mode to Controlled or Not
Controlled.
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6.2.3

Copyright © 2016 Vizrt

3. Click OK.

Note: The number of controlled instances is displayed in the Instances field and
column seen in the Options window.

Server Allocator Configuration

Optimal usage of system resources can be obtained by using multiple map servers,
running multiple map servers on each machine, with a Server Launcher launched on
each of the machines.

The system can be configured with:

e one allocator for multiple map servers,
¢ one allocator on one machine with multiple servers, or
* multiple allocators with multiple server machines.

Single Server Allocator Configuration

The simple environment setup is when running one map server with multiple map
server instances and a Server Operation. In this configuration, the Server Allocator will
accept client requests and divert them to the server instances on the same machine.
Client connections will be equally divided between the map server instances, allowing
better response time and load balancing of server processes.

Multiple Server Allocator Configuration: Classic Redundancy

Having multiple servers, where in each there is a Server Allocator running that controls
all WosS instances of all machines.

This configuration guarantees most redundancy as each Server Allocator is updated
with the current status of all WoS servers, and in case of a failure in one of the
machines, other Server Allocators can provide redirection to any available WoS.

The maximum number of server instances that can be run per machine is 4. Each
server instance should have 4GB of memory and 2 CPUs. So on a machine with 4 dual
CPUs and 16 GB of memory you can run the maximum of 4 server instances.

Server Server B
Allocator

Allocator

Server A { Server

Viz World Wiz Woild Wiz Woild Wiz Woild Wiz World Wiz Woild Wiz Woild Wiz Woild
Server Server Server Server Server Server Server Server

The above diagram describes a system with two machines running a Server Allocator
and four map server instances on each machine. If the client is configured with both
machine names, full redundancy within the system will be accomplished.

Note: Any configuration combination between the Server Allocators and the map
server instances is valid.
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See Also

e Server System Requirements
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7 World Map Editor

The World Map Editor (WME) is a component of the Viz World Client. WME allows you to
browse and select map features, similar to those created using Map Editor Classic. In
comparison with Map Editor Classic, Map Editor offers almost the same features, which
allow you to create stunning maps in no time.

This chapter contains information on the following topics:

¢ Getting Started
e Tools

e World Map Editor Shortcuts

7.1 Getting Started

Once you have the Viz World Client installed you can start the Map Editor and connect
to the Viz World Server. Once connected you will be able to open existing design
projects.

To start the Map Editor

Normally the Map Editor will be launched from Viz Trio, Viz Artist or Viz Pilot.

To connect to Viz World Server

Note: When the Map Editor is launched from a Vizrt application (e.g. Trio, Artist,
Pilot), it will automatically connect to the server that has been configured within
that application, rather than the server configured within the Map Editor.

Start the Map Editor

2. Click the Settings button

3. Set the Viz World Server hostname. If not specified, the Map Editor will connect to
localhost.

4. Click Save
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7.2

7.2.1

Page 60

Tools

This section contains information on the following topics:

e Map Editor Toolbar
e Settings
e Search

e Layers
e Extra Data Manager

* Details

* Shapes Tool

e Streets Tool

e Show or Hide Map Features
¢ Quick Map

* Locator and Preview

¢ Preset Editor

¢ Multihop Editor

Map Editor Toolbar
The Map Editor has the following toolbars:

¢ Horizontal Toolbar

e Vertical Toolbar
¢ Quick Map Toolbar
e |ocator and Preview Tabs

Horizontal Toolbar

Natural Earth !. }"

The horizontal toolbar contains the following options:
° Save Favorites: Save current project as a favorite project. Unlike projects which
only contain the base map styling, a Favorite is a project which also has data saved
as part of it, such as selected countries, loaded streets, and labels.

Note: User favorites will not be synchronized across servers when working
with server allocator. When working with multiple servers, synchronizing user
favorites can be done as an automated process of replicating the relevant
folders. User favorites are stored by default under C:\Program Files\Vizrt\Viz
World\Users\Default\Favorites.

Open Favorite: Open a favorite project.

Open Project: Open existing map template files.
* Undo: Undo last change

° Redo: Redo last change
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Copy Map to Clipboard:

* Click the icon to copy the current map view, and its details, to a clipboard that
can be used later on when reopening World Map Editor.

e Select a previously copied map from the dropdown. The clipboard is a local list,
for the currently active directory.

¢ Delete an item from the clipboard list by right clicking an item and selecting
Delete from the context menu.

Search: Search the map.
Select stylesheet: Select one of the template’s available stylesheets.

If the stylesheet uses either Digital Globe or Microsoft Bing, an additional dropdown
will allow you to select the profile of imagery to use from the provider. The different
Profiles provide a different imagery set for the same location.

e _
DigitalGlob

Consumer v i Cylindrical Equidis
& 4 »

Consumer

True Currency

Cloud Cover ;
+ Vivid (Mot Licensed) +

Note: +Vivid provides a set of seamless tiles of imagery for every level,
however some images may not be the most recent imagery. The +Vivid
option on Digital Globe is a paid subscription, contact your local Vizrt Sales
representative if you require a license.

& Notifications: Displays notifications of errors.

Settings: Change the Settings (Viz World Server, Language, Map Legend, Safe
Guide)

H information: Displays version information about the Viz World Client and Server.

Vertical Toolbar

Tools

=

The vertical toolbar contains the following options:

Layers: Enables you to search for and filter features based on the current map
Layers in view.

Details: Shows the Details for all selected features. Right-clicking the button will
open a context menu that allows you to fit to, center to or clear all details.

Fl Pan: Enables the user to click and drag on the map to move the map in the
direction of the drag.

BY Zoom: Zooms the map according to the area selected. To select an area, click
and drag to draw a rectangle.
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.2 Shapes tool: Opens the Shapes Tool. Right-clicking the button will open a
context menu that allows you to select the shape.

I streets tool: Opens the Streets Tool

Inverse Colors: Toggle the color of the map legend and map features (countries,
cities, etc.) See Settings for how to enable/disable the map legend.

f show/Hide Features on Map: Click the button to show or hide the selected
map features. Click the arrow to select which map features to show. See Show or
Hide Map Features.

Quick Map Toolbar

Q ® World P | Australia P | New South Wales

Use this to access the Quick Map features.

Locator and Preview Tabs

Locator Preview

Use this to access the Locator and Preview features.

Settings

Settings

Server worldserver
Language English
Map Legend m

Safe Guide [0}

Save

Server: Set the Viz World Server hostname. If not specified, the Map Editor will
connect to localhost.

Language: Select from the available map languages. See Map Name Editor for
information on how to configure the languages.

Map Legend: Enable or disable the map legend.
Safe Guide: Enable or disable a safety area around the map (e.g. for text safety)

Search

Toronto Canada|

P Filter

¥ Toronto, Ontario, Canada

[ ] Toronto, Canada

» Web Results : 6
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7.2.4

The search option allows you to search for, and add notable locations to the map. The
map can then be fitted, or centered around these locations.

From the results list, each item has the options:

* /88 Add/remove the selected location to/from the map

& : Fit the map to the selected location

: Center current map view to the selected location

All locations that have been added to the map can also be edited from the Details view.

Layers

Places

= ‘ Places Streets Shapefile KML

Filter

Sort by: Type 4
Z Orade 3 or, Romania
7 Noj omania
# Sanmartin, Bihor, Romania

Displaying 3 features

Enables you to search for and filter features based on the current map layer in view.
You can also sort based on Country, Name, and Type.

Streets
Streets Shapefile KML First Look
Select Streets to Load ' Load Visible Streets

» Alba, Ro
» Arad, Ro

This tab allows users to load street data by clicking Select Streets to Load, and using
the Extra Data Manager, as well as add items to the map using the Extra Data Browser.

The roads in the visible map can be loaded into the list by clicking Load Visible
Streets.

Shapefile

Shapefile KML

This tab is to allow users to load Extra data such as Shape files.
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Streets Shapefile KML

Load Open Upload

The KML Manager lets you load Keyhole Markup Language (KML) files which can then
be added to the map. The KML file can be uploaded from the Viz World Server or
opened from a local file.

* Load: Load a file from the Viz World Server. Clicking the Load button, opens the
KML Browser and lists all the available KML files. It works the same way as the Extra
Data Browser.

¢ Open: Open a file from the file system, but do not copy it to the Viz World Server
* Upload File: Open a file from the file system and copy to the Viz World Server

Note: If the KML file includes a camera position, then the map will zoom to that
position, otherwise the map will focus on all of the data found in the file.

KML files can also be manually imported into the server, and must be placed in the
following folders:
e 32 bit:

e C:\Program Files (x86)\Curious Software\Curious World Maps\KML

* C:\Program Files (x86)\Curious Software\Curious World Maps\Users
\Default\KML

* 64 bit:
e C:\Program Files\vizrt\Viz World\KML
* C:\Program Files\vizrt\Viz World\Users\Default\KML

Any files uploaded from the client will be stored in this same location.

First Look

Places Streets Shapefile KML First Look

Only Visible on map

Australian Open Tennis
i ips 2014

The events tab is a feed of events from Digital Globe’s FirstLook service.
FirstLook provides rapid imagery of major global events, such as:

¢ Natural disasters: Earthquakes, fires, tornados, hurricanes
¢ Man-made crisis: Terrorism, large accidents
e Political instability: Riots, civil war
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¢ Human interest: World Cup, Olympics, F1, NFL

It requires a yearly license to use the imagery.

7.2.5 Extra Data Manager

The Extra Data Manager is available from the Layers Tool and allows users to manage
extra data that is stored on the Viz World Server.

Note: In order to work with Extra Data, the Viz World Server must have data
loaded.

Note: Streets data requires additional license features and the installation of
street data on the server.

Using Extra Data

1. Inthe Layers tool, click on the Streets tab, to open the Extra Data Browser. (this
will be empty if no data has been selected).

Streets KML First

Load Streets Load Visible Streets

Only Visible on map

Click on Load Streets to open the Extra Data Manager.

Navigate to the required data and use the Add, Fit and Centre buttons to select
the data and/or move the map.

Close the Extra Data Manager when finished.

4. Open the Extra Data Browser again to see all the loaded data and add features
which are related to the loaded data.

5. Data can be deselected either from within the Extra Data Manager or the Extra
Data Browser, using the ‘X’ button.

Extra Data Manager

In the Extra Data Manager, the view can be switched between Flat List view and Tree
view, using the buttons at the bottom of the window.

The Flat List view presents the data in a flat structure with a navigation bar at the
top. To navigate in the data, double-click an item in the list to open it, or use the drop-
down menus. In this case, the Filter only filters the content of the current directory.
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The Tree view presents the data in a hierarchical structure. To navigate in the data,
double-click an item in the list. The Filter filters the whole tree and lets you navigate
within the results using Enter and Shift+Enter keys or the ‘~" and ‘v’ buttons.

Street Data
Filter

i on map

® Extradata P | Completedata P | Europe P | Scandinavia-2012 W
DK
H

WA

SE

‘= Flat List

Street Data

Filter
€ on map
v Complete data
> Africa
» America
» Asia-Pacific
» Demo
Europe
>

v

» Switzerland

» Benel

=Tree ‘= Flat List

Extra Data Browser

The Extra Data Browser displays all the loaded data and can be used to add features
which are related to the loaded data.

Streets

» Finnmark, No
¥ Hordaland, No

¥ Streets
Agdestein, stord hordaland no
Motorways
Primary Roads Apaltunnelen, lindas hordalan...
MamiRood Amanipatunnelen, bergen hor...
Secondary Roads

Other Roads Amavegen, bergen hordaland...

> Land Use A Arnavegen, indre arna bergen...
» Lland Use B

: : Beitlatunnelen, vaksdal hordal...
Huospital Points

» Rivers and Lakes Bolstadtunnelen hordala...

Island
~anes Displaying 196 features

e
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7.2.6 Details

Displaying 2 details

#® Remove All

‘oints teres M Bus
Disasters

Traffic o~ Helicopter

The Details view allows you to edit the name and appearance of details. Changes can
be made to multiple details by selecting them together. The details in the list can be
reordered by dragging them, or easily hidden from the map.

Custom styles and style families can be created in the Map Designer using the Style
Editor. These styles will then be available in the Editor.

The icon used for each detail can be changed by selecting the detail in the list and
browsing for a new icon in the list of icons.

Details can be sorted alphabetically using the B3 buttons.

Displaying 2 details

Show/hide each detail, without removing it from the list, by clicking the BHE icon.
When a detail is hidden, it is not rendered in the scene.

Displaying 1 details
¥ Remove All

Clicking the Edit button next to each item in the Details list allows editing the following
features:

e All Caps: Caps on or off

* Add to Database: New name alternatives (e.g. language specific) can be saved to
the database
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* Label Location: Adjust the location of the detail’s label.

Displaying 2 details
2 Remove All

#) TORONTO Fit to details

Center to details

M Nova Scotia |_k

Remove details

Clear all details

The context menu provides the following options:

* Fit to details: Fits the map according to the selected details

¢ Center to details: Centers the current view according to the selected details
* Remove details: Removes all selected details

¢ Clear all details: Removes all details regardless of selection

Note: If the default style defined in the server is not available in the scene
designs, then the first design which is available in that scene will be used.

7.2.7 Shapes Tool

The Shape Tool lets users draw shapes on the map.

Context Menu

A right-click or a long left-click on the Shapes Tool icon will present a context menu with
the following options:

* Spline Shape: Draw segments of a smoothed, curved line. It can be closed or
open. Double click to finish drawing.

¢ Linear Shape: Draw straight-line segments. It can be closed or open. Double click
to finish drawing.

¢ Closed Shape: The shape drawn is closed, i.e. the first and last points drawn will
be joined.

* Fill Shape: The shape will be filled. Forces the shape to be closed.

* Circle / Ellipse / Rectangle: Select a geometric shape. If none are selected, the
tool will default to drawing a spline or linear shape.
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Edit Mode

When the Shapes Tool icon is selected, clicking on an existing shape will present the
Shapes toolbar:

* Lock/unlock the handles (only relevant to spline shapes): Allows the shape to be
modified more flexibly.

* Remove the shape from the map.

¢ Fit the map to shape.

¢ Center the map on shape.

¢ Convert shape to spline/linear (not relevant to geometric shapes).

* Make shape closed/open (only relevant to lines).

* Fill the shape with color.

¢ Change the shape style (for example an ellipse can be a Region or a Country). Note
that this may affect the appearance in Viz Artist scenes.

Shortcut keys
When a shape is in edit mode, the following shortcuts keys are available:

* DELETE key deletes the shape
e *key centers the map on the shape

At any time, pressing the D key will activate the Shape Tool. When the D key is
released, the previously active tool will become active and the shape will be submitted
to the Server.

To add a shape to the map

Click on the Shapes Tool icon to activate it.
Right-click on the Shapes Tool icon. A context menu will appear.

Select the kind of shape to draw, for example an ellipse.

P w N

Drag on the map to create a shape. When the mouse button is released, the
shape is submitted to the Viz World Server.

To edit an existing shape

1. Click on the Shapes Tool icon to activate it.
2. Click on the shape you want to edit. A toolbar will appear next to the shape.
3. Use the Shape Tool to modify the shape.
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Streets Tool

The Streets Tool can be used to add streets or segments of streets. It uses the data that
has been added by the Extra Data Manager.

When the Streets Tool is activated, a red dot will appear when the mouse is hovered
over a street. Clicking on the red dot brings up the Streets Tool menu bar.

The Streets Tool menu bar contains:

* Add Segment: Allows the user to add segments of the street. Each click on the
map adds a segment. Double-click to finish the operation and submit the shape to
the Server.

* Add Street: Add the selected street to the map.
* Label Street: Add just the label without the line.
* Fit the map to the street.

¢ Center the map on the street.

Once a street is added to the map, the user can edit it using the Shapes Tool.
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The Show/Hide Map Features button toggles the features on and off. If they are on, a
summary of features is also displayed.

Auto Regions | Towns | Streets | Other

Minor Towns

" i
B Streets

* & Places Of Interest
B Others

To configure which features will be displayed, click the arrow and select which map
features to show.

To modify a feature, you can also hover over the feature on the map to display the tool
bar.

| [HH gy | B W

Note: You can also show or hide individual details, using the Details tool.

7.2.10 Quick Map

M Australian Capital Territory
M Jervis Bay Territory

M New South Wales

M Northern Territory

M Queensland

The Quick Map toolbar allows quick navigation to regions, countries and cities. It
works together with the Locator tab to identify the location of the map segment which
is currently displayed in the Map Editor window.

* Q: Click on the Q icon to filter the drop-down lists and configure which features will
be listed in them.

* Globe: Provides quick access to regions of the world, for example, Asia, Middle East,
Europe.

¢ World drop-down: Select a country
¢ Country drop-down: Select a State or City

e Click on the drop-down headings (e.g. World or Australia) to zoom to the
corresponding level (i.e. world or country).

¢ Type in the text field to search for countries, regions or sub-regions.
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7.2.11 Locator and Preview

Locator Preview

The Locator-Preview tabs display the following information:

Locator

¢ Select an area and the map will zoom to that location

Preview

e If the Map Editor was opened from Viz Artist, Viz Trio or Viz Pilot, the Preview tab

will generate a snapshot of the Viz Scene. For Viz Pilot it will only work if a preview
server is configured.

Note: The Preview Server URI must include the http prefix (e.g http://
localhost:54000). In Viz Pilot 5.7.x and earlier, check the setting in VizPilot
under Options > Preferences > Advanced > preview_server_uri. In Viz Pilot

6.0 or later, check the setting in the Data Server under Settings > VCP
Parameters > preview_server_uri. For more information see the section ‘To give
applications access to the Preview Server’ in the Viz Pilot User’s Guide.

7.2.12 Preset Editor

* Right click on the VizBoldLocator to display a list of predefined regions.

Americas

Africa

Asia

Middle East

5. Asia

Europe

United Kingdom

Leslie

Gilad

Add Current View as Preset k

Locat Edit Presets

y P
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7.2.13

Add your own presets to this list by right-clicking and selecting Add Current View
as Preset. Then enter a name for the preset.

Enter Preset Name

My New Preset

Cancel

Edit your presets by right-clicking and selecting Edit Presets. In the window that
appears, you can rename, reorder, delete, or duplicate the custom list.

Presets Editor

Leslie

Gilad

Cancel

Multihop Editor

The Multihop Editor allows users to control the number of hops on a template. For
example, if a scene was designed with 2 hops, the user in Viz Trio would be able to add
up to 30 hops.

Enable the Multihop Editor

The Multihop Editor is hidden by default, but can be enabled in the following ways:

If a scene contains a Control Multihop plugin, then when the World Map Editor is
opened from Viz Trio or Viz Pilot, it will include the Multihop Editor.

When a scene in Viz Artist contains the Hops Manager plugin, then pressing the
Multihop button will open the World Map Editor, including the Multihop Editor.

Using the Multihop Editor

Once enabled, the Multihop Editor appears on the right-hand side of the World Map
Editor, and shows all the hops that are defined. The hops can be reordered by dragging
them to the desired place in the list.

¥ - orange

Cylindrical Equidistant Mercator
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Multihop Editing Options

A context menu on the Multihop Editor displays the following options:

* Cut, Copy, Paste, Duplicate or Remove items in the list.

+ Change Style: Select one or more hops and change their style. The change will
ONLY apply to the selected hops.

Change Project
D Duplicate

c

Note: To change the style of ALL hops, use the Select stylesheet button in
the Horizontal Toolbar.

+ Change Project: Select one or more hops and select a new map template file for
these hops. The change will ONLY apply to the selected hops.

Note: To change the project of ALL hops, use the Open Project button in the
Horizontal Toolbar.

7.3 World Map Editor Shortcuts

Where you are Shortcuts you can use

While in detail map editor Esc - Cancel edits
Enter - Save edits

While in detail list editor Esc - Cancel edits
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Where you are

Shortcuts you can use

F2 - Start edit

Multiply - Fit to detail
Divide - Center to detail
Minus - Remove detail

While on a list feature

Multiply - Fit to feature
Divide - Center to feature
Plus - Add feature

Minus - Remove feature

While in preset edit mode

Esc - Cancel edits
Enter - Save edits

While in shape edit mode

Esc - Cancel edits
Enter - Save edits
Del - Delete shape
Multiply - Fit to shape

While on first look list

Esc - Clear filter

While on main view

Ctrl + O - Open project browser
Ctrl + S - Save favorite

While pan tool selected

Ctrl - Zoom tool while key pressed

While zoom tool selected

Spacebar - Pan tool while key pressed

While shape tool selected

Ctrl - Zoom tool while key pressed
Spacebar - Pan tool while key pressed

While street tool selected

Ctrl - Zoom tool while key pressed
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8 Map Designer

The Map Designer is a component of the Viz World Client (WoC). Map Designer allows
you to create map templates similar to those created using Viz World Classic. In
comparison with Viz World Classic, Map Designer offers just the core features, which
allow you to design stunning maps in no time.

Map Designer shares much of the functionality of the World Map Editor, and as such, all
shared features are described in the World Map Editor section, with only the additional
features of the Map Designer covered in this section.

Note: Currently the Map Designer is only able to work with flat maps.

This chapter contains information on the following topics:

¢ Getting Started
¢ Map Designer Toolbars

e Stylesheet Editor

8.1 Getting Started

Once you have the Viz World Client installed you can start the Map Designer and
connect to the Viz World Server. Once connected you will be able to open existing
design projects, use existing templates, create new templates from existing templates,
or create a template from scratch using a blank template.

To start the Map Designer

The Map Designer can be started from the desktop or start menu (i.e. Viz World Design
Client), or from the installation directory (MapsDesignClient.exe):

e 32-bit system: c:\Program Files\vizrt\Common\Maps\
* 64-bit system: C:\Program Files (x86)\vizrt\Common\Maps\

To connect to Viz World Server
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Start the Map Designer
Click the Settings button, located on the toolbar.

Set the Viz World Server hostname. If not specified, the Map Designer will
connect to localhost.

4. Click Save

To create a map template

Map Designer

w [ [=

Open From From Blank
Project Template Existing

1. Start the Map Designer
2. Select one of the following options
* Open Project: Open an existing project

* From Template: Starts a new project based on a selection of default
stylesheets

* From Existing: Starts a new project based on an existing project
* Blank: Start a new project

8.2

Map Designer Toolbars

The Map Designer has two toolbars, and most of the functions are the same as the Map
Editor Toolbar. The functions that differ are described in this section.

Horizontal Toolbar

Natural Earth !- 4\" 1'-.

The horizontal toolbar is the same as the Map Editor Toolbar, with the exception of:

« New Project: Create a new map template (see Getting Started)

* Open Project: Open existing map template files.

* Save Project: Save the current map template file.

* Save Project As: Save the current map template file as a new file.

Vertical Toolbar

The vertical toolbar is the same as the Map Editor Toolbar.

8.3
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Stylesheet Editor

Stylesheet Editor

+ ¥ e

P Land
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The Stylesheet Editor is in many ways similar to working with the Styles Editor in Viz
World Classic. You can define styles for land, sea, borders and so on.

This section contains information on the following topics:

¢ Add and Organize Stylesheets

e Customize Styles

* Default Values
e Land

* Sea

* Miscellaneous
» Extra Data

* Borders

8.3.1 Add and Organize Stylesheets

While working on your template’s stylesheets you can Add new or existing stylesheets
from other projects to your own project. In addition you can Organize your own
stylesheets.

Add

Stylesheet Editor

+

From From
Template Existing

When adding stylesheets you can select one of the template stylesheets, or a
stylesheet from an existing project or simply a blank stylesheet:

« From Template: Browse for and select one or multiple existing stylesheet
templates and add them to your project.

* From Existing: Browse or search for stylesheets from existing Projects. Select one
or multiple existing stylesheets and add them to your project.

¢ Blank: A new blank stylesheet is added and opened.
Organize

Stylesheet Editor +

Natural Earth

Political - Grey

When organizing stylesheets, the stylesheets in the project are listed, and it is possible
to perform the operations; Duplicate, Rename, or Delete.
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Additional stylesheets can be added using the Add button at the top of the Organize
window.

8.3.2 Customize Styles

Use the Style Editor to edit and customize the styles of points, lines and areas. These
styles can then be used in your Viz World project.

Open the Style Editor from the Stylesheet Editor toolbar.

Stylesheet Editor

+ 8 sy

¥ Land | Edit Families |

This section contains the following topics:

e Style Editor
e To create a new style family

e To select a new default style

Style Editor

#9| Styles Editor
World Server Connect

¥ Families B3 Points | Lines | Areas ¥ Defaults Points | Lines

* E-Regions Point Label Y ?  Point

Admin 1 = - . Region

Admin 2 = . Sub_Region

Country b <] = . Country

Town > 1K Y A Town_lk

* Colours
F Towns
* Regions

- 10K ® ] " !
¥ Points of Interest Town > 10K Town_10k

» Transportation Town > 100K Y = Town_100k

Save Changes Revert

Style families are listed on the left, and default styles on the right. The Style Editor
comes with a predefined list of families and styles that can be used as-is, or can be
edited or removed. Drag styles to reorder them or move them from one family to
another.

The styles are global to the system and are available in the World Map Editor, based on
what is available in the Viz scene. Any style in the system that is not part of the scene
will be disabled in the editor, and any style that is part of the scene but is not defined
as part of the global styles will be available in the Others family.

To create a new style family
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4.

In the Style Editor, click the New button to create a new family, then give it a
name

#£8 Styles Editor

World Server Connect

¥ Families B3 Points | Lines | Areas

Within the family, click the New Style button to add new styles

#9 Styles Editor

World Server Connect

¥ Families 3 Points | Line:

* E-Regions
Fill in the details for the style:
1. Type (point, line, area)
2 Name
3. lIcon: Select a new icon in the file browser
4. Color, opacity etc. Only possible for Area and Line.

L4

MyFamily

Click Save Changes

To select a new default style

1.
2.

Drag a style from the family list to the default list, and drop it on the desired style.
Click Save Changes.
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8.3.3 Default Values

Highlight
. Size [ ] 3000 % =

Intensity [ ]

Relief Scale

Settings which use the default values have a grey square next to them. If the value
differs from the default, the square turns white. Click a white square to return the
values to default.

8.3.4 Land

Relief MNatural

Color "R
Ice Color .

" Drop Shadow
Color

Angle

Distance @
Softness @

Drop shadow on
"La
"Na

" Relief Shading

Highlight

Size [ ]
e

Intensity [ ]

Relief Scale

" Refine Relief

The Land settings allow you to define the Style of the map and its fill colors, aswell as
the Drop Shadow and Relief Shading effects.

Style

When defining land styles you first select whether the map should have a Synthetic,
Relief or Natural style.

¢ Synthetic gives the map a basic style, where you can select a single Fill Color
or four fill colors. If you select four fill colors, no country, adjacent to each other,
will have the same color. Both Relief and Natural styles can mix with Synthetic
utilizing its single or four color option. The Ice Color can be set separately.

* Natural gives you the option to select which satellite imagery provider to use (e.qg.
Microsoft Virtual Earth, Digital Globe, Planet Observer, and so on). In addition you
can adjust the map’s brightness, contrast, saturation, gamma, and tint.

If the stylesheet uses either Digital Globe or Microsoft Bing, you can set which
imagery profile to use as default. The profiles provide different imagery sets for the
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same location. If required, the operator can change the profile from the Map Editor
Toolbar when selecting the desired final location.

¥ Land

Style Synthetic Relief © Natural

Microsoft Virtual Earth

Satellite £
Brightness 76.00
Contrast 100.00
Saturation 100.00
Gamma 1.00

Tint

¢ Relief contour colors work the same way as for Sea. It gives you the option to
define colors at varying levels of height (i.e. from 0 to 8000 m.a.s.l.). Clicking below
the bar adds a new handle. Double-clicking a handle will open a color picker for
setting a color for that level. Dragging the handle horizontally will adjust the height
parameter. Dragging the handle vertically will remove the handle.

Style  Synthetic Relief Matural

Drop Shadow

Drop Shadow can be added to land, lakes/wide rivers, and narrow rivers. The drop
shadow effect also allows you to adjust the angle of the shadow, and its distance and
softness (spread).

Relief Shading

Relief shading can be added to land. When enabled you can define how the light will
affect the relief by adjusting the highlight (by click and drag). The Size and Intensity
settings will help you control the appearance of the relief texturing on the map.

Refine Relief will add extra detail to the relief. This is especially helpful when zooming
in at low levels.

The image below shows a map with Refine Relief enabled and disabled:
W :vcHwnz JTW 5:ku

, A,H{OL‘ ’ 'chL
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Sea

Contours

Opacity

Natural Sea

PlanetObserver 15m

Mix with others
Mear Mix @
FarMix @
Brightness
Contrast
Saturation
Gamma

Tint

The Sea settings allow you to define the color and/or contour colors of the sea, and
when using satellite imagery how it should mix with the base and/or contour colors.

Color sets the base color of the sea.

Contour colors work the same way as for Land. It gives you the option to define
colors at varying levels of depth (i.e. from 0 to 10000 m.b.s.l.). Clicking below the

bar adds a new handle. Double-clicking a handle will open a color picker for setting a
color for that level. Dragging the handle horizontally will adjust the depth parameter.
Dragging the handle vertically will remove the handle. Opacity blends the base color
with the contour colors. The lower the value, the more of the base color will be shown,
and conversely.

Natural sea enables you to select which satellite imagery provider to use (e.qg.
Microsoft Virtual Earth, Digital Globe, Planet Observer, and so on). In addition you can
adjust the map’s brightness, contrast, saturation, gamma, and tint.

Mix with others allows you set the alpha for the mix between the base and/or contour
colors and the satellite imagery. It will mix the colors based on whether you are near or
far away from sea level. Meaning, when you are close to sea level it will use the near
mix setting, and when far away it will use the far mix setting.

Mix with others
Near Mix [ ]

Far Mix

Mix with others

Near Mix [ ]

Far Mix
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8.3.6

Miscellaneous

¥ Miscellaneous
Projection Cylindrical Equidistant
Global Map Data

Lakes Medium Lakes

Rivers Major Rivers

Master Size o 1.00

Small Rivers @ 7000 %

Max Width 2.00 px

Extra Map Data

Local Street Data

Draw Land

Lakes Major Lakes
[ ]

Rivers Wide Rivers

Lat/Long Lines
Draw on Land
| [ ] 200 px

Spacing
long @ 10.00 de

lat @ 10.00 de

Projection:_Map projection either Marcator or Cylindrical Equidistant (Unprojected).

Global Map Data/Extra Map Data: For Lakes and Rivers you can select a base
color (no alpha) and whether or not None, Major, Medium, Minor or All lakes and/or

rivers should be shown.

For rivers you can also define:

* Master Size affects the width of all rivers drawn as lines.
« Small Rivers affects the width of rivers which are classified as minor rivers.

¢ Max Width (in pixels) determines the maximum line width at which rivers will be
drawn. This is useful if you wish to prevent rivers being drawn as very thick lines as

a map zooms in.

When Local Street Data is enabled, the data for lakes and rivers can be displayed.

Latitude/Longitude Lines can be enabled/disabled. The color, width and spacing are

configurable.
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8.3.7 Extra Data

¥ Extra Data

Local Street Data

Roads All Roads
o

Freeway/Motorway

Primary

Main

Secondary

Other

If Local Street Data is used, the Extra Data settings allow the various types of roads to
be styled.

8.3.8 Borders

1.00 px

ashed line

050 px

050 px

The Border settings allow you to define the border color and width (in pixels, 0.00 -
10.00 px). You can set colors and width for country and region borders, and coastal
lines. In addition you can enable/disable disputed borders. Disputed borders are shown
with a dashed line.
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9 Map Builder

The Map Builder is a component of the Viz World Client (WoC). Map Builder is used
during design in Viz Artist to build maps quickly and efficiently. It is used in conjunction
with the Map Builder Plugin scene plugin.

IMPORTANT! Prior to using the Map Builder you need To import basic map
elements.

In general when creating a map scene your scene will consist of a few basic elements.
The elements are built in the following order:

© e N Uk WN R

=
©

Create a scene using the Map Builder plugin (see Getting Started)
Choose Scene Type

Create a Base Map.

Define the Global Hop.

Create a Navigator which can be used to create a destination list.
Set the map Orientation.

Configure the design source and object pool Settings.

Use Window to enable or disable a window mask for the scene.

Use Global Borders to generate global vector border data based on the settings
applied.

Refresh the thumbnails when re-launching the Map Builder to make changes (see
Toolbar and Menus).
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9.1

Page 88

Getting Started

i

Once you have installed the Viz World Client you can start Viz Artist and create a scene
using the Map Builder Plugin scene plugin. Note that the Map Builder itself will by
default connect to the same Viz World Server as Viz Artist. If needed you can switch to
another Viz World Server from Map Builder’s file menu.

As a first step to work with the Map Builder you can create a scene that only contains
the Map Builder Plugin scene plugin. Once created you can launch the Map Builder
by clicking the Launch Wizard button. This will open the Map Builder and allow you to
Choose Scene Type.

To start creating a scene using the Map Builder

Start Viz Artist

Click Built Ins and then the Scene Plugins tab
Select the Maps plugin folder

* This will show the Map Builder scene plugin

Container | Camera |Light | Scene Settings

Click Scene Settings and the Plugin tab
5. Drag and drop the Map Builder plugin onto the Plugin areas placeholder
Save the scene

* Once the scene has been saved you can open the Map Builder and click the
Launch Wizard button to open the Map Builder.

To import basic map elements

Start Viz Artist.

Click Import and select Archives from the drop-list

Navigate to C:\Program Files\Vizrt\Common\Maps\Archives
Select the VizWorldGlobalDesigns.via archive.

u ke w N e

Click Import Archive.
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9.2 Choose Scene Type

Choose Scene Type

w1 W
Focus on

Navigator Map

1 Destination Map Object

Navigator Scene

Scene with one starting point and up to 32 destinations.
Geometry can be globe or flat.

When launching the Map Builder you will be presented with the following options:
« Navigator: Allows you to build a scene with one starting point and up to 32
destinations.

* Focus on Map: Allows you to create a static scene with a base map only. Can only
be used with flat geometries.

+ 1 Destination: Allows you to build a scene with one starting point and one
destination.

*« Map Object: Allows you to build a scene with one starting point and one
destination. The window option is used so that the map only uses part of the screen.

¢ Open: Opens existing map template files.

9.3 Toolbar and Menus

Toolbar

« New Map Template: Allows you to create a new map template (see Getting
Started)

* Open: Allows you to open existing map template files.
¢ Save: Saves the map template file.
* Save As: Allows you to save the map template file as a new file.

¢ Refresh: Refreshes the thumbnails. Refreshing thumbnails must be done after
manually editing a Map Builder generated scene and when re-launching the Map
Builder as all thumbnails of maps (Base Map, Destinations and Orientation) are lost.
In order to refresh them press the F5 key, or click the refresh button in the toolbar.

Menus

* The File menu contains the same functions as the Toolbar, as well as Exit.
* Tools menu contains

¢ Refresh thumbnails

¢ Map Server Settings: i.e. Viz World Server host name

» Option to enable/disable the tooltips
* Help menu contains links to the About information and the User Guide
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9.4 Base Map

¥ Base Map Settings

Base Map Type: World Selected Map

s Tt Map type: Globe Flat
Labels: None Managed Managed + Auto
Resolution: HD1080 |+ W: H:

Base Map is the Globe/Flat map in a specific style and data. The map created at this
level is usually good for country level view.

9.5 Global Hop

¥ Global Hop Settings
Hop base duration:
Hop base duration: Distance Based | Per Destination
Hop Min duration
Stop type: Disabled Fly over Stop Points Pause Points

Pause at map start: Enabled Disabled

Camera pan / tilt: Per Destination Global

Defines the camera’s trajectory animation setting. It describes how the navigation
animation should be (e.g. map start + 3 destination animations, each “hop” animation
based on 5 seconds, with stop points between destinations).

9.6 Navigator

Navigator Hops =+ 3  Move W Map Start + 1 Destination

Map Start External Contrel G

Type defines whether each destination will be of type Geo Position Only, Map - Single
Image or Pyramid of Maps.

A Geo Position Only destination will only use a Geo Position reference to the navigation.
This mode is useful for destinations that are always far away from the base map. No
map will be created in this mode (as it will save texture memory).
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Note: When destination is set to Geo Position Only, it cannot be controlled by an
external application such as Viz Trio or Viz Pilot.

Map - Single Image enables operators to control a destination using an external
application (either a Map or Pyramid has to be selected). If the selected destination is
used for a reference point, and it needs to be controlled, use this type (e.g. a far away
starting point).

Pyramid of maps is used when the base map is not suitable for close-ups. A pyramid of
maps built around the destination will smoothen the resolution difference between the
base map and the destination target.

Destinations

Each destination can consist of map elements (labels, regions and miscellaneous map
elements).

If destinations are controlled (e.g. by Viz Trio or Viz Pilot) they can be linked to each
other - to allow the user to easily control multiple destination elements. Linking is only
a help to the user and has no effect on the scene.

Copying (duplicating) a destination is possible by selecting a destination and clicking
the add button.

Note: The selected destination will not be duplicated if the destination type is Geo
Position Only.

9.7 Orientation

¥ Orientation

’ Add orientation map

Center Map  Locator

The Orientation map is displayed in the bottom corner of the screen. It consists of a
small map with a marker showing what part of the world is currently being navigated
to.

There are three views available:

¢ Center Map: The orientation map will be moved according to the main map’s
geographic properties

¢ Locator: A marker on the orientation map will move according to the main map’s
geographic properties

¢ Globe: A globe will rotate according to the main map’s geographic properties.
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9.8 Settings
¥ Settings
Designs source: In Scene
Objects pool path: Default
User folder:
Map Layer: 2nd Layer
Allows the user to specify the design source and object pool path.
Designs source is an option that allows designs to be shared between scenes by using
the Object Pool, instead of the in-scene designs.
Object Pool Path: The default object path is /vizrt/VizWorld/GlobalDesigns. This
option allows users to specify an alternative Viz Graphic Hub or Object Pool folder. A
custom Object Pool Path must use the same hierarchy structure as the default object
path.
Map Layer: Select whether the scene will use the Front and Main layers, or will only use
the Main layer and then apply a Dynamic texture for the overlaid items.
9.9 Window
¥ Window
" Use Window " Control Window Mask
X: 50.00
¥: 50.00
Width %: 40.00
Height %: 40.00
When this option is enabled the Map Builder will add a window mask to the Viz Scene
and also apply the X, Y, width and height values to it.
9.10 Global Borders
¥ Global Borders
World: None
Region Data: @
Region List: Africa
Country Borders:  Internal Coastline
This option will enable Borders as vector shapes in the scene.
¢ World: Select whether to create full world vector borders or not
* Region Data: Additional regional data up to the resolution selected (Country, Region,
SubRegion)
* Region List: The regions that will be built are based on the selection in this field.
e Country Borders: Select whether to generate Internal Borders, Coastline Boarders or
Both
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10 Map Editor Classic

The World Map Editor (WME Classic) is a component of the Viz World Client. WME
Classic can be integrated with numerous Vizrt products that enables users to select,
frame and populate maps and use them in Viz. The WME connects to the Viz World
Server and retrieves the map to be used.

This section contains information on the following topics:

e Map Editor Classic
e Using the Map Editor
¢ Map Name Editor

¢ Using the Map Name Editor

10.1 Map Editor Classic

Amsbes L et [

S Gl

The WME window includes the map area, navigation and map editing area, map details
area and the map tool bar. The user can select (zoom and pan) a region on the map, or
use the search tool to find the requested location. The user can add information to be
displayed over the map by selecting objects from the database or by manually marking
a place on the map. The added objects are displayed in the Map Details area.

This section contains information on the following topics:

* Map Area

* Navigation and Map Editing Area
* Search Tab

* Explorer Tab

* Extra Data Tab

* Images Tab

e Symbols Tab

e Map Tool Bar
¢ Map Details Area
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Map Area

The map area displays the current map and enables the user to modify the map
interactively, according to the selected tool in the buttons toolbar and by using the

integrated Zoom Options .

Context Menu

Guides Screen Safe

Languages Title Safe

Server Priority Logo

Background

¢ Guides: Allows you to display default guides (e.g. safe and title area) or custom
guides and/or images (e.g. logo and background). For more information, see how To
add custom guides.

* Languages: Defines the language setting for labels. See the Server Configuration
tool’s Display section and how To create a new language file.

e Server Priority: Sets the connection priority given by the Viz World Server. See the
Server Launcher Configuration section and the Enable Priority Login option. If you
are working on scene design using Viz Artist, Viz Artist also needs to be configured
(separately). See Viz Artist’s Maps Configuration section.

To add custom guides

With custom guides you have three options; two for placing an image as a background
or logo and one for placing guides such as title and safe area boxes.

1. On the Viz World Server machine locate and open the CustomGuides.txt file
under

* 32 bit: c:\Program Files\Curious Software\Curious World Maps
\Settings

* 64 bit: C:\Program Files\vizrt\Viz World\Settings
2. Enter the following to show an image (e.g. logo) on top of the map:

* Syntax: Type "Title" Ratio Width (%) Height (%) "Filename" Image X (%)
Image Y (%) Opacity (%)

* Example: Image "Logo" 1.333 80 80 "C:\logo.png" 0 0 75

* This will add an image on top of the map, the image will be applied with 75%
opacity (alpha is supported).

3. Enter the following to show a background image on top of the map:
* Example: Image "Background" -1 90 90 "C:\background.png" 5 5 25

* This will stretch background.png to fit the current aspect ratio (-1) with 5% on
each side as margin at 25% opacity.

4. Enter the following to add a custom guide to the map:
* Syntax: "Title" Ratio Width (%) Height (%)
* Example: "4:3 Title Safe" 1.333 80 80

* Valid width and height values have to be between 50 and 100. Set ratio (width
divided by height), or -1 for current aspect ratio. You can define up to 5 custom
guides.
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Zoom Options

In the upper left corner of the Map Area there are two rectangular blue shaped buttons
that can be used to zoom in and out of the map. In addition it is also possible to use the
mouse (left button) and/or in combination with the keyboard.

The zoom options, besides menus and buttons, are:

Drag and draw a rectangle to zoom in to fit.

Click the left mouse button to zoom in.

Hold down SHIFT to zoom out.

Hold down CTRL to zoom in in smaller steps.

Hold down CTRL and ALT to zoom out in smaller steps.

10.1.2 Navigation and Map Editing Area

The navigation area enables the user to locate places by searching the database or
selecting a place from the explorer list. When a place is found (or selected) the user
can fit the map to the requested area, add information to the map, highlight the region
and modify the map.

Using the Results

After conducting a search or using the explorer, the results will be displayed as a list.
When an entry is selected, the buttons on the right side of the list will become enabled:

+* Add to map: Adds the selected entry to the map. The selected entry will be
added to the map graphically as defined in the selected map style. A map style
defines map symbols, fonts, icons, colors, and so on. For map styles see also Map
Tool Bar and the Map Style drop-down menu.

B center map: Pans the map to center the selected entry (keeping the current
map scale size).

B Fit to fill: Centers the map and scales the map to fill the map area.

@ Show details: Opens the browsing tool, which displays the context information
for the selected detail. The context information includes the regions containing the
detail (that is country, state and county) and the capital of that country.

10.1.3 Search Tab

Search | Explorer | Extra Data | Images | Symbaols
Find @&l O Visible
Search: Paris T

Cross St

&?‘, Paris, Lamar County
r';} Paris, TX United...ates, Lamar County

Type: | &l - Source:ia -
All
Map DE

T |MName
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The search tab is used for searching the database for a place, using a string or sub
string typed in the name text box. The search results can be filtered using the radio
buttons and the drop-down list.

Searching is instant (after the first three characters) and optimized according to
relevance; hence, if you search for Paris your result will show all places named Paris,
but if you search Paris TX you will get Paris in Texas, USA.

Search | Explorer | Extra Data | Images | Symbaols
Find @&l O Visible

Search: broadway AND 44

Cross St

Type:D - Source:E -
T |MName |
<-|> Broadway & W 44...ew york new york =
|H?| Broadway, new york new york
|ﬁ| W 44th St, new york new york [ﬂ

If you have street data (see Extra Data Tab) you can also search for crossroads using
AND or & (e.g. Broadway AND 44th).

Search Parameters

* Find All: When selected it displays all matching entries in the database.

* Find Visible: When selected it only displays matching entries visible in the current
map.

¢ Addr and Cross st.: Enables the user to search for specific addresses.

* Type: Limits the result list according to the selected Type. For example region,
capitals, tourist attraction, and so on.

e Source: Searches a range of sources.
¢ All: Searches all sources.
¢ Internal: Searches the map database and extra data.
¢ Map DB: Searches the Viz World database.

« Extra Data: Searches all extra data packages bought in addition to the standard
installation (see Map DB).

¢ Web: Searches Yahoo for online point data.

Note: Searching for addresses requires licensed street data installed on the
server.
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10.1.4 Explorer Tab

Search | Explorer | Extra Data | Images | Symbols
[isible

-l Canada = n
Alberta :Sa

British Columbia 1= [l
Manitoba I

Mew Brunswick
Mewfoundland and Labrador =
Morthwest Territories
Mova Scotia

Towins > 100k +| <Fier>

Type | Name
35; Abbotsford, British Columbia
35; Burnaby, British Columbia
35; Coquitlam, British Columbia
35; Kelowna, British Columbia
35; Langley, British Columbia
35; Morth Vancouver, British Columbia
35; Richmond, British Columbia
35; Saanich, British Columbia
35; Surrey, British Columbia
;] Vancouver, British Columbia

35; Victoria, British Columbia

The explorer tab is used for selecting a location from a list of places derived from the
server’s database. The list is displayed in a tree format showing countries, regions,
cities, and so on.

Explorer Parameters (list filter)

* Visible: Only displays location entries visible in the current map.

« Type: Limits the search result list to the selected type like region, capitals, tourist
attraction, and so on, when one of the entries in the list of available types are
selected.

¢ Filter: Filters the search result further.

Note: To find New York, type N, then type E, etc. with every character typed in the
string filter the list will be smaller.
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Extra Data Tab

Searchl Explorer  ExtraData | Imagesl Symbolsl

I~ Visible Imnport KML... | Data.. |

-- Telemark, Mo b] ﬂ
[+ Terama, Abruzzo, |t
[+ Troms, Mo é.l
[+ Westdgder, No
[+ Westfold, No
[+ Wibo Valentia, Calabria, It
= KML Files

- elf 2008kl

[ wisible <Filkers

Type | MName ¥

EE“ Gm

hid
Alversund

Alvgen ﬂ
Askey 5=
Austevoll ﬂ
Austmarka

Austrheim

Bekkjarvik

000008

i

Bildeyna
Bjgrgum
Blomsterdalen
Brattholmen
Bamlo
Bammelhavn
Dale
Dimmelsvik
Eidfjord
Eidsvig

0000000008

Eikelandsosen M

Addressl Intersectionsl Back |
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The Extra Data tab is used for selecting a street from the streets database on the

server, and Keyhole Markup Language (KML) files.

Note: Streets data requires additional license features and the installation of

street data on the server.

Streets

Searchl Explorer  ExtraData | Imagesl Symbolsl

I Wisible Impart KML... | Data... |

[=- Hordaland, No b] ,{b»l
[=)- Streets
Motorways ﬂ
Frimary Roads tJ
Main Roads Vi
Other Roads ﬂ

Land Use A
. #-LandUseB M

[ wisible Ifurulien

Type MName ¥ |

Addressl Intersectionsl Back |

DI 1k
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10.1.6

Streets data is available from the Streets node, and are sorted by Motorways, Primary
Roads, Main Roads and Other Roads. Use the Filter search to search for streets.

Import KML

Search] Explorer  ExtraData l Imag =)

I Wisible I L. [ Tour de France 2008

Telemark, Mo
Teramo, Abruzzo, [t
Trams, Mo
West-Agder, Mo
Westfold, Mo
Yibo Walentia, Calabria, It
KL Filez

tdf2008_kml

I Wisible <Filter>

Type Mame

1] [ F- - - -

Stage 1 start

Stage 1

Stage 1 finish
Stage 2 start

Stage 2

Stage 2 finish
Stage 3 start

Stage 3

Chomn D idnke

b

ﬂ

Keyhole Markup Language (KML) files can be imported and added to the map. The
KML data will be accessible from the Extra Data tab as with street data. By clicking the
KML Files node, all the imported KML files will appear as sub nodes. Click one of the
imported KML files to open the KML file window the respective file will be file.

KML files currently must be manually imported into the server. Files are placed in the

following location:

e 32 bit: c:\Program Files\Curious Software\Curious World Maps\KML

* 64 bit: C:\Program Files\vizrt\Viz World\KML

Images Tab

| Search I Explorer I Extra Data | Images |Sy1'nbo|5

<Filter=

¥ Last 7 Days

gl—leavyﬂmdshﬁ].lad(r

¥ Last 31 Days

MExplosion in Brazzaville, Congo

US Midsection Tornadoes

@

uFlood in El Tarf, Algeria
==

uFlood in Peru
==

(4 g Cyclone Giovanna

¥ Older

Flood and Ocean Storm in Madagascar

uFlood in Mozambigue
_
Philippines Earthquake

HB! One-Year Anniversa... in Cairo, Egypt

|2 ']

-

)

B

NG

The image tab allows you to search for and buy Digital Globe First Look event imagery.
You can also browse and evaluate first look imagery (with watermark); however, only
users who are licensed for Digital Globe First Look can purchase the images with valid

credentials.
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First Look Service by Digital Globe ® is an on demand access to fresh imagery taken
hours or days after an event happens. The Viz World Server fetches a complete list of
available event imagery from the service when Viz World Server is starts. Clicking the
Force Refresh button will update this list.

Events are organized by time, where latest events are on top.

Add the selected image to the map: Adds an event imagery to the map

Center the map on the selected image: Centers the view of the map to the
location of the event imagery

Fit the map to the selected image: Fits the map view to the event imagery

Image Purchase =]
ORDER. CONFIRMATION

This service is available only for Digital Globe online users.

The FirstLook Image you have selected is available for the price
and duration indicated at the information page ("VIEW™ button),
and access to and use of the selected image is subject to the terms
of the End User License Agreement (EULA) set out at such page.

Clicking on the following "I AGREE" button, and entering your user
name and password indicates (i) you have read the End User
License Agreement, (ji) your agreement to pay the quoted price,
{iii) your acceptance of the specified time limit regarding permitted
use of the image, and {jv) your acceptance of the terms of use set
outin the EULA.

Pricing and End User License Agreement Pricing Terms

Username:

Password:

[ 1acree | [ cancel |

Purchase selected image and add it to the map: Opens an Image Purchase
dialog box that allows you to read the Pricing and Terms (EULA) for the images. In
order to purchase an event imagery, you have to be licensed for the Digital Globe
First Look service, and have valid credentials that are supplied with the license file.
The purchased image will be added to your map.

Event Info
Points of intrests:
Title: Heavy Floods in Ecuador [‘3’3 Narme
Date: 2012-03-09 20:35:00 UTC g Babahoyo
Bal
Categories:  Natural Disaster | [\: a: I
Description: A state of emergency was dedared Thursday for five B2 achala
Ecuadorian provinces where floods triggered by winter :
rains have left 20 people dead and 2,523 displaced. &

Event detailed information: Opens a dialog box showing a full description of the
event. From this dialog box you can also add the points of interest to your map in
addition to the add, center, fit and purchase operations already available under the
Image tab.

See Also

Events server configuration

Symbols Tab

Symbols are added using Viz World Classic, and can be imported using the
Configuration tool or Viz World Classic.

To add symbols
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10.1.8

Start Viz World Classic, preferably on the maps server.
Create or open a map project.
From the Tools menu, select Symbols.

P w N

In the Symbols dialog box, click the + symbol (bottom) to search and select for a
symbol.

Ul

Close Viz World Classic.
6. Restart the Viz World Server to load the new images.

Map Tool Bar

[Dig'rtaIGIobe v][ v| Region Pick Browse Move  Add Add Edit Locators
Zoom Zoom Pan | Feature Map Label Label |5treets Shape Shape |—|

=BG ] (] (2] =) [ (&) ()0 (6 (98950 [ (Y M (i

The map tool bar includes a row of buttons controlling the map interactive mode. The
map area enables an interactive map selection and manipulation and the map tool bar
is used for selecting the map interactive behavior.

This section contains information on the following topics:

¢ Map Tool Options

¢ To create a map using the Quick Map location browser

e To set the map location

e To pick a label and add it to the map

e To move a label

Map Tool Options

* Available Map Stylesheet: Displays a list of available map styles of the selected
template. Select a map style to apply the style’'s design to the displayed map.

* View Presets: Displays a set of view presets. Available options are: The World,
United States, N America, S America, Americas, Africa, Asia, Middle East, S Asia,
Europe and United Kingdom.

= Open New Template: Loads one of the defined templates installed on the
server creating a blank map with the template’s styles and settings. When pressing
this button a confirmation window will open. When confirmed, the template window
will open. Select one of the projects in the list and click OK. A new map will appear
in the map area using the new template’s default styles and settings.

= Save Favorite: Save map as a favorite.

Note: User favorites will not be synchronized across servers when working
with server allocator. When working with multiple servers, synchronizing user
favorites can be done as an automated process of replicating the relevant
folders. User favorites are stored by default under C:\Program Files\Vizrt\Viz
World\Users\Default\Favorites.

9 Undo button: Cancels the last change on the map.

© Redo button: Cancels the last canceled change on the map.
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Bird’s Eye: Displays the available imagery Bird’'s Eye imagery from the Bing Maps
Platform. When clicking the button, the imagery for the area of the current map will
be displayed enabling the user to select an image for the map.

Quick Map
Set Location

Quick Map: Opens the Quick Map location browser that enables the user To create
a map using the Quick Map location browser .

Set Location: Opens the Set Location dialog which enables the user To set the map
location using longitude, latitude and map size values (radius around the defined
point).

[ | Region Zoom: Enables the user to click and drag the mouse on the map to
create a rectangle surrounding an area on the map (rubber band).

¢ The rectangle displays two icons; a cancel icon in the upper right corner and
accept icon in the lower left.

* The rectangle keeps the aspect ratio set for the map unlike regular zoom (see
below).

* Region zoom can be adjusted before accepting the area selection.

4| Zoom: Zooms into the map on every click on a point in the map centering the
clicked point in the Map Area. Another option is to drag and create a selection area.
When the mouse button is released, the selected area will become the selected
map. Selecting an area using the zoom option does not maintain the aspect ratio.

Note: Both Region Zoom and Zoom allows for area selection in the Map Area;
however, Region Zoom will maintain aspect ratio and allow the user to cancel
the operation after the selection was made.

®| pan: Enables the user to click and drag on the map to move the map in the
direction of the drag.

&1 Pick Feature: Shows a group of available places from the database as
“phantom labels”. This feature enables the user To pick a label and add it to the
map . The labels will appear over the map only when an entry is selected in the
explorer tab or in the search area.

@ Browse Map: When clicked any click on the Map Area will update the browse
window with context information for the clicked position. The context information
includes regions containing the position (for example country, state and county) and
the capital of the country.

"

Browse

Features

{‘; Italy
{C 3y Toscana

A
8] Arezzo

;: Roma (Rome), Roma

B8 o

) Move Label: Enables the user To move a label in the Map Area. Map Label
enables the user to move the tip and the caption of user-created labels or to rotate
them. In other labels only the caption can be moved and rotated.
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Note: Rotation of labels in WME will not effect label objects generated by Viz
(3D labels). The rotation is noticed only when using labels as part of the map
texture.

‘ Add Label: Adds a label at the click point, enabling the user to enter and select
a label text and label icon type.

New Detail

Name: | My Place

Style: |Place -

Iv¥ Remember label and publish to all user

oK | Cancel |

« Remember label and publish to all users: When this option is checked, the
new label will be added to the database. Whenever the place is selected all the
customized labels will be available for selection by the user. When the option is
unchecked, the modified label will be used only by the current map.

¥ Streets: Enables the user to select and label streets on the map. Street data
must be loaded for this feature to work (see Extra Data Tab).

w Nastegaten {0
sckd whole | acdwhoie v Label | PSS

A sacion | st sacton e |
Add Label

B NS - RS

¢ Add Shape: Adds shapes to the map. Select between points (straight) and bezier
(curved). Selecting the Add Shape button also opens a small toolbox for selecting
shape designs.

M: \/Poinis
|

Available options are:
¢ Area: Fills the drawn shape, and will also close the line (see Closed Line).

* Closed Line: Allows the user to close the shape without setting the final point
(e.g. 2 points will draw a third closing the line with the first point).

* Open Line: Allows the user to draw a line that is not closed.
¢ Delete Last: Deletes the last drawn line.
¢ Cancel: Cancels the draw operation.

* Edit Shape: Allows the user to edit the shapes and streets added to the map.
Streets (roads) can be offset, while shapes can be adjusted using the Point toolbox
that appears when the Edit Shape button is selected.

W: memm
‘1\ Offset Road
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Note: Shapes and streets can be edited further using the maps plugins (e.g.
3D Line and 3D Line Manager.

To create a map using the Quick Map location browser

Quick Map =]
Country [ china Mgalr| [ ;'ﬂzqu Features |

Camboda [a] [Ariwi T Type | Hame ¥

Camercon

Canada = |[Sengang

Cape Verde Fusian = e Tangzhou, Beifing

Cayman Islands Ganou

Central Affican Republic Gua

Ceuta Guangnd Zhuangeu Zizhigu

Blo] P e
Finish

1. Click the More button’s Quick Map option in the WME.
2. Select or search for a country in the Country list.

e The map area will fit to the selected country and the State/Region list will show
a list of available regions of the selected country.

* When a country is selected in the list, the Add to map and Mark Area buttons
will be enabled.

3. Select an entry from the list, the County/sub region list will be filled.
4. Click Finish to close the location browser and create the map.

Tip: Clicking the Search button switches the Quick Map tool to the search tool
mode.

To set the map location

Set Location

Long. () | 114.0000C =
= Kilometres
Metres

Lat. ¢y) | 22.00000 et
ards

=

Radius I 360.00 :II |Kilometres LI

[o]4 I Cancel |

1. Click the Set Location button in the WME to open the Set Location dialog box.

2. Enter the longitude, latitude, and map size radius in miles, kilometers, meters or
yards.
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3. Click OK to calculate and display the map in the Map Area .

To pick alabel and add it to the map

- Indonesia E‘
Aceh !
Eal e
Bangka-Beliung .
Earien
Benghubs |

I~ Wisible [Fegan vl |<F|I|e|)

Type | Mame ¥ ~ ﬂ
G- Bali . ﬂ
6 sangka-Belitung
'\:. Banten
§ oo @
g“;- Gorankslo
G Jakarta Raya
1. Perform a search and select a location.

Click the Pick Feature button to display all the phantom labels for the selected
area.

3. Click a label to add it to the map.

To move a label

Pick Browse Move Add Add Edit
Feature Map  Label Label |Streets Shaoe  Shape

(€ (1§88 OBraeia o [

Move Label Point

wRotate Label

1. Click the drop-down button to open a list of options.

2. Select one of the options and then select a label on the map and move the label
around in the graphic display.

10.1.9 Map Details Area

Map Details
EONSSS—
@ Austria
< ‘=
U Sweden
@ Israel &Iﬂﬂl
E Tha:lan;:l “l
8] Englan: .
“
Style: | Selected Region i
Font Size: |12 vl [~ &l Caps

The Map Details area displays a list of all the added locations over the map. The user
can modify the map, by selecting one of the added places and the control buttons on
the right side of the map details area.

Map Details parameters
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Style: Sets or modifies the graphic display representing the selected place on the
map. The style selection will affect the highlighting color used to mark the selected
place, the label, and so on.

Font Size: Sets the font size used for the label in the graphic display. Font size is
only relevant for the display in the editor and for text labels that are exported as
part of the map texture; hence, it will not affect the size of labels rendered by Viz.

All Caps: Uses only capital letters in the graphic display when showing the selected
place’s label.

d= Rename label button: Opens the Rename Label dialog box that will allow the
user to customize and add other labels to the database by entering a new label
for the selected place or by selecting an existing label from the list of labels or
modifying an existing label.

* Remember change and publish to all users: When this option is checked,
the renamed label will be added to the database. Whenever the place is
selected, all the customized labels will be available for selection by the user.
When the option is unchecked, the modified label will be used only by the current

map.

Rename Label
| My Place j
I” Remember change and publish to all users

()8 | Cancel |

“ Delete place from map: Removes the selected entry from the map (and from
the map details list).

Delete all places from map: Removes all added places from the map (and
from the map details list).

10.2 Using the Map Editor

This section describes how to use Viz World’s Map Editor (WME) with Viz Artist, Viz Pilot
client (which includes how to use Viz Template Wizard and the Newsroom Component),
Viz Trio and Viz Weather.

This section contains information on the following topics:
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To test with Viz Artist

To test with Viz Pilot

To test with Viz Trio

To test with Viz Weather
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To test with Viz Artist

e TSN WP . ESNRrSRN Ny - e

[ e cunicusstaptient

Viz Artist requires no additional setup as long as the Viz World Client is installed, and
the map server settings in Viz Config’s Maps section have been activated.

Open a map scene

Locate and click the CWMClient icon in the tree structure to open the CWMClient
Editor.

In the editor, click the Viz World Map Editor (WME) button to open the editor.
Search and select a map, and click OK to add a map to the scene

Note: Make sure that ControlMap plugins are placed on the same containers as
the CWMClients in order for Viz Pilot to be able to change their maps.

To test with Viz Pilot

['ﬁVhdem Wizard v. 5.3.0 - Database: VIZ-xwd JO0DOC
Be fot Bew VoEngre Tods Hep

Viz Pilot’s map server parameters are stored on the Viz Pilot database. The parameters
can be set or changed using the Viz Pilot client (Options > Preferences > Viz World).

For an operator or journalist to be able to change maps, the map scenes must use
the ControlMap plugin. Also, before the scene can be used in the Viz Pilot client or
Newsroom Component a map template must be created using Viz Template Wizard.
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Start Viz Template Wizard
Import a Viz Artist map scene to the Viz Template Wizard

¢ [If a ControlMap plugin is used by the designer an image component will be
automatically added to the template

* A template user clicking the image component will then be able to open Map
Editor to select a map

3. The ImageSources property should be set to IsAdvancedCuriousMap
Save the template to a concept

Once the template is stored it can be opened by the Viz Pilot client or Newsroom
Component.

Eeach | v | e | e | T | — A
——— et Sl I ) [N
s

P e
IR

Tt |raeey

|3 % |8

1. Start the Viz Pilot client or Newsroom Component, and open the newly created
template.

Click the image in the template to open the WME.

Enter a search criteria (for example London)

Select London City, England from the list

Tick London City, England, and click the zoom button (map icon) for England
Click OK to close the WME.

Save a data element of the template and add it to the playlist.

© N v ks WwN

Play or preview the scene on a local Viz Engine renderer to see the map
animations.
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To test with Viz Trio
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Viz Trio’s map server parameters are set by the local Viz Engine that Viz Trio uses to
render the scenes locally; hence, there is no need to configure Viz Trio.

Start Viz Trio

Select Import Scenes from the drop-list in the Editing window.

Locate and import a tutorial scene to create it as a Viz Trio template.

Select and double-click to open the newly added template.

Click the Browse Viz World button to open the editor.

Enter a search criteria (for example London)

Select London City, England from the list

Tick London City, England, and click the zoom button (map icon) for England

© X N Uk WwWNH

Play the scene in Viz Trio so see the map animations

To test with Viz Weather

To enable Viz World capabilities add the following entry to the Viz Weather INI file:
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[CURIOUS]

cwm_enabled=y

simplified=n

Open a map enabled scene in the editor
Click the Map button on the editor toolbar
Click the Map icon to select a map

P w N

Select From Server

* When selected, a full version of the map editor opens
Select a map project

Enter a search criteria (for example London)

Select London City, England from the result list

Enter a new search criteria (for example England)

© ® N o U

Select England from the result list

CIEIE

10. Adjust the view and style of the map

* Use the map buttons (lower right) in Viz World Client
11. Click OK to close the map editor.
12. Play the scene in Viz Weather to see the map animations.

10.3
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Map Name Editor

&7 Map Marmes EQt)

World Server localhost Connect

Pk World »

Capital Region Town > 1M Town > 100K Town > 10K Town > 1K

Demeocratic Republic  Democratic Republic

Denmark

Djibouts
Dominica
c  Dominican Republic
East Timor
Ecuador
Egypt
El Sahvador

TrINEmn NNTa

Ethiopia

Showing 273 Features

The Map Name Editor is a batch feature translation tool meaning that you can use it to
edit multiple language translations stored at the Viz World Server.

¢ World Server: Allows you to connect to the Viz World Server using either hostname
or IP address. Click the Connect button to connect with the server.

Once logged in you can display all features at four different region levels; World,
Country, Region and Sub Region level. However, this depends on the levels available
for each country (e.g. the United States of America has all four levels, while Oman only
has three levels).
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Once you have chosen the regional level you want you can further filter your result or
select one or several of the pre-configured layer buttons.

b World » Filter :

Capital Region Town > 1M Town > 100K Town > 10K Town > 1K Other

v DB Name

Democratic Republic  Democratic Republic o Country

Alternate Name

Denmark Denmark Country

User Name
Diibouti Diibouti o T P Pt Country
Dominica German Country
Dominican Republic ¥ Hebrew Country

East Timor East Timor ¥ Japanese

v Ty,
Ecuador Ecuador Type

Egypt Egypt

If you right-click the column headers you can display different columns. The standard

columns are Display Name, DB Name, Alternate Name, User Name, Abbreviations and
Type. In addition you can add you custom language alternatives and choose to display
them using the context menu.

See Also

e Using the Map Name Editor

10.4

Using the Map Name Editor

This section describes how to use the Map Name Editor. See the following sections for
more information:

e To create a new language file

e To add language specific translations

¢ To use the new language file

To create a new language file

Start Windows Explorer
2. Create a folder named Languages in the following location:

* 32 bit: c:\Program Files\Curious Software\Curious World Maps
\SharedData

* 64 bit: C:\Program Files\vizrt\Viz World\SharedData

3. In the folder you can either place an empty file called <my language>.mdx or
copy and rename UserNames.mdx (if you already have changed a lot of the label
names)

P World P Belgium P Bruxelles

Capital Region  Townlm TownlOOk TownlOk = Townlk Other

Anderlecht Anderlecht Townl0K

Brussels Bruxelles _ Capital

4. Start the Map Name Editor executable found under

* 32 bit: c:\Program Files\Curious Software\Curious World Maps

Copyright © 2016 Vizrt Page 111



Page 112

Viz World Client and Server User’s Guide

* 64 bit: C:\Program Files\vizrt\Viz World
5. Edit the new file
* Your language will be added as a new column

6. Click Save Changes

To add language specific translations

Start the Map Name Editor
Connect to your Viz World Server

Right-click and select your language column representing your custom language
file

Search for the name that needs a language specific translation
5. Enter the translation and click Save Changes

To use the new language file

Start the Server Configuration tool and log on to your Viz World Server
Select the Maps’ Display section
Set the Alternate Label Display’s first option to be M-Language (multi-language)

P w N E

Start for example Viz Artist, create a maps scene and launch the Map Editor
(WME)

Guides

Languages English
Server Priority » | ¥ Morwegian o
S o|Brussel | %

5. Right-click the map area and select your language from the appearing context
menu

Note: Setting a language in WME does not affect the language used in Viz
Artist.

6. For Viz Artist add/edit the VizWorld.ini file under C:\ProgramData\Vizrt
\viz3\Maps and add the following entry:

language=[my Language ID]
7. or (dynamically) send the following command to Viz Engine:
MAPS LANGUAGE [my Language ID]

Note: my Language ID refers to the order in the list of languages, English
= 0, Norwegian = letc. See the above screenshot.

See Also

¢ Map Name Editor
e Display
¢ Maps Configuration
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11 Photoshop Plugin

The Viz World Photoshop Plugin is used to integrate Viz World and Adobe Photoshop
files. Maps created with the Photoshop Plugin will create a new file with separate layers
for every feature and detail on the map.

Note: The Photoshop Plugin must be installed separately, see Installing Photoshop
Plugin.

This section contains the following topics:

¢ Working with the Photoshop Plugin
¢ Photoshop Layers

¢ Viz World Settings in Photoshop

Working with the Photoshop Plugin

Once the plugin is installed, you will be able to open Map Editor Classic from within
Photoshop.
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In Photoshop, go to File > Scripts and you will see the Viz World options.

File
New... Ctrl+MN

Edit Image Layer Type Select Filter 3D View Window Help

m Controls:

Open... Ctrl+O
Browse in Bridge... PN PO SFL ECTED LAND"™, Layer Mask/8) * =
Browse in Mini Bridge... § . N o g o
Open As... Alt+Shift+ Ctrl+ O
Automate 4
Scripts 4 Image Processor...
File Info... Alt+Shift+ Ctrl+] Delete All Empty Layers
Print... Ctrl+P Flatten All Layer Effects
Print One Copy Alt+Shift+ Ctrl+P Flatten All Masks
Exit Ctrl+Q Layer Comps to Files...
Layer Comps to PDF...
Layer Comps to WPG...

Export Layers to Files...

Script Events Manager...

Viz World Map Editor...
Viz World Refresh Map...
Viz World Save As Geotiff...

iz World Setting...

The options that the plugin adds, are:

¢ Viz World Map Editor
¢ Opens Map Editor Classic.

¢ Select a TPL, style, and so on, then browse and add details to your map.

* After making your selections and clicking OK, a new Photoshop file will be
created with all the layers of the different features and details on the selected
map.

* Viz World Refresh Map

¢ Opens Map Editor Classic with the selections and map from the previously
generated Photoshop file.

¢ Modify your selection, add details to the map, and so on.

* After making your selections and modifications and clicking OK the changes will
be applied to the existing Photoshop file instead of creating a new file.

¢ Viz World Save As Geotiff: Save the file as a GeoTIFF file (a TIFF file which
includes georeferencing information)

* Viz World Setting: Opens the settings window (see Viz World Settings in
Photoshop)

Photoshop Layers

The Photoshop Plugin creates 5 layers in your Photoshop file. The following two layers
are always created:

e All Layers (a raster image of the final selected map)
¢ Base Map (a raster image of the land and sea without any selections)

The remaining three layers can be configured in the Viz World Settings in Photoshop
window.

Viz World Settings in Photoshop
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To open the Viz World Settings, go to File > Scripts > Viz World Setting

5] Viz World Setting |
Server Name:
[localhost |
M Layer 1
[] Base Map [Jlabels [+]5ea
[]Selected Regions [ |Roads [ ]Lat Lon Grid
[+ Borders []Rail []Events

[]Selected Borders  [#land [ |Data

[ Layer 2
[] Base Map [Jlabels []S5ea
[ Selected Regions [ |Roads [ ]Lat Lon Grid
[]Borders []Rail []Events

[ Selected Borders [ |Land [ ]Data

[ Layer 3
[] Base Map [#Labels []Sea
[]Selected Regions [ |Roads [ ]Lat Lon Grid
[[] Borders []Rail []Events

[]Selected Borders [ |Land [ ]Data

Please specify the server and layers for saving Viz World
configuration file.

¢« Server Name: Viz World Server Host name

* Layer 1/2/3: The Photoshop Plugin creates 5 Photoshop Layers. Three of these
layers can be configured here by selecting the features that should be included.
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12 Geometry Plugins

The World Map Editor (WoC) installation includes a package of plugins used for

enhancing the geographic referencing ability in Viz Artist. The WoC plugins include

geometry, container, shader and scene plugins.

This chapter describes all geometry plugins. The geometry plugins are found in three
plugin folders:

See the following sections for more information:

Maps: Contains Standard plugins.
Maps-Adv: Contains Advanced plugins.

Maps-Obs: Contains Obsolete plugins, installed only for backward compatibility.

These plugins should not be used when designing new scenes.

Standard

2D Label
3D Border
3D Line

3D Model
3D Region
3D Roads
Atlas

C3D Terrain
Geolmage
Globe
Label and Go

Map Scale
Pyramid Control

Shadow Agent

Shape to Spline
Street Labels

Advanced

3D Border Control

3D Line Control

3D Region Control

GeoChart
Region Halo

Obsolete

Flat MR

See Also
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e Container Plugins

¢ Shader Plugins
e Scene Plugins

12.1 2D Label

LD

g -
2DLabel

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The 2DLabel plugin is used for creating two dimensional labels on the map, based on
labels received from the selected map or automatically generated labels generated
by the Label Manager Plugin according to the map information received from the

Navigator plugin.

Note: When adding a 2DLabel plugin to a container, a World Position plugin and
an Alpha plugin will be added automatically to the same container. The Label
Manager Plugin scene plugin has to be added manually to the scene when using
the 2DLabel plugin without a Navigator plugin.

This plugin has five sections of parameters (GUI Options):

* Label
* Bevel
e Caption
* Special
¢ Fade
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12.1.1 Label

2DLabel Plugin (14.0.0)

Margin Options
Width Margins

Heig!

Label Color

Outline Caolor

(cal

* Margin Options:
¢ Equal Spaced: Uses equal spacing for the side margins and top/bottom
margins.
¢ Separate: Uses different margins for each side of the labels.

* Width Margins, Left/Right Margins: Sets the margin between the sides of the
text and the label background edges.

* Height Margins, Top/Bottom Margins: Sets the margin between the top and
bottom of the text and the label background edges.

¢ Outline Width: Sets the width of the label’s background outline.
* Label Color: Sets the color of the label’s background fill.
¢ Outline Color: Sets the color of the label’s background outline.

Note: The numeric values next to the color parameters are the alpha values of
the label and the label outline.

Note: The color palette effects only the selected color parameter (label or
outline), and it will appear when one of the color parameter is selected. (Viz 3).

12.1.2 Bevel

« Bevel: This parameter defines the bevel value of the label’s background corners.

* Roundness: This parameter defines whether the background corners will be
rounded or not.

* Detail: Defines the quality of the label object (when a higher value is selected,
more polygons will be used to build the label object).

¢ Lock Aspect: When enabled (On), the bevel and roundness parameters will be
applied to the corners of the label object equally. When disabled (Off), the bevel and
roundness parameters will be applied to the corners using the object’s height and
width ratio.
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Caption

m

2DLabel Plugin {14.0.0)

e[ eee GRS seese | rede |

[RRGETT T Length |

30.0 ":F
0 =)

Pivot: Defines the label’s object shape and location in relation to the label’s
geographic location:

* Pointer: The label object includes a pointer going out of the label background
and pointing at the label’s geographical position. When selected, additional
parameters will be enabled: Width and Connection Bevel.

¢ Outline: The label object has a rectangular shape and the outline of the shape is
on the label’s geographical position.

¢ Center: The center of the label is placed over the label’s geographical position.

« Offset: The label is placed at the defined offset from the label’s geographical
position.

* Position: Used by Auto Street Labels to suggest a few possible locations for the
label (positions along the street) so that Label Manager can pick one of them.

Width Type: Defines whether the (strap) width should change as the caption is
moving away from the tip or stay fixed.

Width: Defines the width of the pointer’s base overlapping the label background.
This parameter is only enabled when Pointer is selected.

Connection Bevel: Defines whether the area connecting between the pointer and
the label background is to be rounded or sharp. This parameter is only enabled
when Pointer is selected.

Rotate Labels: Defines whether labels, created in Viz (3D labels), will be rotated
like the labels in World Map Editor or Map Editor Classic (WME). If set to Off, all
labels will be displayed horizontally. If set to On, labels that were rotated in Map
Editor will be rotated in Viz.

Caption Source: The options Default Position, WME Directions and Label
Manager Presets include the properties described below.

Default Position

This will be used when adding labels in WME when no direction is selected.

Direction (deg): Sets the angle of the label in relation to its geographic position.
Distance (cm): Sets the distance of the label from its geographical position.

WME Offsets Distance: Enables the WME to offset the distance (default ON).
When disabled (OFF) only the direction offsets from WME is used and the distance
ignored.

WME Directions
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12.1.4

This allows you to set and fine tune offsets for every direction available in WME. When
selected, the labels will be placed as they were placed on the map in the Map Editor.
When manually set inside WME they will always take priority over the presets and
Default Position settings.

« WME Compass Rose: Corresponds to the available directions inside the WME, as
shown in the following image.

« Direction Offset (Degrees): Values for fine-tuning the position of the label
« Distance (Viz units): Distance offset for fine-tuning the position of the label

Label Manger Presets

When this is selected, the LabelManager plugin will use the defined presets to place the
labels over the map. The LabelManager plugin will optimize the label position such that
the labels will not overlap.

« Number of Presets: Defines the number of label position presets available to the
user (one to four presets).

e Current Preset: Selects the preset number to be configured, using the Direction and
Distance parameters. Each preset should be selected and the label position should
be adjusted.

» Direction (deg): Sets the angle of the label in relation to its geographic position.
* Distance (cm): Sets the distance of the label from its geographical position.

Special

« Shape: Defines the pointer shape:

¢ None: The pointer will have a sharp point shape.

¢ Circle: The pointer will have a circle at the tip of the pointer.

e Square: The pointer will have a circle at the tip of the pointer.

e Straight: The pointer will have straight lines at the tip of the pointer.

* Size: Defines the size of the shape at the tip of the pointer. The parameter is only
enabled if the pointer is selected and a tip shape is set.

« Navigator Overlay: Defines how the label will be displayed over the map.
Available options are Disabled, Fixed, Scaling, Near Scale and Far Scale.
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+ Disabled: Places the label on the map using its geographical referencing.

* Fixed: Places the label by keeping its geographical referencing but using a
different camera (either with dynamic image or with a front layer). The label size
will remain fixed.

¢ Scaling: Places the label by keeping its geographical referencing but using a
different camera (either with dynamic image or with a front layer). The Label will
scale trying to imitate the camera movement.

* Near Scale: Defines the maximal size of the label on the screen (that is when
zooming in what will be the final size of the label).

¢ Far Scale: Defines the minimal size of the label on the screen (that is when
zooming out what will be the final size of the label).

* Static Map Scale: Defines whether scaling of the label will be performed over

a static map (no Navigator plugin used). When disabled (Off), no scaling will be
applied to the labels. When enabled (On), an additional parameter will be enabled:

* Scale: Sets the scaling factor of the labels when used over a static map (no
Navigator Plugin).
* Collision Mode: Defines how the labels will be placed when an overlap or collision
between two labels occur:

e Tip Based: The pointers of overlapping labels can cross or touch, but no overlap
of label bodies are allowed.

* BBox Based: A bounding box is calculated around the entire label (label body and
pointer). Overlap between a label’s bounding box is not allowed.

« Hide if Empty: will Hide the container of the label if the Label text is empty.

12.1.5 Fade

Fadedefines the fade effect parameters to be used with the duplicated labels. Fade has
two fade modes; Stand Alone and Controlled.

Stand Alone

Fade On Time

Fade On Lat/Long

Lat/Long

2

+ Stand Alone: The label appearance is manually defined by setting the additionally
enabled parameters:

« Fade On Time: Defines a label fade effect, beginning at a relative point to the
defined hop duration. An additional parameter will be enabled, Time To Hop,
defining when the fade will occur.

* Fade On Distance: Defines a label fade effect, beginning at a relative distance
from the hop final location.

Note: The Fade On Distance parameter is only enabled if Navigator Overlay is
set to Scaling. See the plugin section Special.
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« Fade On Lat/Long: Defines a label fade effect, beginning at a Longitude and
Latitude offset from the hop final location. An additional parameter will be
enabled, Lat/Long, defining the offset from in degrees.

Controlled

With Fade Mode set to Controlled, the label appearance is automatically set by the
2DLabel plugin. It can also be based on the Label Manager Plugin plugin settings and
the Navigator plugin animation (hops).

¢ Step: Controls when the label will fade in and out in relation to an animation. In
general the fade can be based on the camera distance (for example; capitals are in
view when distance is below 1000KM) or on timing in relation to the hop:

¢ Auto: When a label is of type point (added by the user) it will fade in and out
based on distance to hop. If the label is of type place/region it will be faded in
and out based on the distance set in Label Manager Plugin plugin. If the hop is
not close enough for the label to show and the label was added by the user it will
be faded in based on hop timing and not distance.

e On Hop: Links the fade to the hop timing.

* Point 1/Point 2: These are reserved for labels where the distance is configured by
the Label Manager Plugin plugin.

« Hop and Above: Turns on at the hop and stays on thereafter.

¢ Selected Label Timing: If the label’s fading is based on hop timing, this parameter
sets the time in relation to the hop time. It is disabled if Step is set to Point 1 or
Point 2. Since the label appearance is automatically calculated this timing offset will
be used in the calculation. Select one of the options:

¢ At End: Labels appear at the end of the animation.

¢ Close to End: Labels appear just before the end of the animation.
¢ Ahead: Labels appear before the end of the animation.

¢ Well Ahead: Labels appear well before the end of the animation.

« Label Priority: Defines the priority of the currently edited label in relation to other
labels when a conflict between label positions occurs. The highest priority will be
preferred when displaying the labels.

¢ Auto: Sets the label priority using the Label Manager Plugin plugin.

* Normal, High: When there is a conflict between two normal (or high) priority
labels, the Label Manager Plugin plugin decides which label to show.

* Always: When always is selected, the label will be displayed even if it conflicts
with another label (with any priority).

12.2 3D Border

3DBorder

e
3DBorder
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The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The 3DBorder plugin is used for applying graphic designs to the border data retrieved
by the 3D Map Setting Plugin scene plugin. Each 3DBorder plugin is used to filter and
define which borders will be drawn.

Note: When adding a 3DBorder plugin to a container, a 3D Line Shader plugin will
be added automatically to the same container. The 3D Map Setting Plugin plugin
has to be added manually when using the 3DBorder plugin.

The Data tab is used for defining which borders will be displayed by the plugin. The
Width tab is used for defining the border width and other graphical related attributes.
The Outline tab is used for adding an outline to the borders. The Effect tab is used for
defining an animation of the border. The Advanced tab is used for defining general
parameters of the border.

This section contains information on the following plugin sections:
* Data

¢ Width

e Outline

+ Effect

* Advanced

e Rebuild button

12.2.1 Data

3DBorder Plugin {14.0.0)
OEEE| width || outne | Effect || Advanced |
[ Country " moEgER Al

Draw

Selection

Select [~ Region || Sub Region ' B
[IBESHEE  Enabled |

=

¢ Draw: Sets the border type that will be drawn by the plugin. Available options are
Country, Region and All.

e Country: Draws country borders only. When Country is selected, additional
options are made available: Country, Coastline and Both (see Select).

* Region: Draws region borders only. When Region is selected, additional options
are made available: Region, Sub Region and Both (see Select).

* All: Draws all available borders retrieved by the 3D Map Setting Plugin plugin.
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¢ Select: Displays the available Country or Region options when either of those two
options is selected.

¢ Country: Draws inland country borders only.

* Coastline: Draws country coastline borders only.

¢« Both (Country & Coastline): Draws both inland and country coastline borders.
* Region: Draws region borders only.

e Sub Region: Draws sub region borders only.

+« Both (Region & Sub Region): Draw both region and sub region borders.

* Selection: Defines whether the plugin will use the selected regions in the map
(received from the CWMClient plugin) or not. If enabled, only the borders of the
selected regions in the map will be drawn. If disabled, all borders will be drawn
according to the plugin settings (country, region, and so on).

12.2.2 Width

3DBorder Plugin (14.0.0)

Width

Width (Kilometers)
Minimum Width
Maximum Width (Pi
Minimum Draw Wid

Fade Edge (%)

s

¢ Fixed (Pixels)- Uses a fixed width when drawing the line. This parameter will
cause the line to maintain the same width regardless of camera position/distance.
Available parameters are Width and Fade Edge.

¢ Width (Pixels): Sets the line width in pixels.

 Fade Edge (%): Sets the percentage of softness added to the edges of the line.
When set to 0% the line edges will be sharp and when set to 100% the edges will
be soft.

* Scaling: When selected, line width will vary according to the camera distance from
the map. Available parameters that allow the user to set the line attributes are
Width, Minimum Width, Maximum Width, Minimum Draw Width and Fade Edge.

* Width (Kilometers): Sets the line width in meters on the map. The closer the
camera to the map, the wider the line will be drawn.

¢ Minimum Width (Pixels): Sets the minimal line width in pixels. If the
calculated line width (according to the Width parameter) is smaller than the
Minimum Width value, then the Minimum Width value will be used.

« Maximum Width (Pixels): Sets the maximal line width in pixels. This value will
be used when the camera distance is small and the line width should have been
larger than the Maximum Width value (in pixels).

¢ Minimum Draw Width (Pixels): Sets the minimal line width in pixels. If the
calculated line width (according to the Width parameter) is smaller than the
Minimum Draw Width value, and larger than the Minimum Width parameter, then
the line will not be drawn.

 Fade Edge (%): Sets the percentage of softness added to the edges of the line.
When set to 0% the line edges will be sharp and when set to 100% the edges will
be soft.
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¢ Fixed (Mm)- Uses a fixed width, in viz units, when drawing the line. This parameter
will cause the line to maintain the same width regardless of camera position/
distance. Available parameters are Width and Fade Edge.

¢ Width: Sets the line width in pixels.

« Fade Edge (%): Sets the percentage of softness added to the edges of the line.
When set to 0% the line edges will be sharp and when set to 100% the edges will
be soft.

« See Me Now: Calculates (when width is set to scaling) the width needed for the
line to be visible at a given distance.

Outline
3DBorder Plugin (14.0.0) 1
Qutline [None [ Master | Slave |PStandAlonen|

Outline Width (%) oS

Outline Fade (%) o 2
Outline Colar [ G

* None: No outline to the borders is drawn by the plugin.

¢ Master: Acts as the master plugin for outline behavior. Other 3DBorder plugins
can be set as clients of this plugin. The same outline attributes will be applied to
borders drawn by the master plugin and by all other slave plugins. When selected,
the Outline Width (%), Outline Fade (%) and Outline Color parameters are also
available.

* Slave: Draws the outline according to the defined outline in the master plugin
above it in the scene hierarchy. All other parameters will be disabled, displaying the
master’s values.

+ Stand Alone: Defines the outline parameters for the borders drawn by this 2D
Label plugin only. When selected, the Outline Width (%), Outline Fade (%) and
Outline Color fields are also available.

¢ Outline Width (%): Sets the width of the outline, as a percentage of the border
width, where 0% is the border width.

¢ Outline Fade (%): Sets the percentage of softness applied to the outline edges.
¢ Outline Color: Sets the color of the outline and the alpha value of the outline.

Note: The hierarchy structure is important when using the master/slave outline
configuration. The master plugin should always reside as the first container in
the group of 3DBorder containers. An Expert plugin should be added to the map
(above the 3D Roads containers) and Z-Buffer Draw should be set OFF.

Effect

3DBorder Plugin (14.0.0)
[ Das | wath | Outine | POVEREE] Advanced |

Border Length 100.0 ;F

Fade 10.0 ?ﬁ

aca
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12.2.5

The Effect tab is used for creating an animation on the line size. After the line object is
created, it can be animated by setting keyframes of the length parameter.

Border Length: Sets the line length, where the value 100 represents 100% of the
line length.

Fade: Defines the softness that is added to the line edge as the length animation
advances. When the length is 100, the end of the line will not be affected by the
Fade parameter.

Advanced

The Advanced tab is used for defining general parameters for the 3DBorder object.

3D8order Plugin (14.0.0) L
0.0

=

o Enebied

" Simvle ARG

Height Offset: Offsets the borders from the map (on the fly).
Border Quality: Selects the quality of the border line:

e Controlled: Border quality is calculated by the navigator distance from the
border object.

* High: Uses high quality when drawing the border line (performance will be
slower).

¢ Medium: Uses medium quality when drawing the border line.

¢ Low: Uses low quality when drawing the border line. Border line will look
pixelized when zooming into the map.

Add Level Down (Shape File): Defines whether the sub region borders will be
drawn with the region borders, or if regions will be drawn with countries.

Control Mode: Defines whether the 3DBorder object is externally controlled by the
3DBorderControl plugin or not. Border objects are controlled by groups.

Set Groups: Set the group number for the object.

Line Shader: Line shader has 2 variants. The first is Simple with less options (and
better performance), while the second is more Advanced and allows for more
options (but at the cost of performance).

Update Texture Mapping: Should the texture coordinates be updated based on
line width.

Low Angle Compensation: Lines become too thin at low camera angles as a
result of the perspective distortion. When that happens, there are not enough pixels
to support a smooth, anti-aliased line, and the lines look jagged and aliased. This
mode compensates for that by both widening the lines and applying transparency
when they are viewed at too low angles.
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* Debug: Enables debug messages in the console

¢ Min Angle: If the angle between the camera and the ground below the line is lower
than "Min Angle", then line width and transparency will not be changed.

* Max Angle: If the angle between the camera and the ground below the line is
higher than "Max Angle", then the line width is increased by the "Width Factor" and
the transparency is scaled by the "Alpha Factor". If the angle is between Min Angle
and Max Angle then the width and transparency are interpolated.

¢ Outline Angle Offset: For outline width, apply an offset to the angle calculation in
order to make the outlines affected at higher angles than the lines themselves

*  Width Factor (%): A factor for modifying line width when applicable.
¢ Alpha Factor (%): A factor for modifying line alpha when applicable.
* Wireframe: Shows the border object as a wireframe.

¢ Print Sub Area Data: Print to the console all the sub regions in the plugin (used for
elections).

12.2.6 Rebuild
A
The Rebuild button triggers the plugin to redraw the borders according to the plugin
parameters. Some parameters are updated as the parameters are changed and do not
require a rebuild command, but it is good practice to rebuild the borders after setting
the parameters.

12.3 3D Border Control
3DBorderCtrl

| ]
3DBorderCo
The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps-
Adv.
The 3DBorderControl plugin is used to control the attributes of a group of 3DBorder
objects. The plugin controls the applied material, border width, edge softness and
visibility.
Note: The 3DBorderControl plugin does not build the 3DBorder objects. The
controlled 3DBorder objects should be built before the 3DBorderControl is used.

The 3DBorderControl plugin has two modes:
* Control for defining the control mode
¢ Width for setting the border parameters.

12.3.1 Control
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* Container: Placeholder for the top container of the 3DBorder objects. All controlled
3DBorder objects must reside directly under the top container. Any lower level
containers will not be effected.
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* Control Mode: Defines how the objects will be grouped when controlled by the
3DBorderContol plugin. When set to Level, the 3DBorder objects will be grouped by
their data type (that is country, region and sub-region).

Control Mode Level

3DBorderControl Plugin (14.0.0)

Container [

s i

e Grow
Couny REgER™| Al
Region Sub Region E

* Draw: Defines what data types will be drawn. 3DBorder objects with other data
types will not be switched off:

e Country: Shows 3DBorder objects displaying country borders only.

+ Region: Shows 3DBorder objects displaying region and sub region borders only,
according to the user selection. Available options are; Region (draws region
borders), Sub-Region (draws sub-region borders) and Both (draws both region
and sub-region borders).

¢ All: Draws all border types (that is country, region and sub-region).

Control Mode Group

Container

¢ Group: Defines the group number that will be visible and controlled by the
3DBorderControl plugin. Groups are defined in the 3D Border plugin in the Advanced
tab’s Set Groups parameter.

12.3.2 Width

Container

width
width

Fade Edge (%)

* Fixed (Pixels): Uses a fixed width when drawing the line. This parameter will
cause the line to maintain the same width regardless of camera position/distance.
Available parameters are Width and Fade Edge.

¢ Width (Pixels): Sets the line width in pixels.

 Fade Edge (%): Sets the percentage of softness added to the edges of the line.
When set to 0% the line edges will be sharp and when set to 100% the edges will
be soft.
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¢ Scaling: When selected, line width will vary according to the camera distance from
the map. Available parameters that allow the user to set the line attributes are
Width, Minimum Width, Maximum Width, Minimum Draw Width and Fade Edge.

* Width (Kilometers): Sets the line width in meters on the map. The closer the
camera to the map, the wider the line will be drawn.

¢ Minimum Width (Pixels): Sets the minimal line width in pixels. If the
calculated line width (according to the Width parameter) is smaller than the
Minimum Width value, then the Minimum Width value will be used.

¢ Maximum Width (Pixels): Sets the maximal line width in pixels. This value will
be used when the camera distance is small and the line width should have been
larger than the Maximum Width value (in pixels).

¢ Minimum Draw Width (Pixels): Sets the minimal line width in pixels. If the
calculated line width (according to the Width parameter) is smaller than the
Minimum Draw Width value, and larger than the Minimum Width parameter, then
the line will not be drawn.

* Fade Edge (%): Sets the percentage of softness added to the edges of the line.
When set to 0% the line edges will be sharp and when set to 100% the edges will
be soft.

¢ Fixed (Mm): Uses a fixed width, in Viz units, when drawing the line. This parameter
will cause the line to maintain the same width regardless of camera position/
distance. Available parameters are Width and Fade Edge.

¢ Width: Sets the line width in pixels.

 Fade Edge (%): Sets the percentage of softness added to the edges of the line.
When set to 0% the line edges will be sharp and when set to 100% the edges will

be soft.
12.4 3D Line
3DLine
Y
e R
3DLine
The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.
The 3DLine plugin has several graphic uses:
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Drawing shape lines created in the Map Editor (WME) when selecting a map. A line
design is created in the hierarchy and defined in the CWMClient plugin (see 3D
Objects and Shapes ).

Drawing a line between label locations, defined in the WME, from the first label in
the list to the last label in the list. Labels in the CWMClient plugin must be enabled
when using this mode.

Drawing a line along hop points defined in a Navigator scene. The line will follow the
path of the Navigator animation between the hops.

Drawing a line using a Long/Lat coordinates list. The line will be drawn from the first
Long/Lat pair to the last.

Note: When adding a 3DLine plugin to a container, a 3D Line Shader plugin will
be added automatically to the same container. The 3D Map Setting Plugin plugin
has to be added manually when using the 3DLine plugin with Navigator plugin.

The 3D Line Manager plugin is used for controlling and creating 3D Line objects.

Note: Some of the uses of 3Dline plugin as described above requires the use of
the Label Manager Plugin plugin in the scene.

This plugin also works together with plugins such as: Trace It

This section contains information on the following topics:

Width

Outline

Effect

Control
Advanced
Rebuild button

12.4.1 Width

3DLine Plugin (14.0.0)

Width
Width (Meters)

Note: Width parameters, Fixed (Pixels) and Scaling, will effect the line object only

if the scene uses a Navigator plugin. In case of a static map, use the Fixed (Mm) to
set the line width.

Fixed (Pixels)- Uses a fixed width when drawing the line. This parameter will
cause the line to maintain the same width regardless of camera position/distance.
Available parameters are Width and Fade Edge.

¢ Width (Pixels): Sets the line width in pixels.
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Fade Edge (%): Sets the percentage of softness added to the edges of the line.
When set to 0% the line edges will be sharp and when set to 100% the edges will
be soft.

¢ Scaling: When selected, line width will vary according to the camera distance from
the map. Available parameters that allow the user to set the line attributes are
Width, Minimum Width, Maximum Width, Minimum Draw Width and Fade Edge.

Width (Meters): Sets the line width in meters on the map. The closer the
camera to the map, the wider the line will be drawn.

Minimum Width (Pixels): Sets the minimal line width in pixels. If the
calculated line width (according to the Width parameter) is smaller than the
Minimum Width value, then the Minimum Width value will be used.

Maximum Width (Pixels): Sets the maximal line width in pixels. This value will
be used when the camera distance is small and the line width should have been
larger than the Maximum Width value (in pixels).

Minimum Draw Width (Pixels): Sets the minimal line width in pixels. If the
calculated line width (according to the Width parameter) is smaller than the
Minimum Draw Width value, and larger than the Minimum Width parameter, then
the line will not be drawn.

Fade Edge (%): Sets the percentage of softness added to the edges of the line.
When set to 0% the line edges will be sharp and when set to 100% the edges will
be soft.

¢ Fixed (Mm)- Uses a fixed width, in viz units, when drawing the line. This parameter
will cause the line to maintain the same width regardless of camera position/
distance. Available parameters are Width and Fade Edge.

Width: Sets the line width in pixels.

Fade Edge (%): Sets the percentage of softness added to the edges of the line.
When set to 0% the line edges will be sharp and when set to 100% the edges will
be soft.

* See Me Now: Calculates (when width is set to scaling) the width needed for the
line to be visible at a given distance.

Outline

Outline

3DLine Plugin (14.0.0) ]

[er T e

outline width (%) | 6.8 B[

0.0 r—‘.F
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¢ Outline: Enables (On) or disables (Off) outline.

Outline Width (%): Sets the width of the outline, as a percentage of the border
width, where 0% is the border width.

Outline Fade (%): Sets the percentage of softness applied to the outline edges.
Outline Color: Sets the color of the outline and the Alpha value of the outline.

Note: The color palette is visible in all tabs of the editor, but it will only effect the
outline color.
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12.4.3

12.4.4

Effect

The Effect tab is used for creating an animation on the line size. After the line object is
created it can be animated by setting keyframes on the length parameter.

3DLine Plugin (14.0.0)

Length: Sets line length, where 100 is 100% of the line length.

Fade: Defines the softness that will be added to the line edge as the length
animation advances. When length is 100 the end of the line will not be affected by
the Fade parameter.

Animation Length (frames): Sets the default length of the reveal animation in
frames (relates to the Run Animation option) and allows you to run a simple reveal
animation by pressing the Run Animation button (used by 3D Map Telestrator)

Lock To Navigator: When using the 3D Line plugin with a Navigator plugin, the line
will animate with the Navigator animation. The starting point of the line will be the
first hop location and the ending point of the line will be the last hop position. The
line will animate as the hop animations are playing.

Run Animation button: will play the animation of that particular line

Control

The Control tab is used for defining external control parameters. External control is
done by the 3DLineControl plugin.

3DLine Plugin (14.0.0)

[ width | Outine || Effect ||WEaHERGI| Advanced |
de  [Disabled | ERuBEA|

Control Mode: Defines whether the object is externally controlled or not.

Set Groups: Defines the groups that the current 3DLine object is a member of. The
same group names should be used in the 3DLineControl.

Shared Memory: What type of shared memory (viz 3 only) can be used in order to
control the lines

Identifier: Shared memory name and general purpose Identifier for this line. Can be
used to control the line or to share a display list data between scenes.
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Advanced

3DLine Plugin (14.0.0)

Cap Edges: Sets the line’s cap shape:

¢ None: The line edges will not change.

* Round: Adds a a filled round shape to the line caps,
¢ Square: Adds a filled square shape to the line caps,

* Feather: Adds a feather shape to the line caps, An additional parameter will be
enabled when Feather is selected: Cap Fade Size.

Length Effect: Determines whether the separate polygons in the line will animate
at the same time (Per Polygon) or one after another (Continuous).

Wireframe: When enabled (On), the 3DLine object will be drawn as a wireframe.
Height Offset: Sets the height offset for the 3D Line object on the map (on the fly).
Line Offset: Sets the line offset for the 3D Line object on the map (on the fly).

Enable World Periodicity: When enabled (On), a line object that crosses the date line
will continue from the other side of the map. When disabled (Off), it will continue
across the date line.

Update Texture Mapping: Should the texture coordinates be updated based on line
width. You have the following options; Disabled, Always or Stationary. Stationary will
only update the texture mapping when navigator is moving.

Note: When enabled, symbols are easier to control, but as line width changes
the cause texture changes which might be disturbing.

Low Angle Compensation: Lines become too thin at low camera angles as a result

of the perspective distortion. When that happens, there are not enough pixels to
support a smooth, anti aliased line, and the lines look jagged and aliased. This mode
compensates for that by both widening the lines and applying transparency when
they are viewed at too low angles. When set to Advanced, the following additional
parameters are available:

« Debug: Enables debug messages in the console.

¢ Min Angle: If the angle between the camera and the ground below the line is
lower than "Min Angle", then line width and transparency will not be changed.

¢ Max Angle: If the angle between the camera and the ground below the line is
higher than "Max Angle", then the line width is increased by the "Width Factor"
and the transparency is scaled by the "Alpha Factor". If the angle is between Min
Angle and Max Angle then the width and transparency are interpolated.

Copyright © 2016 Vizrt



Viz World Client and Server User’s Guide

12.4.6

* Outline Angle Offset: For outline width, apply an offset to the angle calculation
in order to make the outlines affected at higher angles than the lines themselves

¢ Width Factor (%): A factor for modifying line width when applicable.
¢ Alpha Factor (%): A factor for modifying line alpha when applicable.

Rebuild

The Rebuild button triggers the plugin to redraw the lines according to the plugin
parameters. Some parameters are updated as the parameters are changed and do not
require a rebuild command but it is good practice to rebuild the lines after setting the
parameters.

12.5

3D Line Control

3DLineCaontr
The plugin can be found in the folder: Viz Artist 3: Built Ins ->Geometry -> Maps-Adv.

The 3DLineControl plugin is used for controlling 3D Line object groups. The Groups are
then controlled in terms of width and color. The groups are derived from the settings in
the 3DLine objects.

Control

3DLineControl Plugin (14.0.0)

Container

* Container: Sets the top container above the controlled 3DLine objects.

e Group: Defines the controlled group number. A group is defined in every 3DLine
object.

Width

3DLineContrel Plugin (14.0.0)

Container &

" Control | WGRI
Width Fixed ( Pixels) [ Sealing ] Fixed (mm)

Width (Kilometers) 50.0

Minimum Width (Pixels)

Maximum Width (|
Minimum Draw Width (Pixels) 2.0

Fade Edge (%) 50.0

e Width: Select one of the options to control the line width, Fixed (in pixels or in mm),
or scaling.

* Width: When fixed width is selected (pixels or mm), set the width value. Fixed
width the line will maintain the width value through all camera zoom range.
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When Scaling is selected, width is set in actual kilometers and the line width will
be calculated according to the camera zoom.

¢ Minimum Width (Pixels): Set the minimal value of line width in pixels. this value
will be used if the calculated width according to the width parameter is smaller
than the minimum width value (when zooming far out).

¢« Maximum Width (Pixels): Set the maximal value of line width in pixels. this value
will be used if the calculated width according to the width parameter is larger
than the maximum width value (when zooming in).

¢ Minimum Draw Width (Pixels): This value defines the minimal line width drawn.
* Fade Edge (%): Defines the edge fade width as a percentage of the line width.

12.6 3D Model
_IDllodels

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The 3DModels plugin is used for adding 3D models to your graphics scene. As the
models also contain geographical reference you may also place the model on a map.

The images above show a 3D model of Mont Saint-Michel in Normandy, France. The
model was downloaded from http://sketchup.google.com/3dwarehouse and then placed
on a satellite image from Digital Globe.

This section contains information on the following topics:

e Properties
e Working with 3D Models

12.6.1 Properties

3DModels Plugin

w Consolidation
File C: d t/doc.kml l_
Fil Mode PSS Wireframe | Dotted

off
Autc Fetch W Streaming

Fly To Reload Info Fetch Locally

General
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¢ File: Allows you to select the file to load. Capable of loading files in Collada
format with the *.dae extension or *.kml/*.kmz extension (which has geographic
information for the model and a link to a *.dae file inside).

* Fill Mode: Allows you to select the rendering mode; solid, wireframe or dotted.

¢ One Size: Allows you to recall the loaded model to a fixed size. Useful in non-
georeferenced mode.

* Automatic Fetch: used when loading 3DCities rather than single models, this will
enable fetching pieces of the city as you move around the map (Interactive) or
animate (Streaming).

Advanced

The Advanced tab is more suitable for a "streaming" mode of the plugin, when the
plugin loads/streams data out of a large data bank which cannot be loaded entirely due
to it’s size.

GPU Cache Size (mb) 350
Model index

Level of Detail

Height Offset

Show Coverage
Fetch Method
Loading Type

Fade Time (sec)

¢ GPU Cache Size: Limits the amount of data that will be loaded to the GPU. (Loaded
data may consume more size than expected on GPU).

¢ Model index: When more than one model is loaded, the parameter enables to 'run’
through loaded models (mostly for debug purposes). When a specific index is set,
the model is in focus, so the bounding box is shown and 'Fly To’ and 'Info’ buttons
can be used on that model.

* Level of Detail: Defines how many of the largest levels of the texture pyramid (dxt
format) can be neglected during loading. May be useful in cases where the texture
data is heavy and presents a higher resolution than that required to be shown.

* Height Offset: Height offset during fetch of the models.

* Show Coverage: When models are loaded/streamed from the large database, this
shows the total available geo coverage in green color and currently loaded coverage
in orange.

¢ Fetch Method: When models are fetched either by pressing the 'Fetch Locally’
button or in streaming mode, the plugin tries to load as much data around the fetch
point as possible (the amount is limited by the 'GPU Cache Size’ parameter). The
"Navigator’ option defines the fetch point as the current Navigator position while the
"Manual’ option enables you to define the fetch point manually.

* Loading Type: Useful when more than one model is loaded. The Serial mode may
be preferred for recording (using Viz Post) when you have to be sure that all the
models were loaded up until the next frame.

* Fade Time (sec): Defines the time period during which a new model will be faded
from transparent to opaque, to create a more pleasant looking effect on load.

Consolidation
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The Consolidation tab is used for compiling a binary format of the plugin out of Collada
files.

Model Optimization

Downscale Textures

* Model Optimization: Defines the level of optimization for the model while the
model is loading. More optimization may increase loading time while improving
rendering performance in some models.

 Downscale Textures: Defines how much the first levels of a texture pyramid may
be skipped.

Buttons

* Fly To: Used to take the camera to the model, if it is georeferenced (i.e. if the
original Collada file had *.kml or *.kmz files containing the geolocation). Requires
the presence of the NavFinder plugin on the container in order to work.

e Reload: Reloads the model.

¢ Info: Prints information about the model to the console. It prints information about
the dataset in the case when more than one model is loaded, and prints information
regarding a specific model if only one model is loaded or when the "Model index’
parameter is not zero.

¢ Fetch Locally: A manual command to fetch models around the fetch point (defined
with 'Fetch Method’ parameter). The number of models that will be fetched is
limited either by dataset or by the 'GPU Cache Size’' parameter.

Working with 3D Models

This section will give you a quick introduction on how to add a 3D model to your scene,
and also how to place the model on a map or satellite imagery.

Tip: Download models for testing from http://sketchup.google.com/3dwarehouse.

To add 3D models to a scene

1. Start Viz Artist
2. Add the 3D models plugin to an empty scene tree
3. Open the 3D models plugin editor and load a KMZ file

To add 3D models to a map
S
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1. Start Viz Artist
2. Add the Navigator to an empty scene tree
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Add the Atlas plugin to the GeoReferenceMap container

Open the Atlas editor and set it to use Mercator projection

Add a new group as a sub-container of the first container and name it position
Add the World Position plugin to the position group

Add a new group as a sub-container of the position group and name it model
Add the 3D models, Expert and NavFinder plugin to the model group

© NV BRW

Open the 3D models plugin editor and load a KMZ file (e.g. Tower Bridge in
London)

10. Click Go To Model
e This should bring the model into view

11. Open the Navigator editor, select Advanced, and then enable(On) the Pan &
Tilt Animation option

12. Open the 3D models plugin editor again and click Go To Model
13. Open the transformation editor for the model container

14. Open the NavFinder editor in order to adjust the distance, pan and tilt of the
map

Tip: Press Shift+CTRL while adjusting the Distance, and Shift while adjusting
the Pan and Tilt.

See Also

* Viz Artist documentation for information on the Expert plugin

12.7 3D Region
Setien

¥

2DRegion
The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The 3DRegion plugin is used for applying a graphic design to the selected regions in
the map. The designs are defined in the scene and linked in the CWMClient plugin, to
create the regions received from the maps server.

The plugin has the following four editor views:
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¢ General : Quality and performance parameters.
* Region : The object’'s graphic properties.

e Sub Regions : The object’s sub regions graphic properties. This tab is enabled when
the Sub Regions parameter, under the Advanced tab’s Data settings, is enabled
(On).

* Advanced : Defines plugin behavior in special operation scenarios.

12.7.1  General
3DRegion Plugin (14.0.0)

LOD mode

Polygon Quality

Geo Reference

o Rescale

* LOD mode: Sets the level of details (LOD). When set to auto, the plugin will
manage the level of details according to the camera distance from the region
object. When set to manual, the level of details will not change when the camera
moves, and will remain fixed. When set to Manual, the Polygon Quality parameter
will be enabled.

* Polygon Quality: Sets the quality of the generated region object. The Highest
setting will use more polygons to build the region object but will have an effect
on performance when many regions are selected. The Lowest setting will enable
better performance when adding a lot of regions, but will look poor when moving
the camera closer to the region objects.

* Geo Reference: When enabled (On), references the region object to the map
above 3DRegion container. If disabled (Off), the longitude and latitude numbers
will be transferred to the Viz Artist position X, Y values. The object can still be geo
referenced using for example the Locator Control or World Position plugins.

¢ Auto Rescale: Can be used when the region is not geographically referenced (on
screen normal) and you want all regions to be the same size (e.g. Israel uses the
same screen real estate as a map of America) in Viz units.

« Copy Map to Region: Will copy overlay the map texture on top of the region
geometry

* Center X Y: Defines where the axis of the region object will be placed: if Region
is selected then the axis center will be the middle of the region object. If Map is
selected the axis will be placed in the middle of the reference map.

* Sensible Culling: Defines whether to cut off areas that belong to the selected
region but are geographically remote. If set to Off, all marked regions will be built.
Use this feature to improve performance (usually set to On).

e Culling Threshold: Defines the level of details displayed in the regions. The
higher the threshold value, the less details will be drawn (that is small islands, small
regions, and so on).

* Use Cache: When enabled (On), saves the objects to a cache folder. When using
cache, the generated objects and parameters are saved in a cache folder and when
switching between parameters the regions are not rebuilt, but taken from the cache
(if they exist). If no (Off) cache is used, every change in the plugin interface will
trigger a rebuild of the region objects.
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12.7.2

Region

Fill

3DRegion Plugin (14.0.0)

Fill

Include Bottorn
Center Z

Type

Absolute Height

Show Terrain

K2

* Fill: Fill enables the user to add a region object to the map, and if fill is applied, how
regions are built on the map (either flat on the map (no width) or extruded).

* None: No region object will be added to the map.

¢ Extrude: Regions will be added and extruded over the map. When extrude is
used, additional parameters will be enabled.

* Flat: Adds a flat object (Extrude=0).
¢ Include Bottom: builds the bottom of the region when extruded.

¢ Center Z: Sets the Z axis location of the region object, with relation to the map:
bottom, center or top.

* Type: Defines how the Height parameter will be calculated.
* Absolute Height: Defines the regions extrusion height value as Viz units.

« Relative Height: Defines the regions extrusion height value as a percentage of
the regions size.

*« Show Terrain: Enables 3DRegion to take into account any terrain data for a
selected region. Adjust the Terrain Height Scale parameter (see next). For this to
work you need to enable the Fetch Terrain Data option in the CWMClient.

¢ Terrain Height Scale: Adjusts the terrain height.

Border

Borders

Line Width

Line Color 100.0 [

The border parameters define whether a border will be drawn around the region
objects, border color, width and the alpha. If the 3D Region object is in Controlled Mode
(On) the border properties parameters will be disabled.

* Borders: Defines whether the object will be drawn with a border. When enabled
(On), the border will be drawn and the border properties parameters will be
enabled.

¢ Line Width: Sets the number of GL lines for the border width.
¢ Line Color: Uses the color pallet to set the border color.

¢ Alpha: Sets the alpha value for the border. This value is controlled by the number
to the right of the Line Color selection.
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Note: The color palette is visible in all 3D Region editors but it will only affect the
border color.

Sub Regions

The Sub Regions tab has the same fields as the Regions tab, except that Sub Regions
does not have the Show Terrain and Terrain Height Scale fields. It also has the following
field:

* Sub Regions: Defines whether the object will use the sub regions data in the
drawn object. When enabled (On), the sub regions data will be reflected in the
geometry and the Sub Regions tab will display the sub regions parameters.

Advanced

Common parameters

* Freeze. This parameter enables the designer to freeze the region object to Viz data
folders (the region is saved as an image containing the region’s information).

* Wireframe: Draws a wireframe of the object.

Data

3DRegion Plugin (14.0.0)
General Region Sub Regions E
ESET ecion | Ahe | Brow

Controlled Mode

Render Mode

Freeze

The Data tab defines how data will be processed.

* Controlled Mode: Defines whether the 3D Region object will be controlled by a 3D
Region Control plugin in the hierarchy or not.

« Render Mode: Defines whether the 3D Region object will be rendered by Viz or
directly in OpenGL.

Election

All options work together with the 3D Region Control plugin.

Wireframe off

Print SubRegion Data Save SubRegion | Convert Names | Rebuild

¢ Command: Contains the text with region information used for elections.

* Selection Data: Since the region data can be shared between scenes, setting the
Selection Data to Local means you only influence the local scene whereas with
Global you influence all scenes.
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¢ |If Sub Regions is enabled (On), additional parameters will be enabled.
e Print SubRegion Data: Prints the data in the Viz console.
* Save Sub Regions Strings: Saves back the sub regions data to the file.

* Save Sub Region: Saves the current specific sub region information back to the
file.

¢ Convert Names: Option to convert the names in the plugin to a different set of
names.

* Rebuild: Rebuilds the region objects from the file.

Drraw

Region Alpha Mode

Border Alpha Mode  [NREgGion IEUEIREGEREN| " one
Create Alpha Channel w

Length

Extrude Length (F) 100 SR

Freeze

Wireframe

The Alpha tab is an advanced tab used mainly for elections. Alpha tab parameters
will be enabled when the Sub Regions parameter is enabled (On). The parameters will
affect the object only when an Alpha plugin is added to the object and the 3D Region
plugin is in Controlled Mode. These parameters define what part of the region data will
be affected by the alpha plugin.
¢ Draw: Defines what part of the object will be affected by the alpha settings.

« All: Both region and sub regions will be drawn in the object.

* Region: Draws only the region.

¢ Sub Region: Draws only the sub regions.

¢ None: Sets region and sub regions to be transparent.
*« Region Alpha Mode: Defines what part of the data will be affected by the alpha

plugin.

* Region: Affects only the region areas.

* Sub Regions: Affects only sub region areas.

* None: No data will be affected by the alpha plugin.

* Border Alpha Mode: Defines what part of the border data will be affected by the
alpha plugin.

* Region: Affects only the region borders.
* Sub Regions: Affects only sub region borders.
* None: No data will be affected by the alpha plugin.
¢ Create Alpha Channel: Automatically create an alpha channel animation
* Length: Length of alpha channel animation

* Extrude Length (F): Option to animate sub regions height (extrude). This
parameter sets the time for the animation.
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Draw

General

i_ Data

None

The Draw tab defines advanced parameters for drawing the region objects.

International Date Line: Relates to countries that reside on the 180 and -180
longitude line when using flat maps.

* None: Draws the regions on both sides of the map.

¢ United: Draws the regions together.

Border Data: Defines the source data of the borders.

* Polygon: Draws borders using polygon data.

* Border: Draws borders using border data (higher memory consumption).
Border Quality: Sets the required border quality.

Morphing: (Off, Start, End, Start & End)

e Start: Multiple start shapes can be used to create multiple region morphing
shapes. You must also design a separate region using End in order to define how
the shape should end.

e Start & End: Will allow setting two shapes (start and end), and the region will
morph between the two shapes.

Morphing Samples: Number of data samples between the start and end
animation.

Morphing Value (%): Used to animate between the first and last frame of the
shape.

Note: The color palette is visible in all 3D Region editors but it will only affect the
border color.

12.8
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3D Region Control

ionCTRL

SDR’-egionCo
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The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps-
Adv.

The 3D Region Control plugin is used to control one or more 3D Region objects and
changing and applying graphic properties to the objects.

Typical use of the 3D Region Control is when producing election graphics where it is
useful to distinguish regions by, for example, color.

Properties

3DRegionCentrol Plugin (14.0.0)

3DRegions Parent Container r‘

Control Mode

 3DRegions Parent Container: Container place holder for the container holding
the region objects.

¢ Control Mode: Defines the data segment of the object that will be controlled.
Select Region or Sub Region and then select what part of the region/sub-region to
control:

¢ Fill: Enables control of the region/subregion’s fill properties.
« Border: Enables control of the region/subregion’s border properties.

Fill

¢ Fill Mode: Defines the fill of the regions.

* Interpolate 3: Sets three colors that will define the regions color range. The
regions color will be derived from the range of colors and the number of regions.

* Interpolate 2: Sets two colors that will define the regions color range. The
regions color will be derived from the range of colors and the number of regions.

* Group: Controls the fill of all the 3DRegion objects under the defined 3DRegions
Container (apply the material added to the 3DRegionControl container).

* Highlighted: Controls the selected regions on the map only.

* Apply Sender Matrix: Applies a matrix to the regions. Available options are None,
Multiply, Translate, Scale and Full.

¢ None: Uses the 3D Region matrix.

¢ Multiply: Uses the 3D Region matrix multiplied by the 3D Region Control matrix.
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¢ Translate: Uses only the translated part (x, y and z position) of the 3D Region
Control matrix.

¢ Scale: Uses the scale part (x, y and z scaling) of the 3D Region Control matrix.
¢ Full: Uses the 3D Region Control matrix.
* Apply On: Applies the sent matrix on all regions or only the selected sub regions.
¢« Draw Group: When Fill Mode is set to Group, this defines the group to draw.

Border

Control Mode Sub Region
T oA s

Region Borders Highlighted

width ER

* Region/Sub Region Borders: Enables control of the region/sub region borders
properties.

e All: Controls all borders of the 3DRegion objects under the 3DRegion Container.

« Highlighted: Controls the borders of the 3DRegion objects that are the selected
regions in the map.

¢ Width: Defines the border width in pixels.

Note: The color palette is visible in all tabs but it will affect the last selected color
parameter in the Ul.

12.9
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3D Roads

e oy
ZDRoads

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The plugin has three different plugin editor views:

+ Data : Defines what type of roads will be drawn by the selected 3DRoads object.
Select one or more types of roads to be displayed, using the plugin graphic
properties.

e Width : Defines the width of the roads drawn by the plugin.
e Qutline : Defines the objects outline properties and behavior.

¢ Advanced : Defines extra settings on how to handle texture mapping and low angle
compensation when drawing streets.
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12.9.1 Data

3DRoads Plugin (14.0.0)

Main Roads
ndary Roads
Other Roads

Major Railways

:
5]

Other Railways

=

* Freeways/Motorways, Primary, Main, Secondary and Other Roads: When
enabled (On), the plugin will draw roads rated according to the selection in the
loaded roads data.

* Major and Other Railways: When enabled (On), the plugin will draw railways
rated according to the selection in the loaded railways data.

12.9.2 Width
¢  Width: Selects how the road width will be calculated.

3DRoads Plugin (14.0.0)

Width
Width

Fade Edge (%)

Height Offset
Line Offset

,ﬁ

* Fixed (Pixels): When set to Fixed the road will maintain a fixed width during
camera zoom movements. Available options are Width (pixels) and Fade Edge (%).

* Width (Pixels): Sets the width of the roads in number of pixels.
* Fade Edge (%): Sets the percentage of softness applied to the road edges.
* Height Offset: Offsets the borders from the map (on the fly).

¢ Scaling: When set to Scaling the road width will vary according to the camera zoom
movements. When selected, the following parameters are available:

« Width (Meters): Sets the physical road width (in Meters). This value is
translated into drawn pixels according to the camera zoom position and the size
of the map.

¢ Minimum Width (Pixels): Sets the minimal size that the roads will be drawn. If
the calculated road size in pixels is lower than the minimum width, the road will
not be drawn.

¢ Maximum Width (Pixels): Sets the maximal size that the roads will be drawn.
If the calculated road size in pixels is higher than the maximum width, the road
width will be set to the maximum width.

* Minimum Draw Width (Pixels): Sets the minimal size that the roads will be
drawn. When zooming into an area, this will be the point where the roads begin
to fade in and be drawn over the map.

* Fade Edge (%): Sets the percentage of softness applied to the road edges.

* See Me Now: Calculates (when width is set to scaling) the width needed for the
line to be visible at a given distance.
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Fixed (mm): When set to Fixed (mm) the road will maintain a fixed width during
camera zoom movements. Available options are Width (millimeters) and Fade Edge
(%). When selected, the Width (mm) and Fade Edge (%) parameters are available.

Outline

3DRoads Plugin (14.0.0) i
Outine [ Wone | Wasier | Save | PSERRREY

Outline Width (%) o =g

Outline Fade (%) O
Qutline Color W | 1000 EF

[+

Outline: Selects one of the options for adding outline to the roads. Available
options are None, Master, Slave and Stand Alone.

¢ None: No outline will be added to the roads drawn by the plugin.

* Master: Master mode is used to control other 3D Roads plugins which are in
slave mode. The same outline attributes will be applied to roads drawn by the
master plugin and by all its slave plugins. When selected, the available additional
parameters are Outline Width (%), Outline Fade (%) and Outline Color. Note: The
master setting ONLY controls other plugins, it does not draw any outlines itself. If
there are no slave plugins, then no outlines will be visible.

* Slave: Draws the outline according to the defined outline in the master plugin
above it in the scene hierarchy. All other parameters will be disabled, displaying
the master’s values.

¢ Stand Alone: Defines the outline parameters for the roads drawn by this 3D
Roads plugin only. When selected, available additional parameters are Outline
Width (%), Outline Fade (%) and Outline Color.

¢ Outline Width (%): Sets the width of the outline, as a percentage of the road

width, where 0% is the road width.

¢ Outline Fade (%): Sets the percentage of softness applied to the outline edges.

¢ Outline Color: Sets the color of the outline and the alpha value of the outline.

Note: The hierarchy structure is important when using the master/slave outline
configuration. The master plugin should always reside as the first container in
the group of 3D Roads containers. An Expert plugin should be added to the map
(above the 3D Roads containers) and Z-Buffer Draw should be set to OFF.

Note: Road data should be loaded (using the CWMClient plugin) before working
on roads design.

Copyright © 2016 Vizrt



Viz World Client and Server User’s Guide

12.9.4 Advanced
3DRoads Plugin (14.0.0)

Wireframe

Line Shader

Update Texture Mapping  [IDicabied | [AIWEVERNN|Stationary |

Low Angle Compensation ng

Debug m

Min Angle 55.0 ﬁﬁ

Max Angle 70.0 ;F

Outline Angle Offset 0 R

Width Factor ( Qoo [

Alpha Facto ”2:‘

F

¢ Line Shader: Line shader has 2 variants. The first is Simple with less options (and
better performance), while the second is more Advanced and allows for more
options (but at the cost of performance).

* Update Texture Mapping: Defines when to update the mapping of textures
applied in the container:

* Disabled: Will never update the mapping of the texture

¢ Always: Will update the mapping of the texture while animating

* Stationary: Will update the mapping of the texture only when the scene is
stationary or not an animation.

* Low Angle Compensation: Used when creating graphics that will have a low angle
point of view or tilt in order to remove aliasing on lines far away from the camera.

¢ Wireframe: Displays the roads as wireframe.

« Debug: Enables debug messages in the console.

¢ Min Angle: If the angle between the camera and the ground below the line is
lower than "Min Angle", then line width and transparency will not be changed.

¢ Max Angle: If the angle between the camera and the ground below the line is
higher than "Max Angle", then the line width is increased by the "Width Factor"
and the transparency is scaled by the "Alpha Factor". If the angle is between Min
Angle and Max Angle then the width and transparency are interpolated.

* Outline Angle Offset: For outline width, apply an offset to the angle
calculation in order to make the outlines affected at higher angles than the lines
themselves.

* Width Factor (%): A factor for modifying line width when applicable.
Percentage value for the width of the line far away from the camera. For example
400% thicker than when it is close to the camera

* Alpha Factor (%): A factor for modifying line alpha when applicable. Percentage
value for the alpha of the line far away from the camera.

12.10 Atlas

Copyright © 2016 Vizrt

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The Atlas plugin is used for displaying Microsoft satellite imagery. This object plugin is
used with a navigator plugin, enabling interactive navigation to any location on Earth.
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The plugin can be used to display imagery for a Navigator animation (Hops), while
creating the required image tiles for a smooth and complete camera movement. It can
also be used with the Globe plugin.

IMPORTANT! To ensure that image tiles appear correctly, use a base map with
the correct projection.

The plugin has the following plugin editor tabs;

* Data

* General

e Advanced

¢ Communication

¢ Buttons

Data

Atlas Plugin (14.0.0)

[BEE | General [T Advanced |
Data Source BRG] CMR || DG || Blom || WMS |[ Nokia | Map Server |

protocol SR New
bate Type S EE R SR EREE

[Warmup [ Clear Cache | Clear Memory Cache 7

The Data tab is used to define imagery parameters.

« Data Source: Sets the data provider. Available providers are:
* Microsoft Bing
* Vizrt's CMR (Curious Multi Resolution)
« DG (Digital Globe)
* Blom

« WMS (Web Map Service) geo server
oki

* Map Server

.
=2
Q

Note: Bing, Blom, DG and WMS require an internet connection. Bing and Blom
will not work without a license, DG will, but will show a watermark.

Bing

* Protocol:
If Legacy is selected, the APl used in previous versions of VizWorld will be used.

You can use the Data Type parameter to choose between satellite imagery, road
and border maps with labels or a combination of the two. If you combine the two
road and border maps with labels they will be imposed over the satellite imagery.
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* Satellite: Will display ONLY satellite imagery.

e Map: Displays the map using the hybrid styling and will also display labels

“r

Araten 1 s

CHINA

« Traffic: Draws a traffic layer

If New is selected, a new API is used, which gives you more control over what to
display in the map. It will allow you select whether or not to include labels in the
map, and what language to use for those labels. The following parameters are
available:

¢ Map: Display Satellite imagery, or display the Map using the hybrid styling.
* Labels: Turns the labels in the Map on/off.
¢ Culture: Allows you to select the language of the labels

¢ Vector: Determines whether or not the map will include vector data (streets/
borders) with the satellite imagery.

« Hills: Determines whether or not the synthetic map will include hills topography.
CMR

* CMR File: Sets the path to the CMR file.
« CMR Data Status: Indicates whether or not the file was loaded correctly.

DG

* Projection: Defines the projection of the map, either Unprojected or Mercator.
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+ Digital Globe Profile: Enables you to select from the most common profiles of
Digital Globe maps (Note that imagery from different profiles may differ in some
places and be the same in others).

In addition, the following parameters can be configured in the VizWorld.ini
configuration file (by default located at C: \ProgramData\vizrt\viz3\Maps):
¢ DigitalGlobePrefix

* FirstLookPrefix

If these parameters are used (i.e. present and not commented with hash) then Atlas
will use these strings as the basic connection string. The license key, projection, tile
coordinates and additional parameters like profile or header will be added in Atlas
itself.

Blom

+ Data Type: Sets how the map will be displayed. For more information, see the
description of the Data Type parameter in the Bing tab.

WMS

* Projection: Defines the projection of the map, either Unprojected or Mercator.
¢ Url: Sets the Url of the WMS geo server.

¢ Layer: Comma-separated list of one or more map layers. Values in list correspond
to the layer <Name> values by the geo server’s Capabilities file. Layer list is
optional if the Styled Layer Descriptor (SLD) parameter is present in the request.

* Free text: Used to set optional parameters like transparency and background
color (e.g. TRANSPARENT=TRUE §BGCOLOR=#E98300&). For more information on
how to set optional parameters in the free text field, see the WMS specification
documentation.

¢ Version: Request version. Valid values are 1.0.0, 1.1.0, or 1.1.1.

Nokia

+ Data Type: Sets how the map will be displayed. For more information, see the
description of the Data Type parameter in the Bing tab.

Map Server
This will allow the use of the TPLs and stylesheets in an available map server.

* Server Configuration:

» Default: Will use the default server configured in the engine (See Viz Engine
Configuration).

e Manual: Will allow you to use a different server than what is configured in the Viz
Engine.

* Projects: Will list all TPLs that are available in the map server
¢ Project: Will display the selected TPL
* Pick Style: Numerical index of the available style sheets in the selected TPL

« Layer: Name of the selected Style sheet
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Note: In the Viz Artist interface, a maximum of 256 TPLs can be displayed.

12.10.2 General

Atlas Plugin (14.0.0)

1000.0 ,':F

FadeTime 15 ,':F

Warmup | Clear Cache | Clear Memory Cache _'T'

* Use Base Map: This option is used when working with a base map above the
Atlas container, and the base map is projected. Note that Microsoft Bing imagery is
unprojected, so in order to have the images positioned correctly over the map set
this parameter to On. The same applies if you use the Globe plugin.

¢ Map Size: Defines the size of the Atlas image.

« Fade Time: Defines the duration of the transition between tile resolutions when
zooming in/out of the image.

12.10.3 Advanced

Atlas Plugin (15.1.0)
[ neral [ Bdvanced | Communication
Temp Folder
Mode

sts per Frame

[P REREN| OxT1(Opaaue) || Gbsolete | OXTS(Alpha)

Mipma|
[ tow  p—— g

Warmup || Clear Cache || Clear Memory Cache || 7|

The Advanced tab is used for configuring connection and operation parameters.

« Temp Folder: Defines a specific cache folder for the retrieved imagery.

* Mode: Defines the mode of retrieving the tiles from Microsoft Bing server. When set
to Serial, and new image tiles are required, Atlas plugin will send a request to the
server and wait for a reply. Only after the reply another tile will be requested, and
so on. During the time that the plugin as waiting for a replay the Ul is locked the
user cannot perform other operations. When set to Multithreaded, the images are
requested by a thread of the plugin and the Ul is not locked.

* Requests per Frame: Defines the maximal image requests from the serverin a
frame.

* Layers: Defines the number of images (with different resolution) per one area.

¢ Texture Compression: Select one of the required compression modes for the
images.
¢ Texture Quality:
* Linear: Performs a linear interpolation to smooth the texture when being
magnified or shrunk. The texture looks good, but some distortions can be visible

when the textured object is animated further away on the Z axis. As the object
then gets smaller and smaller, the shrinking and interpolation of the texture
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creates a lot of "noise" on the texture. As a consequence, the linear quality is
appropriate when the objects that have the texture do not change their size
much.

* Mipmap: Performs a linear interpolation to smooth the texture. In addition, it
offers a solution to the problem that appears on the two other qualities when the
object is being moved away along the Z axis or shrunk. To avoid the "noise" that
we see when a texture constantly scales to try to fit.

* Quality: Defines the quality of the images requested from the server.

« Memory Buffer Size: Option to control memory buffer used by Atlas. Useful for
scenes with multiple Atlas plugins.

* Layer Type: Selecting a transparent layer type you will be able to maintain
transparency while stacking multiple layers on top of each other. Selecting opaque
you will consequently block anything below it. WMS layers tend to be transparent
(e.q. power lines or flood area). This parameter is only visible when the Data Source
is set to WMS.

e Stop Support Margins: When set to ON, additional image tiles surrounding the
displayed area will be retrieved, to enable immediate display of high resolution
images when the user moves the image.

¢ Limit Disk Read Time (ms): This parameter specifies the maximum time period
for the plugin to be occupied with loading. If while loading the tiles for the current
frame, the plugin recognizes that loading is taking too much time, it will stop
loading and render the frame.

* Use Hysteresis: This option resolves the 'flickering problem’ that may occur if the
Navigator position moves back and forth around a point where the plugin decides
to change resolution levels. Hysteresis uses history data in the calculation of a point
where the level should be changed, such that the switch for zoom in and zoom out
will not happen in the same point, thus avoiding the flickering. If enabled, set the
Hysteresis size.

* Set Proxy (button): Applies the proxy settings.

* Tessellation: Only visible when Atlas is used under basemap. The Tessellation
parameter is used to increase tessellation of each tile in the Atlas plugin. This may
be useful when projection of the basemap differs from the projection of Atlas data
source (and one of the projections is not linear). By using tessellation, the tile fits
more accurately to the basemap (less distortion). Raising this parameter affects
performance, so only use when distortion due to a difference of projections is visible
and unacceptable.

12.10.4 Communication

Atlas Plugin (15.1.0)

Data | General Advanced Communication

¢ Use Proxy: When set to ON, proxy configuration parameters will be enabled. Use
this option when working an a network with proxy:

¢ IP: Proxy server IP number
e Port: Proxy port number
* Username/Password: Sets the username and password.
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* Bind to IP Address: When set, this forces the plugin to use the IP address of a
specific network card in the computer (used when multiple network cards are part of
the computer). When not set, it defaults to the first network connection.

12.10.5 Buttons
« Warm up: Prepares all image tiles for a defined animation. Once tiles are in the
cache folder, the animation will play smoothly.
* Clear Cache: Will clear and delete all imagery in the cache folder defined under the
folder Advanced/Temp.
¢ Clear Memory Cache: Will clear the Viz memory and reload the images.
12.11 C3D Terrain
==
.. ©
C30Temrain
The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.
The C3DTerrain plugin is used for displaying terrain objects. The terrain is retrieved
from the Viz World Server (WoS) when a CWMClient plugin is added to a C3DTerrain
object. When the CWMClient plugin is added to the C3DTerrain plugin, terrain
tessellation parameters will be enabled in the Miscellaneous tab of the CWMClient
plugin.
The plugin has three views:
* Terrain
e Pyramid
* Advanced
e Buttons
12.11.1 Terrain

C3DTerrain Plugin (14.0.0)

T

¢ Terrain Mode: Defines the data source for the terrain height:
* File: Load height from terrain file (*.c3d).
* Image: Use a Viz image to create the terrain data.

¢ Memory: Terrain data may be accessible from three different sources: from a
terrain file on disk (file), from server by using the CWMClient (memory) or from
server using the CWMClient but then saved to the Viz Graphic Hub as an image
(Image).

¢ Terrain File Name: Defines a path to the file to be loaded.
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Note: The Terrain File Name parameter will be disabled when a CWMClient
plugin is attached to the Atlas container.

* Height Scale Mode: Sets the height scaling option for the terrain:

Manual: Sets the height scale manually by changing the Height Scale
parameter. When selected, additional parameters will be enabled:

Soft: Sets the terrain surface to be softened by interpolating points over the
terrain. This option prevents the sharp edges over the terrain surface.

Normal: Uses the same terrain elevation values received from the server.

Exaggerate: Applies a large scaling factor to the terrain height differences,
exaggerating the terrain surface.

Tiling: The terrain height will not take into account the map size. Setting Height
Scale Mode to Absolute may therefore be needed for the terrain tiling, or else the
tiles might not connect properly (due to height differences).

¢ Globe: When enabled (On), the terrain will be drawn as part of a globe and the
Globe Radius parameter will be enabled.

* Globe Radius: Sets the size of the globe used for drawing the terrain.

Note: The Globe and the Globe Radius parameters will be disabled if Use Base
Map is enabled (On).

¢ Height Scale: Sets the scaling value for the terrain elevation. Using a low value will
flatten the terrain surface.

¢ Delta Z: Sets the Z axis offset for the terrain (mainly used when using the base
map).

Pyramid

Pyramid

C3DTerrain Plugin (14.0.0)

Pyramid Steps
Growth Factor

Pyramid Terrain Factor

Blend textu

External Blend Amount

Terrain Status

e

reeze enarn

A Pyramid is a set of map textures in different resolutions, used for zooming into a
defined area. When the camera is far from the map, a low resolution map texture is
used (covering a wide area). As the camera zooms into the map, it will zoom into an
area with higher resolution texture, until the final map, with the highest resolution,
is used. In order to enable the Atlas 's Pyramid parameters a CWMClient plugin must
be attached to its container. Note that this will disable Atlas 's Terrain File Name
parameter. See the Terrain editor view.
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Pyramid: This parameter defines whether a pyramid of map textures will be
created for the terrain area. When enabled (On) the Max Height and 3D Levels
parameters will be enabled.

*« Max Height: Defines the number of textures that will be created.
¢ 3D Levels: Defines the number of terrain objects that will be created.

Blend Textures: Defines whether the edges of the maps will be soft, blending into
the larger map of the pyramid. When enabled (On), the edges will be softened and
the Blend Amount parameter will be enabled.

* Blend Amount: Defines the amount of softness added to the map edges.
Rebuild Pyramid: Builds the pyramid levels.

Note: The parameter Rebuild Pyramid is enabled only if Pyramid is enabled
(On) and it will be visible in all tabs.

12.11.3 Advanced

C3DTerrain Plugin (14.0.0)

. e
[ Terrain | Pyramid | WARvEREEa]
Terrain File Name f-_|

Sampling Resolution

Terrain Status

Rebuild Freeze Terrain
=

Sampling Resolution: Defines the number of points that will be used to calculate
the terrain. The higher the sampling resolution, the less detail will be shown. When
Pyramid mode is enabled (On), this parameter will be disabled

Use Base Map: Defines the geographical referencing of the terrain. If Use Base
Map is enabled (On), the terrain will move to its geographic location on the base
map, and the Base Container parameter will be enabled.

* Base Container: If empty and Use Base Map is enabled (On), the first map
above the C3Dterrain container in the hierarchy will be used as the base map. To
use a specific map as the base map, drag a map container to the Base Container
place holder. If Use Base Map is disabled (Off), the Globe parameter will be
enabled and the terrain will be drawn as part of a globe. Set the Globe Radius to
modify the terrain size and curve.

*  Wireframe: Displays the terrain as wireframe.

* Sides Smoothing: When enabled (On), the edges of the terrain will be drawn as

flat lines (height is zero). This option is useful when using the terrain object over the
base map. When enabled (On), additional parameters are enabled:
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+ Sides Smoothing Factor: Defines the width of the area, close to the edges,
that will be interpolated to create the smooth transition from terrain info to a flat
edge.

* Uniform Smoothing: Applies smoothing for all sides. Enabling Uniform
smoothing (On), will set smoothing for all sides, and hide the individual
parameters. Available individual parameters are; Left, Right, Top and Bottom
smoothing.

* Texture Compression: Sets the compression level for the texture (DTX5 is the
highest compression level; hence, less texture quality).

e Terrain Status: Displays the terrain object status. If the terrain object was rebuilt
successfully, the indicator will display OK, otherwise, the indicator will display Not
Built.

12.11.4 Buttons

¢ Rebuild: Will force a rebuild of the geometry, which is necessary when changing
parameters that cannot be updated in real time.

* Freeze Terrain: Saves the terrain image and data as Viz images for faster loading
and for archiving.

12.12 Flat MR
FlatMR
w i i
[ Flatvr |
The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps-
Obs.
The FlatMR plugin is used for displaying CMR (Curious Multi Resolution) files over a flat
object. The texture for the terrain is defined in the file or retrieved from the Microsoft
Bing Maps Platform (when licensed).
IMPORTANT! This plugin is included in World Map Editor package for
compatibility reasons, and is not maintained. It is recommended to use the Atlas
and other plugins for designing new scenes.
12.13 GeoChart
GeoChart
= -]
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The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps-
Adv.

The GeoChart plugin shows geo-located values by representing them as 3D bars on a
map. The data format can be a grid of geo positions (locations with constant distances
from one another) or a list of coordinates. In addition, data may be split by timeframes
and the plugin is able to animate the data chart throughout the frames.

In order to use GeoChart, it should be put beneath the geo reference and load data
(see Supported Formats ). GeoChart will add the GeoChartShader to the container
automatically.

This section contains information on the following topics:

e General

» Color

* Advanced

* Supported Formats

¢ Creating Mask Images
¢ Examples

12.13.1 General

Load Data
Animation Mode

|:_|

¢ Load Data: Used to select the data file to be loaded.

¢« Frame Number: When data comes in frames (see Supported Formats ) this control
appears and the desired timeframe can be chosen.

Please note that although it is possible to animate data through the Frame Number
parameter it is not recommended because when the frame is switched the data
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is read from the hard disk such that such an animation will be more performance
consuming. Moreover there will be no interpolation between frames such that the
animation will ‘jump’ from timeframe to timeframe. Use Animation Timeline instead.

¢ Animation Mode: Can be enabled if the data has timeframes. In this mode the

whole frame sequence is analyzed and an animation is built. The data will be
interpolated smoothly between the frames such that the animation will look smooth.

¢« Animation Timeline: When an animation is built, the data can be animated

through timeframes using this parameter.

+« Animation Buffer Size: Defines the size of the memory buffer in which the

created animation is stored. If the buffer size is less than that required to build the
animation from all the available frames, then not all of the frames will be included
(You can check the total available frames by dragging the Frame Number parameter
to the right and seeing the largest frame shown, and the frames included in the
animation by dragging the Animation Timeline parameters to the far right).

« Bar Type: Defines the geometry of the bar. Please note that Cylinder geometry is

the most performance consuming while Prism is the lightest.

« Bevel Bars: Bevels bars edges.

* Bar Height: Scales the height of the bars
* Bar Width: Scales the width of the bars
e Bar Length: Alters bar’s length starting from the bottom.

¢« Mask Source: Data may be clipped to a specific region such that only bars inside

the region will be seen. For this purpose a mask image is required. You can drag the
image into the 'Mask’ rectangle in the 'Image’ option or specify a container with a
mask image in the 'Container’ option. See Creating Mask Images .

* Rebuild : Only three parameters of the GeoChart plugin can be changed 'on the

fly’ - Bar Height, Bar Width and Bar Length. Altering other parameters will require a
Rebuild.

Color

GeoChart Flugin

Logarithmic Color

Set Input Range

N

3

pomE
Al
=

1aaiN =

|

=

Input Minimum 0.0
Input Maximum

Colors 3

100.0

Color Image

Color Levels

[Rebuiid|

Logarithmic Color: This option applies logarithmic scale to a color transform. This
may be used when the data has dramatic differences between low and high values
(in such cases the high values will be red by default and all the low values will be
blue). Logarithmic scale makes this difference less dramatic, such that more in-
between colors will appear on lower values.
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12.13.3

An example of such data may be world population density. In large cities this value
will be considerably higher than in it’s surroundings, making it difficult to see less
dramatic differences in low population areas.

Set Input Range: Constrains input range to a specified Input Minimum and
Input Maximum value. All values below the minimum will be interpreted as lowest
possible bar height (zero by default) and all values higher than the maximum will be
interpreted as a maximum bar height. Note that when ’'Set Input Range’ is pressed
the actual minimum and maximum data values from the loaded data are seen.

Colors: The color map is defined by choosing colors and a number of in-between
color ramp stages.

Color Image: Alternatively to using ‘Colors’, you can use an image to define the

color map. The image must be dragged to this control. An example of an image
defining color map:

calormapl

Posterization: Enables a continuous color map to be split into a desired number of
discreet colors.

Advanced

GeoChart Plugin

Resolution Level
Invert Output
Cutput Minimum
Output Maximum
Use Input Range
Input Minimum
Input Maximum
Clip Data

Clip Bottom

Clip Top

[‘Rebuiid |

Bar Response: Defines which property of the bar will be effected by the value it
represents.

Logarithmic Data: Puts the values that the bars represent on the logarithmic
scale. This gives a better indication of differences between low values, and makes
the difference between low and high values less dramatic. May be useful in

cases where there is a large difference between low and high values. (e.g. world
population density). Consider using this option in combination with the 'Logarithmic
Color’ option under the Color tab.

Data Simplification: The data file that is being loaded to a plugin may contain a
huge amount of data and can become very performance intensive during rendering.
For that reason you may want to resample the data and create different resolution
levels to show lower resolution from farther distance. Moreover, data is spit into
tiles by a culling mechanism. This parameter defines how may resolution levels

will be created out of the original data, and therefore effects loading time and the
animation built process.

Fix To Resolution Level: In some cases you would not like the data to be
resampled, since this means a loss of some information. In such a case you can
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choose the option to use only one, fixed resolution level, which you choose by using
the Resolution Level parameter. A zero value means that raw data is used. Raw
data is not resampled and not split to tiles.

¢ Invert Output: Maximum values get the lowest bar heights and vice versa.

¢ Output Minimum: Defines the height of the bar representing the minimum found
value.

¢ Output Maximum: Defines the height of the bar representing the maximum found
value.

* Use Input Range: Defines the input range such that values lower than Input
Minimum will be considered as having the Input Minimum value, and values higher
than Input Maximum will be considered as having the Input Maximum value. This
may be useful when focusing on a specific range in values.

« Clip Data: Enables clipping the bars representing values lower or higher than
defined in the Clip Bottom and Clip Top parameters. Note that when this button
is switched to 'On’ the Clip Bottom and Clip Top controls appear with values
corresponding to the actual minimum and maximum found values in the data.

Note that, unlike using input range, the clipped bars are not seen at all rather than
just representing minimum and maximum values defined in clipping.

Supported Formats
The following formats are supported:
e ASC File

¢ Viz Weather data format
* TAB File

ASC File

In the *.asc format, the ascii file represents a 'grid’ of values in defined geographic
range, defining the number of rows and columns of such data.

For example, the following shows a part of a file showing a grid of world values:

ncols 360

nrows 180

xllcorner -180.0
yllcorner -90.0

cellsize 1.000000000000

NODATA value =-9999
-9999 -9999 -9999 0.1252774 0.1192886 ...

Viz Weather data format

The data is contained in one *.ini file and a corresponding list of binary files
representing each timeframe. This data format enables the creation of an animation
through timeframes.

The ".ini’ file defines 'what to expect’ from the binaries, including the region, projection
and resolution (distance between samples of a grid data).

The binaries are a list of values corresponding to one timeframe in float precision.

Example of *.ini file:
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12.13.5

[Grid]

ModelType=GFS
ModelName=GFS
DataName=Temperature
DataType=TEMPERATURE
FileType=BINARY
FromTime=201204102100
ToTime=201204132100
TimeStep=180
Region=-180.000000/180.000000/-90.000000/90.000000
Resolution=1
Compression=UNCOMPRESSED
[Projection]
Type=UNPROJECTED

[Files]

FileO=grid 0.Db
Filel=grid 1.b
File2=grid 2.Db

[Times]

Time0=201204102100
Timel=201204110000
Time2=201204110300
[Mins,Maxs]
Vals0=-64.059998,37.739994
Valsl=-63.859997,35.239994
Vals2=-64.260010,36.139988

TAB File

The *.tab format is used for non-grid type data. It contains a list of data samples
defining the date, hour, coordinate and value of each. The first time such data is read

it is processed such that all the samples corresponding to the same hour will represent
one timeframe, and the processed data will be saved as a cache (in the same folder
where the *.tab file is located) containing a *.bin header file and numerous *.dat files
each corresponding to one frame. (The filenames of *.dat files define the date and hour
they represent).

For example:

2013-06-29 00 -90.087890625 179.912109375 112
2013-06-29 00 -41.30859375 174.7265625 1
2013-06-29 01 -40.95703125 174.814453125 1
2013-06-29 01 -39.0234375 -68.115234375 2
2013-06-29 01 -38.759765625 -72.685546875 1
2013-06-29 02 -38.49609375 -63.6328125 1
2013-06-29 02 -38.232421875 144.31640625 7
2013-06-29 02 -37.96875 145.107421875 1
2013-06-29 02 -37.880859375 144.931640625 32

Creating Mask Images
A mask image is created with the help of the CWMClient plugin.

The image should correspond exactly to a georeference on which GeoChart is placed,
so the basemap region must be defined in the CWM plugin. In the case when Atlas is
used as georeference, put it beneath the CWM so that it corresponds exactly.
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Go to the CWM plugin defining the georeference and change the Texture
Compression parameter to 'None’. You can find it under the "Texture tab’.

Open Viz World Map Editor and select the desired region.
Put the Map Layers Control plugin on a container with CWM (the georeference).

In the Map Layers Control plugin, switch Control to Enable and deselect all of the
options except the 'Selected Regions’, and press 'Refresh Map’.

Go to CWM Client’s Miscellaneous tab and press 'Freeze’.

Drag the resulting image from the container to the image pool. You can now

use it as a mask for the selected region. You can unfreeze the CWM, remove
MapLayersControl and change back the texture compression, but be careful not to
change the size and range of the georeference map.

Examples

Weather precipitation data

Weather precipitation data clipped to a region
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Weather precipitation data on the globe

World temperature values

12.14 Geolmage
T

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The Geolmage plugin is used as a base object with maps to enable geographic
referencing options. Geolmage is short for Geographical reference Image.

The plugin has three views:

e Basic

e Pyramid
e Advanced

12.14.1 Basic

Geolmage Flugin (14.0.0) l_

e Ryerid | Advenced

Delta Z

Map Status

Apply Fade Plugin
7
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Use Base Map: Defines the geographical referencing of the Geolmage. If Use Base
Map is enabled (On), the Geolmage will move to its geographic location on the base

map and resize accordingly.
* Map Size: If Use Base Map is Off, this sets the size of the Geolmage geometry.

* Tesselation: This value changes the number of triangles of the rendered filecard to
increase the visual quality.

Note: The number of triangles will affect the performance of the system.

« Base Container: If empty, the first geo-referenced map above the Geolmage
container in the hierarchy will be used as the base map. To use a specific map as
the base map, drag a map container to the Base Container place holder.

* Delta Z: Sets a Z offset for the Geolmage geometry.

* Map Status: Will display the status of the imagery and whether or not the imagery
contains geo-referencing.

* Apply Fade Plugin: When clicked, a Fade Texture plugin will be applied to the
container.

Pyramid

Geolmage Plugin (14.0.0)

e YRR Advered
Pyramid Wﬂ
Map Style rce WE
Satellite Threshold (Deg) | 08 3
Max Pyramid Height 3
Pyramid Factor

Pyramid Steps

Apply Fade

Fade Range

Pyramid: When to set to None or Local this uses the local parameters. When set to
Global, it uses the parameters as defined in the Hops Manager.

Map Style: Defines the map style to be used for the pyramid maps:

¢ Source: Uses the top CWMClient container ( Map Tiler ) style selection when
creating the pyramid maps.

¢ Target: Uses the hop CWMClient style selection when creating the pyramid
maps.

¢ Split: Splits the pyramid layers style, based on image latitude and longitude
size. If the image size is smaller then the threshold the target style will be used,
if larger then the source style will be used. Additionally, it is possible to turn on
the color correction option in Pyramid Control which will color correct the target
image to match the source images. Set the Satellite Threshold (deg).

Max Pyramid Height: Defines the maximal number of maps that will be created in
the pyramid. The optimal number of pyramid maps is calculated by the MapPyramid
plugin. If the optimal number exceeds the Max Pyramid Height value, then the
plugin will generate the maximal number defined.

Pyramid Factor: Calculates the number of maps required defining the size factor
between the maps of the pyramid.
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*« Pyramid Steps: Defines how the map coverage area grows from pyramid to
pyramid:

¢ Equal: The size factor will be based on map pyramid height, pyramid factor and
the resolution difference between the base map and the final map. The actual
number might be different than the pyramid factor. The number of levels might
also be smaller than the max pyramid height

¢ Constant: The value of the pyramid factor will be used as is, with the value of
max pyramid height.

¢ Create Hole: Will create a hole on each pyramid tile

* Image Aspect: (Power of 2). Will calculate the closest power of 2 size, based on the
selected image size of the CWMClient Plugin texture size. Target will use exactly the
same size as the CWMClient Plugin texture size.

Note: It is recommended to use this setting to improve performance.

* Apply Fade: Defines whether the maps used in the pyramid will use soft edges.
Available options are Off, Target and Pyramid.

* Off: No soft edges will be used. The transition between the maps will be visible
(the maps will have sharp edges).

* Target: Sets the last map (target) to have soft edges only.
* Pyramid: Sets all maps in the pyramid to have soft edges.

 Fade Range: When Apply Fade parameter is used, the Fade Range is used to set
the fade level (the area of the image that the fade will be applied to).

* Texture Compression: Select one of the required compression modes for the
images.

* Hide Lower Resolution: Defines whether the map created by the CWMClient
plugin, located on the MapPyramid container, will be turned off when the texture
resolution of that map is lower than the Globe or Geolmage map tiles resolution. If
it is enabled (On), the maps with lower resolution will be turned off automatically by
the MapPyramid plugin. If it is disabled (Off), the MapPyramid will not turn off the
low resolution maps.

* Map Status: Status of the map

12.14.3 Advanced

When the Use Base Map option on the Basic tab is turned on, the Advanced tab will
display parameters for cropping the imagery applied on this container.

Geolmage Plugin (14.0.0)

* Crop Mode: Defines whether the Geolmage will be cropped:
¢ None: The map will not be cropped.

¢ Manual: Allows the user to manually set the crop values for the map: West
and East sets the Longitude value for the western and eastern edge of the
Geolmage map. North and South and sets the Latitude value for the northern
and southern edge of the Geolmage map.
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« Base Map: Crops the Geolmage according to the base map, that is, if the
Geolmage exceeds the base map edges, it will be cropped accordingly.

12.15

Globe

By

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The Globe plugin is used as a base object, with maps, to enable geographic referencing
options over a globe. The globe object will geographically reference the map at the
correct location over the globe.

The plugin has three views:

e Basic

¢ Pyramid
e Advanced

e Buttons

12.15.1 Basic

Page 168

Globe Plugin (14.0.0) i
I e RavaReed
Tesselation 5 FF

Radius

Map Status

+ Tessellation: Defines the number of polygons used to create the Globe geometry.
¢ Radius: Defines the radius of the globe.

¢ Map Status: Reports if the map was loaded as expected (Ok), geographic
referencing of the map, and so on.

Copyright © 2016 Vizrt



Viz World Client and Server User’s Guide

12.15.2 Pyramid

Globe FPlugin (14.0.0)

Max Pyramid Height
Pyramid Factor

Map Status
Ea
[ Build Pyramid

* Pyramid: When to set to None or Local this uses the local parameters. When set to
Global, it uses the parameters as defined in the Hops Manager.

* Map Style: Defines the map style to be used for the pyramid maps:

¢ Source: Uses the top CWMClient container ( Map Tiler ) style selection when
creating the pyramid maps.

e Target: Uses the hop CWMClient style selection when creating the pyramid
maps.

e Split: Splits the pyramid layers style, based on image latitude and longitude
size. If the image size is smaller then the threshold the target style will be used,
if larger then the source style will be used. Additionally, it is possible to turn on
the color correction option in Pyramid Control which will color correct the target
image to match the source images. Set the Satellite Threshold (deg).

¢ Max Pyramid Height: Defines the maximal number of maps that will be created in
the pyramid. The optimal number of pyramid maps is calculated by the MapPyramid
plugin. If the optimal number exceeds the Max Pyramid Height value, then the
plugin will generate the maximal number defined.

* Pyramid Factor: Calculates the number of maps required defining the size factor
between the maps of the pyramid.

*« Pyramid Steps: Defines how the map coverage area grows from pyramid to
pyramid:

¢ Equal: The size factor will be based on map pyramid height, pyramid factor and
the resolution difference between the base map and the final map. The actual
number might be different than the pyramid factor. The number of levels might
also be smaller than the max pyramid height

¢ Constant: The value of the pyramid factor will be used as is, with the value of
max pyramid height.

* Create Hole: Will create a hole on each pyramid tile

* Image Aspect: (Power of 2). Will calculate the closest power of 2 size, based on the
selected image size of the CWMClient Plugin texture size. Target will use exactly the
same size as the CWMClient Plugin texture size.

Note: It is recommended to use this setting to improve performance.

* Apply Fade: Defines whether the maps used in the pyramid will use soft edges.
Available options are Off, Target and Pyramid.
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¢ Off: No soft edges will be used. The transition between the maps will be visible
(the maps will have sharp edges).

¢ Target: Sets the last map (target) to have soft edges only.
¢ Pyramid: Sets all maps in the pyramid to have soft edges.

« Fade Range: When Apply Fade parameter is used, the Fade Range is used to set
the fade level (the area of the image that the fade will be applied to).

¢ Texture Compression: Select one of the required compression modes for the
images.

* Hide Lower Resolution: Defines whether the map created by the CWMClient
plugin, located on the MapPyramid container, will be turned off when the texture
resolution of that map is lower than the Globe or Geolmage map tiles resolution. If
it is enabled (On), the maps with lower resolution will be turned off automatically by
the MapPyramid plugin. If it is disabled (Off), the MapPyramid will not turn off the
low resolution maps.

¢ Map Status: Status of the map.

Advanced

Globe Plugin (14.0.0)

T byemd I REvEReE
~ Relative Geo Refer__
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» Tesselation 1

Texture Mapping
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-90.0
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Bl el

Hole South (From lat)
Hole North (To lat)

Avoid Radius Cheat

Map Status
[l
[ Build Byramid |

* Sub Tessellation: This parameter divides each of the Globe flat areas, to increase
texture coordinates and improve the way the textures look on a globe.

¢ Texture Mapping: This parameter defines how the texture (map) will be mapped
over the Globe:

¢ Absolute: the globe object will be cropped according to the values set in the
West, East, South and North parameters.

« Relative: the globe object will be cropped according to the geographical
properties of the map applied to the Globe.

* GeoRef: The map will be mapped over the globe object according to its
geographical properties.
* West/East: Sets the Longitude value for the western/eastern edge of the Globe.
The globe object will be cropped at that Longitude.

* South/North: Sets the Latitude value for the southern/northern edge of the Globe.
The globe object will be cropped at that Latitude.

* Enable Hole: Saves performance when building pyramids using globe objects.
When the globe objects for the pyramid layers are created, a hole is created where
the higher resolution maps are, to avoid rendering multiple pixel layers (and to save
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performance). It can be used manually to create a hole in a globe object by setting
values which are in the area of the map in use. When enabled (On) additional
parameters will be enabled:

¢ Hole West (From lon): Defines an inner Longitude in the map area where the
hole will begin (West side).

¢ Hole East (To lon): Defines an inner Longitude in the map area where the hole
will begin (East side).

¢ Hole South (From lat): Defines an inner Latitude in the map area where the
hole will begin (South side).

* Hole North (To lat): Defines an inner Latitude in the map area where the hole
will begin (North side).

* Avoid Radius Cheat: The plugin contains a Radius setting that can be avoided if
required.

12.15.4 Buttons
¢ Build Pyramid: Rebuild the pyramids

If Pyramid is set to None in the Pyramid tab, then the available buttons are:

* Apply Fade Plugin: When clicked, a Fade Texture plugin will be applied to the
container.

* Face Z Axis: When clicked, the globe object will rotate and centre facing the Z-axis.
This button can be used when not a full globe is rendered (for example only Asia).
Do not use this feature with the Navigator plugin as it assumes no rotation.

12.16 Label and Go

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The purpose of Label and Go is to draw many labels on screen. Its main area of use is
interactive scenes, but it can of course be used for regular scene design as well.

Traditionally, label drawing has been done by copying a design multiple times. This
method gives you full control over the label’s look, but limits the number of labels
which can be used as every label is at least 2 containers. Also, if the number of labels
exceed 500 containers it may become a performance issue.

Label and Go gives less options for design, but since all design is done for one
container performance is still good using 70000 labels.

Notes

¢ All data sources may select from 10 different designs.

e There are currently no limits as to how many Label and Go plugins can be used by
one scene.
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¢ Label collision is calculated and taken into account. Other types of labels (e.g.
design using the Street Labels plugin) are not taken into account.

¢ Label and Go currently works on flat maps only.

The options are divided into three tabs, Global, Design and Communication, and this
section contains information on the following topics:

e Properties - Global

e VizBoldProperties - Design

e VizBoldProperties - Communication
¢ Working with Label and Go

12.16.1 Properties - Global

La Plugin

Global | Design | Communication

Auto Labels i_r_‘WM Labels [ Streets i— Other .|_L|:n:E| File_| Shields

On Map | Overlay

E¥

100.0

100.0 F"P

» Data source: Defines the type of source the plugin should render. Label and Go
supports the following data sources:

e Auto labels: Labels of the entire world.
¢ CWM labels: Labels created by the CWMClient plugin.
* Streets: Street labels (created by the 3D Road Manager or CWMClient plugin)

¢ Other: Currently Viz World supports KML plugin.
¢ Local file: Shape file which contains names and geo positions.

* Shields: This is based on street data and currently only supports Tom-Tom
data for the USA. It allows the designer to set designs for road types such as
highways, interstates, etc, and to use an iconic representation of the street
instead of the street name. During import of the street data, a CSV file is created
under plugin\data\maps\DesignMappings which contains all the types of shields
found in the data. The Mapping column in this file can be edited in order to map
the shield types to specific user designs, and then the Label and Go plugin is
used to read the file.

* Labels Draw Style:
¢ On Map: Will place the labels on the same camera as the navigator camera
¢ Overlay: Will place the labels on the second camera (normally front layer)
* Alpha fade time: Time (fields) for new labels to appear or disappear

« Max number of labels: Max number of label to render including all the labels so
far (other Label and Go are taken into account aswell)

¢ Culling bounding box: Option to scale the real bounding box to avoid too many
labels on screen

* Line spacing: Line spacing when using 2 lines
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12.16.2 Properties - Design

Plugin
Design Communication
na.ttf F

Capital Town 1m Region Sub Region | Town 100k
o < Nature Tourist

100000.0 38

o Bf
Caption iar C Pointer
Hide

- 100.0 I.'-_-. r
140.0
off [ scalex |
100.0 I.'-_-. r
o B

0.0 [ |
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Font: Sets the font used by all labels.

Label Type: Select from the default types of labels when using auto-labels on Data
Source (Country, Capital, etc).

Using POI-1, POI-2 and so on, allow you to define the name of the style, for example:
Earthquake, Explosion, etc

Render: Enables (On) or disables (Off) rendering of the selected label design type
(e.g. Country, POI-1 and so on).

View Distance: Sets the distance from where the label style should be visible

Set Distance: Sets the View Distance property based on the current distance of the
map

Priority: Overwrites the default priority which is based on type and town size

Caption/Background/Pointer: The Caption, Background and Pointer properties
are different for each type of design, and are described in the separate lists below.

Buttons:
¢ All Off: Turns off all labels, except the one currently edited.
e All On: Turns on all labels.

* Copy setting from type above/below: Copies the settings from the label type
above/below.

Outline Quality : Quality when background is set to outline ( not work will fix )

Outline Quality Mask : Select the mask to use so it will not interfere with the
scene regular makes.

Debug : Draw a green rectangle around all/current labels. (useful to see the
bounding box).

Caption

Caption:
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¢ Hide: will display only the pointer of each label

e Show: Will display both the pointer and the text of each label
Text color: Sets the color of the text.

Text Size : Sets the size of the text. Text size influences all sizes.

Max size: When set to either Scale X or ScaleXY it will limit the size of the text on
either X or XY axis.

Max width: Sets the maximum width the text should take and will scale the text
either on X or XY based on the Max Size setting.

X/Y Offset: Allows to offset the text on XY from its lat/long.

Rotate: When working with streets, the labels can be rotated to follow the street,
when set to OFF they will not be rotated.

Background

Background : Defines the background type for the text (none/rectangle/image/
outline).

Size : Sets the size of the background in relation to the text in percent (%).
Image : Sets a background image for the text.

Background color : Sets the background color.

Outline color : Sets the outline color.

Outline width : Sets the outline width.

Background Fixed Size, Background X, Background Y: When set to fixed size
it lets you define the X Y size of the background.

Pointer

Point: Sets the type of point.

Caption position: Sets the position of the label in relation to the point.
Point Color: Sets the color of the point.

Point Size: Sets the size of the point.

Point Distance (%): Sets the distance of the label in relation to the point in
percent (%).

Point BG: Enables (On) or disables (Off) the Point BG properties.
Point BG Color: Sets the points background color.
Point BG Size (%): Sets the points background size in percent (%).

12.16.3 Properties - Communication

Plugin

Global | Design Communication

None MultiTouch [ Mouse
| None _ Global [ Scene |' Distributed

entifier SELECTED_LABEL
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Off on

Interactive Mode: This property is here for backwards compatibility only. The
recommended way is to use the MTButton plugin instead. (For more information on
MTButton, see the Viz Artist User’s Guide).
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« Shared Memory Type: Changes between Scene-, Global- and Distributed-Shared
Memory.

¢ Shared Memory Ildentifier: Sets the Shared Memory key name.

* Set Data Pool: Enables the distribution of the data to a DataPool structure using
the same name as the Shared Memory ldentifier.

Shared Memory Communication with Label and Go
To send labels via shared memory to Label and Go, you need to send:

Id, Label, long,lat
style ( optional )

Each label must start with id.

Example

dim Variable as string

dim array as Array([string]

\gMy data separated my new line

dim data as String = GetParameterString("Data")
data.Split ("\n\r", array)

\gDepending on label@Go setting

Variable = "LABELANDGO "

Variable.Append ("ADDLABELS")

Scene.Map[Variable] = array

12.16.4 Working with Label and Go

To create a simple Label and Go scene

— E'J' ’C}jﬁ GeoReferenceMap

1. Add the Atlas plugin to your scene tree
2. Add the Navigator plugin to the same container as the Atlas plugin

3. Open the Navigator editor, click Miscellaneous and set Interactive Mode to
Always

4. Add a sub container to the GeoReferenceMap

U

Add the Label and Go plugin to the new container
T

i '
Gibraltar S

w—osoﬁ Corporation

6. Click the Scene Editor’s E button
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* E: Enables the handling of interactive script/plug-in events. Interactive scripts
and plug-ins are those related to mouse or keyboard actions.

7. Click the scene and zoom in and out with your mouse to see the labels appear
8. Open the Label and Go editor to test the settings

To use Viz Config for interactive communication
When using MTButton for interactivity together with Label and Go:

1. The input method from Viz Config will be used (e.g. Win 7, PPI, TUIO, mouse)
2. The clicked label on the map will be published to shared memory

Note: For more information on MTButton, see the Viz Artist User’s Guide.

12.17

Map Scale

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.
The purpose of the Map Scale geometry plugin is to display the scale factor of the map.
The plugin has two views:

¢ General
e Advanced

12.17.1 General

Page 176

MapScale Plugin

e Advanesd

een

Height

Units

Labeling Mode  WEGSBWPEM] Srall Gmps | Continuous | Ruler

Left

25.0 ,’:|—

¢ Geo Source: When set to Navigator, the scale or zoom factor data will be based on
the navigator plugin. When set to Map, the values will be based on the defined Map
container.

* Screen Size: Lets you define what the size of the geometry on the screen should
be, measured as % of the screen on the X axis.

* Height: Lets you define the height of the geometry, measured as % of the screen
on the Y axis.
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¢ Units: Display units in Kilometers or Miles.
¢ Labeling Mode:

The Large/Small Limps options try to find the closest round number in the visible
range. While gradually zooming in or out, the rectangle containing the map scale
will be scaled according to a visible number. When the range limit is reached, the
number will change and the rectangle will jump to a new range. This may result in
an unpleasant visual effect, so the Continuous mode is used where the rectangle
showing the scale remains unchanged and the numbers showing the range change
continuously without jumps.

* Large Limps Changes the text display when the change of scale factor is a
significant change, e.g. 1000KM, and next limp 500KM

*« Small Limps: Changes the text display when the change of scale factor is a
smaller change, e.g: 1000KM, and next limp 900KM

¢ Continuous: Will be an exact number of the coverage area of the geometry

* Ruler: A combination between Continuous mode and Limps. While the total
width of the rectangle remains unchanged, notches are added showing the
rounded range.

¢ Shape: Rectangular edges, Rounded Edges or Notched left and right

When using Notched you have an additional parameter for the direction for the
Notches, Up/Down/Both as well as Width and Height of each Notch.

¢ Outline: allows you to set the outline of the geometry on/off.
¢ Outline Width: When outline is turned on you can define the width of the outline.
¢ Outline Color: When outline is turned on you can define the color of the outline.

12.17.2 Advanced

MapScale Plugin

Camera
Centimeters Label
Meters Label
Kilometers Label
Feet Label

Miles Label

¢« Camera: Sets in what camera the geometry should be placed

* Centimeter/Meter/Kilometers/Feet/Miles Label: Let you define the suffix for
each unit

12.18 Pyramid Control
PyramidCtrl

|

.I;yramidC_‘u-rT
The plugin is in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The purpose of the Pyramid Control geometry plugin is to sort overlapped layers of the
pyramids in the scene such that tiles with higher resolution will not be hidden by tiles
with lower resolution.
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Note: The plugin must be located in the hierarchy of the MapTiler plugin.

Properties

PyramidC

_Enabled

| E}isabled__ _Enabled
50.0 .

1.0

¢ Fade Tiles: When turned on, a fade animation will be applied to each tile level
based on the distance to the hop

« Start/End Fade (%): When Fade Tiles is enabled, these parameters set the %
distance to the hop for starting and ending the fade.

* Bind to Hop: When enabled, the visibility of the pyramids is synchronized based on
the hop that they belong to. When disabled (default), the pyramids are shown based
on the highest resolution available throughout the entire scene.

Note: When using Control MultiHop, the Bind To Hop Property will be set to Enabled
by default.

« Pyramid Fade Start (%): Duration that the pyramids will be fully visible, in
percentage of total hop time.

* Target Fade Start (%): Duration that the target image will be fully visible, in
percentage of total hop time.

« Pyramid Fade Length (%): Time taken for pyramids to fade, in percentage of total
hop time.

* Target Fade Length (%): Time taken for target to fade, in percentage of total hop
time.

¢ RenderTile: Select which pyramid image to display, from all the pyramid levels.
Used mainly for debugging the graphics.

¢ Wire Frame: Show the pyramids in wire frame mode, to help understand the
coverage of the pyramids. Used mainly for debugging the graphics.

« Show Bounding Boxes: Renders the bounding box of the pyramids.

* Refresh All Pyramids (button): Forces a refresh of all pyramids for all hops in the
scene.
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12.19 Region Halo

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps-
Adv.

v =. Region-Designs|

» B ] reson

e 3 o

v B © S ceoneerercoo

Vl' =. Region-Holderl|

- R, weson_com

t=l o O Fal

i) 3 o

The RegionHalo plugin is used to create a halo around 3D Region objects. The plugin is
used in the region design hierarchy with the 3D Region plugin. The plugin and the 3D

Region objects are placed under a group called ‘region’, while the RegionHalo object is
above the 3D Region object.

Note: The halo effect does not work with 3D Region’s extrusion setting(s).

¢ Modes:

¢ Simple displays the most common parameters for manipulating the region’s
halo.

RegionHalo Flugin

ISR Advaneed

Relative Width =E
Refresh

¢ Advanced displays all parameters for manipulating the region’s halo.

RegionHalo Flugin
[ Simple_ AgvERES"]
Relative Width =

Stencil

Stencil Channel

Wireframe

Refresh

« Relative Width: Defines the halo width, relative to the region object’s size.

¢ Stencil: Defines whether the defined mask channel will be used when drawing
the halo (ON), or if no masking will be used (OFF). When using a channel, the halo
shape will follow the object’s shape more accurately.

¢ Stencil Channel: Defines which of the mask channels will be used for the halo
(Scene Settings->Global Settings).
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Warning: Default value is channel 6 (inverted), since Viz uses channels 7 and
8 for shadows. This parameter is used in a scene which makes intense use of
object masks, and the mask channels may collide.

* Wireframe: Draws a wireframe of the halo (for debug purposes).

* Number of Biggest Polygons To Show: Defines the number of region areas that
the halo will be applied to. If the selected region consists of islands, then this value
will define which island and the number of islands that the halo will apply to.

¢ Refresh: Redraws the halo when changing the parameter values.

12.20 Shadow Agent
A
Shadewsgen
The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.
Shadow Agent is an agent for the Shadows parameters covered by the scene plugin
Label Manager Plugin.
Properties
ShadowaAgent Plugin (14.0.0)
Render With Camera ““m
Render With Camera - this parameter defines for which camera shadows will apply:
¢ All - shadows will be rendered on all cameras (Compatible with previous versions).
* Label - shadows are rendered only for the defined off screen labels camera.
¢ Map - shadows are rendered only for the defined map camera.
* Shadow - shadows are rendered only for the defined shadows camera, as defined
in the 3DLabelsManager plugin (Shadows tab).
12.21 Shape to Spline
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This plugin is in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

ShapeToSpline is used for creating and rendering curves in 3D space. Curves may be
represented as simple lines or have volume. The shape of the volume along the curve
(shape of slice) is defined by a 2D geometry that has to be located in a child container
(example geometries: Rectangle, Circle, Noggi).

This plugin uses the Shape to Spline Shader plugin for visualization. The shader will be
added automatically to the container.

This plugin has three main tabs: General Tab, Curves Tab and Debug Tab.
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If using curves from a KML file also see the section on Building Lines from a KML File.

This plugin also works together with plugins such as: Trace It

General Tab

Data Source

Spline Control Points | Curve Points Controlled
nder Type W

Trim Start*

Trim End*

Trim Offset*

« Data Source: The curve shape may come from a KML file or may be generated by
the plugin itself (using the settings in the Curves Tab)

¢ Spline: The original curve may be smoothed to produce a nicer look.

¢ Control Points: The original points serve as control points and a smooth curve
will come between them.

¢ Curve Points: The curve will pass through the original points.

¢ Controlled: The spline option smoothness can be controlled by the Spline
Smoothness parameter.

The resolution of all three spline options is controlled by the Spline Tessellation
parameter and its value defines the number of additional points between each pair
of original ones.

* Render Type:
¢ Shaped: The volume is defined by a shape.

e Curve: The curve is represented by a simple line with dots positioned at the
original points.

* Closing: Defines whether the curve is Open or Closed. In closed curves there
should be no gap between the start and the end point.

¢ Rotation*: Rotates volume shape along the curve.
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Note: All parameters marked with * (asterix) are not required for the curve to
be rebuilt, so can be animated without any performance impact!

Twist*: Rotates the volume shape from the end of the curve.

Trim Start*: Trims the curve from the start point.

Trim End*: Trims the curve from the end point.

Trim Offset*: Offsets the trimmed chunk along the curve.

Scale*: Scales the volume shape along the curve.

Scale Start*: Scales the volume curve from the start point only.
Scale End*: Scales the volume curve from the end point.

Texture Speed*: Moves a texture along the curve with defined speed.

Smoothing Angle: Defines the maximum angle between the normals of adjacent
faces of the 2D shape to be smoothed. For example if the shape is a circle
tessellated by 20 corners, the angle between them is smaller than the default 30
degrees and so it will be seen as a smooth cylinder. If the parameter was lowered to
say 17 the shape will be rendered faceted. The parameter is mainly used to be able
to smooth the curve but be able to preserve sharp corners.

Twist Type: The shape can behave differently while going along the curve. It may
twist with the curve or behave in a more moderate way. The Moderate behavior
may result in a more pleasant visual result. The image below shows a curve that
performs spiral twist (left); the same curve with a shape going along the curve and
twisting with it (center); and finally, the same curve with moderate behavior (right).

Fix Rotation To Plane: Used for the cases when curve is positioned on a 2D plane
and the desired behavior for the rotation of a volume shape is to be stuck to that
plane (the upper side will always be positioned 'up' relative to the curve). In such

a case, the plane normal should be specified. Note that if the specified normal is
parallel to the curve, the result is undefined.

Get Shape: Click this button to get the 2D shape from the child container that will
define the volume profile of the curve.

Curves Tab

[ General GIREE™ Debis
TGRE™| Folygon | Trefol

1.0

0.5 ,’:|—
B

300 ,’: |—
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The generated curves are defined in this tab.

¢ Curve Type: The curves can be created from three groups of mathematic
equations: Torus, Polygon or Trefoil (which is actually a special case of torus).

* Parameters: The parameters under each Curve Type are the parameters for the
mathematical equation defining the curve. Adjust these values to see which effect
they have on the curve.

¢ Torus Presets: These presets can be used to obtain some nice curves without
individually tweaking the parameters.

* Tessellation: Defines how many points the curve will have.

Debug Tab

This tab contains tools that allow you to better understand the shape, like displaying it
in wireframe mode or showing the normal.

Building Lines from a KML File

When the source for the curves is a KML file the KMLReader plugin is used to get the
information from the file and dispatch it to the plugin. KMLReader should be placed
under valid georeferenced (as KML is a geographic format using lat/long coordinates).

To set up the KMLReader, define the design and holder containers by using the Line
Designs & Holder button, set 'Line Split' to 'On', and specify the KML file.

Also consider the following:

1. If the KML file uses Design name, the container with the corresponding design
must prefix this name with hash (for example #LineStyle_00). If the default design
is used, the container must be named 'Default_Design'.

2. The KML style can define the following properties: width (meters), shape,
curvature and textures.

3. To be able to match the shapes to the curves, the name of the container
containing the 2D shape geometry under each design has to correspond.

4. Three options can be used to define curvature: Linear, Control Vertex, Curve Point.
This will set the spline parameter in the plugin for the appropriate setting.

5. Texture can be used once for the whole curve or as an array to texture each chunk
of the curve. In such a case number of textures must correspond to the number of
line chunks.

12.22

Street Labels

Streetla

N

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Geom Plugins -> Maps.
The Street Labels plugin can be used for drawing street labels. Until now the solution
was to use Viz objects to draw street labels where the main drawback was the number

of labels required. Using Viz objects you are limited to 300 to 500 containers before Viz
no longer is able to render in real time.

The Street Labels plugin draws the street labels by itself and by doing so it can holds
over 100.000 labels.
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Since it is not an object designed in Viz Artist the only freedom you have is the
font used and relative position and scale, the Street Labels plugin will only work for
Navigator scenes.

To enable the use of the plugin (as opposed to designing your own street labels) you
need to set under Label Manager’s Auto Labels tab the level of Road Labels to be
shown. The Road Labels option defines the level (number) of road labels that will be
displayed (zero (0) means no labels). You also need to set the label style to be Internal
(Open GL).

Properties

StreetLabels Plugin

Font -\
Width (%) Of 100.0

0.0
Min Pixel DrawingSize

Alpha Fade Time

Other Railways
ce For Same Street Name(%)

Direction

¢ Font: Defines the font used for drawing the labels.
¢ Width: Defines the width of the label in relation to the width of the street.
¢ Position: Defines the position of the label in relation to the center of the street.

¢ Min Pixel drawing size: Defines the minimum number of pixels used to draw
the labels. If the number of pixels is smaller than the current labels (based on
parameters above and the width of the street) the label will not be drawn. The
number must be smaller than the maximum width numbers in the 3D Roads plugin
design.

* Alpha Fade time: Defines the number of frames used to fade in or out when label’s
status changes.

* Render: If controlled is enabled the plugin will draw the streets that belong to the
3D Roads plugin above it, if Standalone is enabled the following settings will apply:

* Primary Roads, Main Roads, Secondary Roads, Other Roads, Major
Railways and Other Railways

¢« Minimal Distance for Same Street Name (%): Distance in screen percent for
showing the same street name twice.

* Direction: Defines the direction of the label. Options are Left to Right (LTR) or Right
to Left (RTL) (not complex script).
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13 Container Plugins

The World Map Editor (WoC) installation includes a package of plugins used for

enhancing the geographic referencing ability in Viz Artist. The WoC plugins includes

geometry, container, shader and scene plugins.

This chapter describes all container plugins. The container plugins are found in seven
plugin folders:

See the following sections for more information:

Maps: Contains Standard plugins.
Maps-Adv: Contains Advanced plugins.

Maps-Lab: Contains experimental plugins. Since these plugins are experimental

and not supported, they are not documented here.

Maps-Man: Contains a set of Manager plugins used for batch creation of 3D

Objects such as regions, borders, and so on.

Maps-Obs: Contains Obsolete plugins, installed only for backward compatibility.

These plugins should not be used when desighing new scenes.
Tools: Contains Tools plugins.
Weather: Containers Weather plugins.

Standard

3D Map Telestrator
Center Map
CWMClient

Focus On Map

Geo Text

Hop Sync

Label It
LatLongGrid
Locator Control

Map Layers
Map Layers Control

Map Pyramid
Map Tiler

Map Zoom
NavFade

NavFinder
Navigator
NavScale

Place Finder
Region to Texture

Trace It
World Position
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Advanced

e 3D Map Telestrator Design

e Hoplt
¢ Label AddOn

¢ NavCom

¢ NavSlave
e Publish To Design

Manager

e 3D Border Manager

e 3D Line Manager

e 3D Region Manager

¢ 3D Road Manager

* Hops Manager
e KML Reader

Obsolete

* Globe Zoom
e Screen Scale

Tools
¢ Mute

Weather

* World Image Refresh

See Also

¢ Geometry Plugins
e Shader Plugins
¢ Scene Plugins

13.1 3D Border Manager

3 rilgr

—

B

30Borderia

The plugin can be found in the folder: Viz Artist 3: Built Ins ->Container Plugins-> Maps-
Man.

The 3DBorderManager plugin is used for creating 3D Border objects based on shape
files. The plugin uses a 3D Border design to create borders according to the defined
settings.
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Properties

3DBorderManager Flugin (14.0.0)

Design ’7F|
Target [ We [ Net | vown |cemmmerT|

Target Container ‘ F‘

Shape File J/plugin/data/maps/ m
Simplify Threshold (Meters) 0.0 ﬁﬁ

Persistent Data m—

Design: Sets the 3D Border design container that is used for building lines. The
design container should be built with a 3D Border object and a material. No special
naming convention is required.

Target: Defines the container to be used as the parent container for the border
containers:

e Me: The 3D Border objects will be built under the current container (holding the
3D Border Manager plugin).

¢ Next: The 3D Border Objects will be built under the next container (next
container in the tree and at the same level as the 3D Border Manager container).

« Down: The 3D Border objects will be built under the first child container.

¢ Container: The 3D Border objects will be built under the container dragged into
the Target container place holder.

Target Container: Specifies the container that will hold all the 3DBorder objects.

Shape File: Defines a path to the shape file (*.shp), containing the border
definitions. Shape files are bought from vendors specialized in Geographic
Information System (GIS) and holds the actual shape data; polygons, splines, and
others. Note that shape files must be stored in individual folders.

Simplify Threshold: Sets the detail reduction factor for the shape borders.

Persistent Data: Defines whether the data will be removed from Viz memory when
the scene is closed or not. When enabled references are kept, and load time is
quicker.

Border Type: Defines which border type will be associated with the created objects.
If Advanced is selected, additional parameters will be enabled allowing the
configuration of border type according to the data associated with the shape file.

* Border’s Type: Specifies the column name that holds each border type.
Country ID, Region ID, Sub Region ID and Coastline ID: Specifies the string
in the database file (*.dbf) that matches to each type (e.g. Country, Region and
So on).

Clear and Build: Removes all child objects of the target container and re-builds the
objects, using the plugin settings.

Clear Target Tree: Removes all child objects of the target container.

13.2

3D Line Manager

LineMgr

3DLineMana
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The plugin can be found in the folder: Viz Artist 3: Built Ins ->Container Plugins-> Maps-

Man.

The 3DLineManager plugin is used for controlling and creating 3D Line objects. The
plugin uses a 3D Line design to create lines according to the defined settings. The
plugin allows you to build 3D Line in four different modes: Navigator, Command, from
WME and from a Shape file.

This section contains information on the following topics:

e Properties

Properties

3DLineManager Plugin

| ShapeFile

* Design: Sets the 3DLine design container that is used for building lines. The design
container should be built with a 3D Line object and a material. No special naming
convention is required.

* Target: Defines the container to be used as the parent container for the line
containers:

Me: The 3D Line objects will be built under the current container (holding the 3D
Line Manager plugin).

Next: The 3D Line Objects will be built under the next container (next container
in the tree and at the same level as the 3D Line Manager container).

Down: The 3D Line objects will be built under the first child container.

Container: The 3D Line objects will be built under the container dragged into
the Target container place holder.

« Data Source: Defines the source from which the 3D Line objects will be created:

Navigator: A 3D Line object will be created using the hop locations defined in
the Navigator plugin. The line will start at the first hop location and end at the
last hop location. Note that when using the Navigator as the data source, the 3D
Line Manager should reside under the Navigator container.

Command: The 3DLine object will be created from a list of Long/Lat pairs
defined by the user, for example: MyLine: 0,0 0,50 30,30

WME labels: Allows you to build a line between locations chosen in Map Editor
Classic (WME) as WME labels (no line will be built if WME labels are not defined).
Also, the WME source container must be specified and refresh should be applied
by clicking the Refresh button in CWMClient (Rebuild button is disabled in this
mode). The line between the labels starts and ends in the order they where
added (as seen in WME's Map Details list). The first label location is the label at
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the top of the list, and the last is at the bottom of the list. Rearrange the list to
create a new order.

* Shape file: Uses a shape file as data source.

Note: In WME Labels option, the 3DLineManager should be attached to the
CWMClient plugin container. The Labels in the CWMClient plugin must be
enabled.

* Flow Data / Routing Data / Flow & Routing: For the selected data source,
define the Simplify Threshold and FRC level. Simplify Threshold reduces the
resolution of the data from the shp file selected. FRC level (High/Medium/Low)
sets the FRC level, for example, High would draw highways and major roads.

Spline: Enables you to convert a line to a smooth curve in different modes:
¢ Off: no curve, straight line chunks between data points.

* Control Points: line is represented as smooth curve that passes between data
points.

* Curve Points: line is represented as smooth curve that passes through data
points.

¢ Controlled: same as Control Points, but smoothness (i.e. distance of the line
from original points) can be controlled.

Set Navigator Hops: Enables the scene to do a hop animation between the labels.

* The animation can be altered by using the Trace It plugin by setting and enabling
a different Trace Camera, Lock Pan, Lock Tilt and Lock Distance mode/parameter
(e.q. creating a flyby/flyover animation).

* In this case the Trace It plugin is added as a sub container of the
Default_Design container (defines the 3D line’s default design) which is
resides under the Map Start (M-s) container. Once changes are made you simply
republish the design (see Publish To Design plugin).

Exclude Hops: Excludes the hop animation for the following labels; None, First,
Last or First & Last. Manual Shift allows you to define which destination that should
be your starting point (limited to a selection of 30 destinations).

Set Hops Height: Allows you to disable or enable the Hops Height setting.
« Hops Height: Enables you to define the height of the hops in Viz units.

Rebuild: This button will force a rebuild on the cache files generated for the
selected shp file.

Build Hierarchy and Data: This button will build base scene hierarchy for traffic
flows scene type and generate needed cache data from the selected shp file.

13.3

3D Map Telestrator

Telestrator

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps

3D Map Telestrator plugin enables you to draw strokes on maps (including globes) and
arbitrary flat objects using screen input interface like mouse or "touch screen". The
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strokes, whether with geo or non-geo coordinates, may be passed to other scenes on
distant computers through the mechanism of shared memory.

3D Map Telestrator uses 3D Line for strokes visualization and thus it benefits from the
rich design capabilities of this plugin.

The obtained strokes may be smoothed to an arbitrary degree to obtain better looking
final result of the drawing.

This section contains information on the following topics:

Properties
Creating a 3D Map Telestrator Scene

Non Geo-Reference Telestration

Shared Memory Mechanism

Using Multitouch Interface

Using Perceptive Pixel Interface

Brush Design Using 3D Line

See Also

3D Map Telestrator Design

Properties

General

3DMapTelestrator Plugin
Shape Recognition
=[q
= I
=

[ e Bown | Cortainer |

| off on'P

off Control Poinks || Curve Points  [WEGmBIHEE |

N
Io#
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Build On Load

Camera: Defines working camera to accept screen input (which is useful in a scene
with layers where more than one camera is used).

Line Pixel Resolution: Defines the required resolution of line during drawing,
such that for example if resolution of 5 is set strokes less than five pixel size will be
disregarded.

Designs Holder: Container beneath which the required design will be searched.

Design Name: A couple of designs may be implemented in the scene and here the
desired one for current use will be set. If the required design does not exist, the first
one found will be used.

Target: Defines where to build line strokes. If the Container option is used the
desired container should be specified in "Target Container" section.

Copyright © 2016 Vizrt



Viz World Client and Server User’s Guide

Active: Defines when the plugin will be active. It may be switched off, active
always or only be activated while pressing 'p’ button on the keyboard. This is useful
when other interactive capabilities are used in the scene (for example interactive
navigation) and a care should be taken in order not to interfere these modes.

Spline: By choosing one of these options the final result will be smoothed for more
pleasant look. The three spline types define three different methods for smoothing.

¢ Control Points: Uses a spline that paths between the points of the original
curve. This will result in the smooth nice curve but may be not accurate enough
since the line doesn’t actually path through original route but may deviate from
it.

e Curve Points: Makes the spline path through points of interest of the original
curves, but this method may also result in some artifacts causing the route to
deform between points of interest, and that is due to a constraint that curve
must be smooth.

¢« Combined: Is a kind of compromise between Control and Curve points (see
Examples)

Smoothness: If spline is used in order to obtain smoothed result the smoothness
defines the threshold for such operation. The higher the threshold the softer the
curve will be (see the examples at the end of this section).

Close Stroke: If enabled strokes will be automatically closed.

Control mode: While enabled evokes a shared memory mechanism to send and
receive strokes to and from other 3D Map Telestrator plugins.

Shared Memory: defines type of shared memory:

¢ Global: Shared within the region of computer.

* Scene: Shared within the region of current scene only.

¢ Distributed: Shared between all the scenes and computers in the network.

Shared Memory Name: Defines the name for connection, such that only
3DMapTelestrators with the same name will share data between them.

Input Interface: Selects interface type for line creation. See further remarks about
"PPI" and "Multitouch" use.

Animation Control: When enabled runs animation that is located on design
container after line is created (mouse button released).

Build On Load: Determines whether or not the lines created when the scene was
saved, will be built when the scene is loaded.

Clear/Undo/Redo: Enables you to undo and redo last strokes or clear the whole
drawing instead.

Shape Recognition

3DMapTelestrator Plugin

Build On Load
Recognize Ellipse
Recognize Square

Recognize Triangle

Build on Load: Determines whether or not the lines created when the scene was
saved, will be built when the scene is loaded.
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* Recognize Ellipse, Square, Triangle and Line: Recognizes four shapes: ellipse
(including circle), square, triangle and line. When the plugin recognizes a shape it
rebuilds it to be of ideal shape (i.e. a hand-drawn circle will be replaced by a perfect
circle of the same size). The Try Harder option means that there will be more
probability to recognize the requested shape (for example the circle may be less
ideal and still be recognized) running the risk that it might replace shapes that are
not e.g. circles. When Try Harder is enabled only one shape can be recognized as
opposed to the Try option which enables the plugin to recognize multiple shapes
simultaneously.

Examples

Influence of the curves parameter set to original, control points, curve points and
combined:

Influence of the curves parameter set to original, control points, curve points and
combined:
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Influence of the smoothness parameter set to original, low, medium and high:

13.3.2 Creating a 3D Map Telestrator Scene

To create a 3D map telestrator scene

1. Prepare a blank workspace for the new scene, go to Geom Plugins -> Maps and
drag an Atlas plugin to the scene

2. Open the Atlas plugin’s editor, and in under Data Source switch to CMR (Curious
Multi Resolution), and in the CMR File locator locate the CMR with the desired
map

* This will create a map to draw on

* If you have an Internet connection and license for Microsoft Bing maps you will
see the world map as soon as you drop Atlas and there will be no need to load
CMR

3. Go to Container Plugins -> Maps and drop the Navigator plugin onto the
same container as the Atlas plugin

* Remember to enable interactivity by pressing the E button (to the left of the
scene editor).

* Now navigation through the map is possible by pressing i button and using
mouse. If the map suddenly disappeared after dropping Navigator plugin just
click the Center Map button on the bottom of it.

Add a container above the one just prepared and name it LineDesigns
Add a new container as a child of LineDesigns and name it Red
Add the 3D Line plugin to the Red container

N o v ok

Open the 3D Line plugin’s editor and set the Width parameter to Fixed
(Pixels)

8. Set the Width’s sliding parameter to 4
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9. Switch to the Outline option on the topmost radio button row and set Outline to
On and give it a width of 50 (Outline Width (%) parameter)

10. Add material to the container and make it to be red color. This will create the first
design for the line.

11. Add another container beneath the Red container and name it Green
12. Add the 3D Line plugin to the Green container

13. Open the 3D Line plugin’s editor and set the Width parameter to Fixed
(Pixels)

14. Add a material with a green color to the container
* This defines the second design for the line named "Green".

15. Add a new container as a child of the Atlas container and name it Telestrator
and add the 3D Map Telestrator plugin to it

16. Open the 3D Map Telestrator plugin’s editor and drag the LineDesigns container
onto the Designs Holder placeholder

17. Set the Design Name parameter to Red (in order to choose red design)
18. Set the Active parameter to the On P position

19. Set Shared Memory parameter to Distributed

20. Save the scene

|r_| 2 rsavigoor [ Al | | 0| | o] ] S| [ RS
°E 7 v

Now you should be able to draw on the map by pressing the P key on the keyboard and
while holding the left mouse button down. Moreover, if you open the same scene on
another computer in the network you should see the same drawings appearing on it
too.

Non Geo-Reference Telestration

In the procedure on how To create a 3D map telestrator scene the drawing was done on
the map, i.e. the path has geographic coordinates and as such it will be placed on the
same geographical route when it will be sent to other computers (by using the Shared
Memory Mechanism). The other map in the other scene may have different style and
projection. It may also have globe geometry, and the path will still be geographically
correct.

However, there is an option to use 3D Map Telestrator without map and geographic
coordinates. In order to use this option two conditions must be met:

¢ The plugin must not be located under geo-reference (in the example scene the Atlas
was used as geo-reference), and
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¢ The flat geometry about to be drawn on must be placed on the same container with
3D Map Telestrator plugin.

13.3.4 Shared Memory Mechanism

As explained in the 3D Map Telestrator Properties section, the plugin uses a shared
memory mechanism in order to send and receive strokes to and from other 3D Map
Telestrator plugins.

In order for two plugins to interconnect they should have the same name for the
shared memory data they are "listening" to. The given name should have a prefix of
"Telestrator ", such that when a user enters the name "alpha" for the group of 3D
Map Telestrator plugins, the actual name of the shared memory parameter will be:
"Telestrator_alpha'.

The format of data consists of a unique id that each stroke receives, name of required
design and data path that comes as a sequence of pairs of numbers representing
longitude and latitude (when non-geo-reference mode is used the flat geometry’s
bounding box is treated as if having the lat/long coordinates of full world). All
components of the data including design name and unique id are separated by
commas.

13.3.5 Using Multitouch Interface

This interface uses touch screen of Multitouch type. In order for the plugin to receive
information from the screen the Input Interface button should be switched to
Multitouch mode and a container with the plugin should contain a geometry. Screen
touches outside of this geometry will be disregarded. So, if the plugin is used in a non-
georeference mode there is no problem since it already contains geometry you are
drawing on. If it is used in a georeference mode the best practice would be to place the
3D Map Telestrator plugin on the container with the map.

13.3.6  Using Perceptive Pixel Interface

In a case of using a Perceptive Pixel Interface (PPI) screen the setup requires a couple
of additional things to be done. A special plugin named Mt2dControl, that is a part

of the PPI plugin package, will accept and process the inputs from the touch screen
and the processed data will be sent to the 3D Map Telestrator plugin through a shared
memory mechanism.
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Continuing the procedure above on how To create a 3D map telestrator scene, you can
add multi-touch capabilities to your graphics scene. Hence, the below procedure and
example scene tree expands the aforementioned procedure.

1
v % LineDesigns|

TS
%#“\%ﬁ Green

== EE e DM e e
v m_. J = _% T@@"E GeoReferenceMap

" Bl

1. Open the 3D Map Telestrator plugin editor and set Input Interface to PPI (see
Properties) and chose a name for a shared memory connection with the PPI
interface (i.e. a PPl variable name). Note that this must differ from shared memory
connections with other 3D Map Telestrator plugins

2. Add the container somewhere in the scene which will not be a part of any
hierarchy

Add a rectangle to the container and scale it to the maximum possible size
Add a Mute plugin on the container in order to avoid rendering it
Add a Multi-touch 2D control (Mt2dControl) plugin on the container

o U kW

Open the Mt2dControl plugin editor and set the following parameters:
* Lock Rotation to On

* Lock Scale to On

* Shared Memory to On

* Shared Memory Type to Scene

* Shared Memory Prefix should be the same as the PPI variable name in the
3DMapTelestrator plugin

* Hit Coordinate Type to World
7. Save the scene

* Now you should be able to draw lines by touching the screen

See Also

e Using Multitouch Interface

Brush Design Using 3D Line

The 3D Line plugin is used by the 3D Map Telestrator to visualize the strokes. The
desired look of the line is set by various parameters in the design (inside the 3D Line
plugin) and it is therefore important to understand these parameters in order to get the
desired look and behavior for the line.

The following are the most important parameters:

Width
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The options for the Width tab defines the width behavior of the line. Three options may
be used to define width behavior:
¢ Fixed (pixels): Defines constant width of line measured in pixels

¢ Scaling: line width may vary according to zoom and the minimum-maximum
parameters could be set

* Fixed (mm): Sets a fixed width in geographic units

* Fade Edge (%): Applies a fade effect to the side-edges

Outline

By using these options an outline of arbitrary width, fade amount and color can be set
to a line.

Effect

Note that by default when a line comes to a 3D Map Telestrator plugin it plays an
animation running from single point to a full path. The attributes of such an animation
can be set beneath this tab. The length of animation in time is controlled by the
Animation Length parameter and if it is set to ‘0’ no animation will be played at all.
Moreover, a nice fade effect to a running edge of the line could be set by the Fade
parameter.

Advanced
A couple of options are available for this tab, the most important of which are:

+ Cap edges: Defines shape for the beginning and end edge of the curve
* Height Offset: Defines an offset line from surface it is put on

 Update Texture Mapping: Note that a texture may be applied to a line. During
zooms, line width is updated according to the setting we made in Width tab, while
line length remains unchanged, thus texture mapped on the line may deform. In
order to keep same aspect ratio for the texture this option must be enabled.

13.4 3D Map Telestrator Design

£

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps-Adv

3D Map Telestrator Design plugin controls 3D Map Telestrator options through design
setup. When this plugin is added to the design its setup is imposed on the 3D Map
Telestrator (i.e. parameters set in 3D Map Telestrator Design plugin will override
parameters set for the 3D Map Telestrator), and thus it is possible to control spline type
and smoothness, close option and shape recognition setup from a design perspective.
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Properties
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* Smoothness: If spline is used in order to obtain smooth results the smoothness
defines the threshold for such an operation. The higher the threshold the softer the
curve will be (see the examples at the 3D Map Telestrator’s Properties).

* Close Stroke: If enabled strokes will be automatically closed.

* Recognize Ellipse, Square, Triangle and Line: Recognizes four shapes: ellipse
(including circle), square, triangle and line. When the plugin recognizes a shape it
rebuilds it to be of ideal shape (i.e. a hand-drawn circle will be replaced by a perfect
circle of the same size). The Try Harder option means that there will be more
probability to recognize the requested shape (for example the circle may be less
ideal and still be recognized) running the risk that it might replace shapes that are
not e.g. circles. When Try Harder is enabled only one shape can be recognized as
opposed to the Try option which enables the plugin to recognize multiple shapes
simultaneously.

13.5

Page 198

3D Region Manager
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The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps-Man.

The 3DRegionManager plugin is used to create sub regions of a selected region on
the map, using a 3D Region design. The plugin receives the region name and gets all
the sub regions of that region from the server or a shape file. The 3D Region design is
duplicated for each sub region and displayed on the map.

This section contains information on the following topics:

¢ Common

¢ Build Region
e VizBoldButtons
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13.5.1 Common

3DRegionManager Plugin (14.0.0)

|'|
Mext Down Container
Local w Command || Region Id

sible Filter Country Region g
" Seleted  PREEE™]

Select Region (WME) Select Region (Classic)

Clear And Build Add To Existing Clear Targst Tree Freeze All

laal

* Design: Sets the region design container that is used for building sub -regions. The
design container should be built with a 3D Region object and a material. No special
naming convention is required.

* Target: Defines the container to be used as the parent container for the sub
regions containers:

Me: Builds the 3DRegion objects under the current container (holding the
3DRegionManager plugin).

Next: Builds the 3DRegion objects under the next container (next container in
the tree and at the same level as the 3D Region Manager container).

Down: Builds the 3DRegion objects under the first child container.

Container: Builds the 3DRegion objects under the container dragged into the
Target container place holder.

13.5.2 Build Region

Target

Build R

an

3DRegionManager Plugin (14.0.0)

e
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o Local PWHER Shape File | Command Region Id
r Visible Filter Country Region | [ HgRe |
" Selected | REERERE™

| Select Region (WME) I Select Region (Classic)
Clear And Build Add To Existing Clear Target Tree Freeze All
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+ Build Region: Defines the source for which the 3DRegion objects will be created.

Local

Local: Builds the 3DRegion objects for the container that the 3D Region Manager
is applied to. The container must be a 3D Region object for the sub regions to be
built for the defined region.

WME: Enables the user to select the regions or sub-regions inside the WME

Shape File: Allows the user to select a shape file that contains the regions to be
created

Command: Allows the user to set a command with the parameters of the
regions to build

Region ID: Enables the user to show a specific region by region ID after having
prepared the cache files.

« 3D Border Visible Filter: Sets which borders should be cropped to map. Any
border lower or equal to the selection will be cropped to the map. Available options
are Country, Region and None.
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WME

* 3D Border Visible Filter: As described above.
¢ Scan: Defines what regions to display.

¢ Selected: Displays only the selected regions, selected by pressing the Select
Region button.

* Recursive: Displays all selected regions and their sub regions.

* Select Region (WME): Opens the World Map Editor , enabling the selection of
regions to be used in Selection mode. Press the Select Region button to select the
regions to be built.

+ Select Region (Classic): Opens the Map Editor Classic , enabling the selection of
regions to be used in Selection mode.

Shape File

Build Region ocs WHME |

Shape Regions mm—
Shape File o in/data H
Conversion File -fplugin/data/maps/ H
Parent 1d Column

Parent Name Column

Parent Name Lengh

Ids' Column

Names' Column

[ Prepare Cache Files |

+ Shape Regions: Defines how the regions will be built. Available options are Merge,
Split and Advanced.

¢ Merge: Creates all regions in the file as one object.
* Split: Creates all regions in the file as separate objects.

* Advanced: Enables the additional parameters Conversion File, State Column
and Name Column. Conversion File defines a file for converting regions indexes
into region names (*.txt file). Parent Id Column, Parent Name Column and
Names Column refer to columns in the database (*.dbf) file that comes with the
shape file. The database files describes what is attached on the shape file. Note
that database files can be opened with Microsoft Office Excel.

* Shape File: Defines a path to the shape file (*.shp), containing the region
definitions. Shape files are bought from vendors specialized in Geographic
Information System (GIS) and holds the actual shape data; polygons, splines, and
others for the container that the 3D Region Manager is applied to. The container
must be a 3D Region object for the sub regions to be built for the defined region.
Note that shape files must be stored in individual folders.

¢ Conversion File: Files used to convert IDs in the file to Viz World IDs.

* Parent Id/Name Column: Column which holds the ID/Name of the parent of the
region

* Parent Name Length: Option to truncate the parent name (0= no truncation)

¢ Ids’/Names’ Column: Column which holds the ID/Name of the region.

* Prepare Cache Files: Instead of building large amounts of regions from a shape
file (which may overload the system), pre-creation of the cache files and then
building the required regions only (directly from the cache files) will minimize the
memory usage. Only prepare Cache Files (without loading the data to Viz) the files
can be used later in Viz, based on the ID.
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Command

Build Region =] WME Shape File |[TCommend | Regionid |

¢ Command: Builds a 3DRegion object from the specified command. The command
defines the region coordinates using pairs of longitude and latitude values. The
command format is as follows:

<3DRegionContainerName>: Longl,Latl Long2,Lat2...
Region Id
Nest | Down | Contaner |

o B
[T temt [ WME | Shepzriz || Cammand | REERTET]

Jelu

Clear And Build I Add To Bxisting Clear Target Tree | Freeze All
=

¢ Shape File: Defines a path to the shape file (*.shp), containing the region
definitions. Shape files are bought from vendors specialized in Geographic
Information System (GIS) and holds the actual shape data; polygons, splines, and
others for the container that the 3D Region Manager is applied to. The container
must be a 3D Region object for the sub regions to be built for the defined region.
Note that shape files must be stored in individual folders.

* Region Id: Sets the region’s ID for the required region.

13.5.3 Buttons
* Clear and Build: Deletes all previously built objects and rebuilds the regions
according to the current settings.
* Add To Existing: Builds the new objects without deleting the old 3D Region objects
from the hierarchy.
* Clear Target Tree: Removes all objects built by the plugin from the Viz scene
hierarchy.
* Freeze All: will freeze the regions to the scene instead of recreating them on load.
13.6 3D Road Manager

Copyright © 2016 Vizrt

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps-Man.

The 3DRoadManager plugin is used for creating 3D Roads objects. The plugin uses a
shape file design to create roads according to the defined settings.

Properties
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* Roads Mode:
* Global: Applies one set of road design for all roads

¢ Design: uses a design per CWMClient. The Design field sets the roads design
container that is used for building border data from a shape file. The design
container should be built with a 3DBorder object and a material. No special
naming convention is required.

¢ Target: When Roads Mode is set to Design, this defines the container to be used as
the parent container for the road designs.

* Me builds the 3DRoads objects under the current container (holding the 3DRoads
Manager plugin).

¢ Next builds the 3DRoads objects under the next container (next container in the
tree and at the same level as the 3DBorderManager container).

* Down builds the 3DRoads objects under the first child container.

e Container builds the 3DRoads objects under the container dragged into the
Target container place holder. The Target Container specifies the container that
will hold all the 3DBorder objects.

e Source: Select street/road source.

e WME: Viz World Map Editor (WME) using the CWM client plugin to connect to the
map server

¢ Shape File: Shape file that contains street data.

¢ Cloud Made: Load street data from Cloud Made. This is a web service which
requires a license.

+ Data Set: Load street data from the converted data supplied by an external
provider into Viz World format

WME

* Simplify Threshold: Sets the detail reduction factor for the shape of the roads.
¢ Select Streets (WME): Opens the World Map Editor .
* Select Streets (Classic) : Opens Map Editor Classic .

* Labels Mode: When set to None, no labels will be created, Partial will only create
labels visible on the view, All will create all labels.

¢ Labels Only: When set to ON, only the labels will be created, but not the roads.

Cloud Made

* Simplify Threshold: Sets the detail reduction factor for the shape of the roads.

* Labels Mode: When set to None, no labels will be created, Partial will only create
labels visible on the view, All will create all labels.

¢ Labels Only: When set to ON, only the labels will be created, but not the roads.

Data Set

* Data Set: Location of data
¢ Simplify Threshold: Sets the detail reduction factor for the shape of the roads.

¢ Labels Mode: When set to None, no labels will be created, Partial will only create
labels visible on the view, All will create all labels.

¢ Labels Only: When set to ON, only the labels will be created, but not the roads.
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Shape File

* Shape File: Defines a path to the shape file (*.shp), containing the border
definitions. Shape files are bought from vendors specialized in Geographic
Information System (GIS) and holds the actual shape data; polygons, splines, and
others. Note that shape files must be stored in individual folders.

* Sort Roads By: Sets the loaded roads from the shape file in a category.

* Category enables the user to select one predefined category of street data.
Available Road Types are Freeways, Primary, Main, Secondary and Other.

¢ Advanced splits the data into different categories using specific string types.
Road Type Column specifies a column name that holds each road category.
Freeways/Motorways, Primary Roads, Main Roads, Secondary Roads and
Other Roads specify what string in the database file (*.dbf) that matches the
road type.

¢ Persistent Roads: Defines whether the roads data is removed from Viz memory
when the scene is closed or not.

¢ Sort Roads By: Defines which road type will be associated to the created objects.
If Advanced is selected, additional parameters will be enabled allowing the
configuration of road types according to the data associated to the shape file.

« Category: Enables the selection of road types. Available options are: Freeways,
Primary Main, Secondary, Other.

Siobal BRG]
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[ Freeways  |OERImER| Main || Secondary
| Other | Major Railways | Minor Railways

Rebuild All (force) I Rebuild Labels I Clear All

¢ Advanced: Sets parameters according to the data in the files associated with
the shape file. Defines the road type column and the specific road type Id in the
file.

3DRo: ager Plugin (14.0.0)

Cloud Made Data Set

R Id Al | Rebuild AN (foree) Rebuild Labels Clear all
=

¢ Road Name/ld Column: Column which holds the Name/ID of the road.
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Buttons

* Rebuild All: Rebuilds all data. If Roads mode is set to Design, 3DRoads objects will
be created from design. If Roads mode is set to Global, global 3DRoads renderers
will render built data.

¢ Rebuild All (force): will delete any cache and force a rebuild of the cache as well
as rebuilding the Viz geometry.

* Rebuild Labels: will rebuild only the labels but will not affect streets already built.

¢ Clean All: Cleans Target container from sub containers.

13.7 Center Map

\t\

Centerhiap

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The Center Map plugin is used, with map objects, for keeping a point on the map in the
center of the map object. The map is moved while the defined point remains centered.

With a Flat map, the map is moved, but with a Globe map the globe is rotated. See also
Map Tiler for more information on Flat and Globe maps.

Note: The Center Map plugin should only be applied to map objects.

Properties

¢ Position: Defines how the map will be centered:

¢ User: Enables the user to manually define a center point by setting Map Center
Longitude and Map Center Latitude values.

CenterMap Plugin (14.0.0)
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*« WPosition: Centers the map at the location of a WPosition container dragged
into the Remote Container place holder.

CenterMap Plugin (14.0.0)
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* Navigator: Centers the map at the location of a Navigator container dragged
into the Remote Container place holder.

« WPoint: Centers the map at the location of a WPoint container dragged into the
Remote Container place holder.

¢ Map: Centers the map at the center of a dragged map into the Remote
Container map.

* Remote Container: When Position is set to WPosition, you must drag the container
that holds the WPosition Plugin to this field in order to get the information.

« Map Center Longitude/Latitude: When Position is set to User, the information
will be defined in these two parameters

* Local Scale: Sets the scale parameter for the map.

*« Animate to Target: When enabled, the map will be animated whenever the
longitude/latitude value changes. This is either with a fixed define time or, when
using length time, it will be relative to the distance it has to travel to the new value.

¢ Animation Time: Value in fields for the animation to target.

* Shared Memory: When set to Master it will write the longitude/latitude values to
the Shared memory variable defined in the Identifier field. When set to Client it will
listen to the values in the shared memory key.

¢ Type: The type of shared memory to use (for more information on Shared Memory
see the Viz Artist User’s Guide):

* Global: Scene.Map: This is the map local to the current Scene. Every Scene has
one map that can be used to exchange data among the scripts in the Scene.

* Scene: System.Map: The system-wide map allows for data sharing among the
Scenes currently loaded into memory.

¢ Distributed: VizCommunication.Map: A distributed map that enables data
sharing among the computers connected to one Viz Graphic Hub.

* Identifier: Identifier to be used for shared memory communication.

13.8

CWMClient

CWMClient

CHMClient

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The CWMClient plugin is the main plugin in the Viz World Client (WoC). The CWMClient
plugin launches the World Map Editor (WME) and retrieves the map from the Viz World
Server (WoS) after the user has applied the changes to the map in WME.

Note: The plugin uses the VizMapsManager.dll to connect to the Viz World Server
machine configured in Viz Config page.

The CWMClient plugin has various different plugin editor views and buttons:

e Texture

e Labels

e 3D Objects

Copyright © 2016 Vizrt Page 205


http://docs.vizrt.com/viz-artist.html

Viz World Client and Server User’s Guide

Miscellaneous
Imagery
Buttons
Search Order

13.8.1 Texture

The texture section defines the geo map image parameters:

Page 206

Lock Aspect Ratio: Effects texture height and texture width parameters. When
enabled (On) any change in the texture height or width will affect both parameters.
When disabled (Off), each parameter is controlled separately.

Texture Size: Presets for texture sizes.

* Auto Adjust To Globe: If texture size is other than manual, this parameter
defines whether the texture size will be modified when mapped on a globe. This
option is used when displaying maps that are close to Earth’s poles.

Adjust for Globe (advanced): Adjusts a 2D selection in WME converting it to 3D.

Adjust for Zoom (advanced): Normally the selected map is zoomed in by
approximately 10 percent in order to avoid the fade area. By enabling Adjust for
Zoom a wider map than the selected one is fetched such that the final selection
better equals the map selected in WME.

Texture Width: Defines the number of pixels in the map width. When aspect ratio
is locked, changing the texture width will automatically change the Texture Height
parameter.

Texture Height: Defines the number of pixels in the map height. When aspect ratio
is locked, changing the texture width will automatically change the Texture Width
parameter.

Texture Compression: Sets the compression level for the texture (DTX5 is the
highest compression level, i.e. less texture quality).

Texture Quality:
* Linear: Use the same image resolution in the entire zoom range.

¢« Mipmap: Change resolution according to the distance from the image (managed
automatically in Viz Artist).

Texture Anisotropic Filter: (Off/2x/4x/8x/16x) Turn on the relevant anisotropic in
the image on the same container with CWMClient (similar to Mipmap, above).

Copyright © 2016 Vizrt



Viz World Client and Server User’s Guide

13.8.2 Labels

3D Designs & Holder: Defines the labels usage and behavior over the map, and
has three available options:

Disabled: Labels produced by the Viz World Server will be displayed as part of
the map texture. No manual definitions are required.

Local: Requires you to manually define the 3D Designs & Holder path (e.g. On
Map Designs: Vizrt/VizWorld/GlobalDesigns/Regions/)

Global: Enables you to use a global design defined by the 3D Map Setting Plugin
scene plugin.

IMPORTANT! Global labels will not work with on screen labels so you will still
need to configure them (if needed).

Local and Global

CWMClient Plugin (13.0.0)

|7 Wiz Wiarld Map Editor{WME) | Refresh Map || Rfresh Map (Force New) | WME+F |
=

Visible Filter: Select All to build all labels defined in WoC. Select Visible to build
only labels that are shown on the selected map.

Backslash as New Line: When Enabled you can add labels with more than one
line typing backslash “\" as a separator for each new line.

Labels Type: Defines the source of the label designs. Available options are
Dynamic and Scene. Selecting Viz-DB or Scene defines where the label designs are
stored.

Dynamic: Dynamically creates new labels based on label designs created in

the scene itself or fetched from the Viz Graphic Hub (Viz DB). All designs are
referenced by the On-Map Designs placeholder. When selecting labels in the

Map Editor (WME) all your labels will be dynamically added underneath the
CWMClient's container and receive the correct label type (provided it is defined
by your label design). Note that this approach does not allow you to use control
plugins. As the number of labels are dynamic this approach does not allow you to
use control plugins.

Static: Unlike the Dynamic label type, Static will not create new labels
underneath the CWMClient's container, but will instead use the number of labels
already defined by the designer (achieved by adding copies of the label designs
as sub containers of the CWMClient’s container). As the number of labels and
label types are static this approach allows you to use control plugins.

Viz-DB: Label source is a merged object from the Viz objects library, containing
the label designs.

Scene: Label source is a group container in the scene hierarchy, containing the
label designs.
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On Map Designs: (Local only). Defines the source of the labels that are displayed
on the map. When Viz DB (Viz Graphic Hub) is selected, define the path to a merged
object, containing the label designs, in Viz object library. When Scene is selected,
drag a group container with the label designs to the container place holder.

On Screen Designs: Defines the source of the labels that are displayed on a plane
in front of the screen. When Viz DB is selected, define the path to a merged object,
containing the label designs, in Viz object library. When Scene is selected, drag a
group container with the label designs to the container place holder.

On Map Holder: (Local only). This parameter is a container used for grouping all
the generated labels on the map. When a map with labels is selected, the plugin
will duplicate the label designs and create the labels. The duplicated labels will be
placed under the On Map Holder container.

On Screen Holder: (Local only). This parameter is a container used for grouping
all the on screen labels (labels that are not geo-referenced) used in the map. When
a map with on screen labels is used and Viz is selected, the on screen label designs
will be copied to the holder container and the label information will be sent to the
copied designs.

Note: Back slash (\) in label names will be treated as a new line (carriage return).

3D Objects

The 3D Objects section defines the other 3D properties of objects on the map, other
than labels (regions, roads and so on).

3D Objects and Regions

CWMClient Plugin (13.0.0)

|7 iz Wiarld Map Editor{WME) || Riefresh Map || Rafresh Map (Force New) | WME+F |
[ Testtire |

30 Designs & Holder

3D Designs & Holder: Defines whether the regions will be part of the received
texture or 3D objects. When set to Disabled, regions will be displayed as part of the
texture. When set to Local or Global the Viz-DB and Scene parameters are made
available. Also, when set to Global, the global region designs and holder will be used
to create the O Map 3D region objects. On Screen parameters will be enabled to
define the on screen region designs and holder.

Note: The global designs and holder are defined in the 3D Map Setting Plugin
scene plugin.

* Viz-DB: Sets region source to be a merged object from the Viz objects library,
containing the region designs.

¢ Scene: Sets region source to be a group container in the scene hierarchy,
containing the region designs.

Copyright © 2016 Vizrt



Viz World Client and Server User’s Guide

On Map Designs: Defines the source of the 3D Region objects that are displayed
on the map. When Viz DB is selected, define the path to a merged object, containing
the region designs, in Viz object library. When Scene is selected, drag a group
container with the region designs to the container place holder.

On Screen Designs: Defines the source of the 3D Region objects that are
displayed on a plane in front of the screen. When Viz DB is selected, define the path
to a merged object, containing the region designs, in Viz object library. When Scene
is selected, drag a group container with the region designs to the container place
holder.

On Map Holder: This parameter is a container used for grouping all the generated
3DRegion objects on the map. When a map with regions is selected, the plugin

will duplicate the region designs and create the 3D Region objects. The duplicated
regions will be placed under the On Map Holder container.

On Screen Holder: This parameter is a container used for grouping all the on
screen regions (regions that are not geo-referenced) used in the map. When a map
with on screen regions is used and Viz is selected, the on screen region designs
will be copied to the holder container and the region information will be sent to the
copied designs.

3D Objects and Borders

CWMClient Plugin (13.0.0)

I

[ sbels | [PUSDTOBjEEE™Y| Miscellaneous || Imagery

[ Regions  [POWBGRERERRN|  Shapes || Rosds || Advanced

|7 Disabled | [GE ] Giokal
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On Map D

On Map Holder

3D Designs & Holder: Defines whether the border line will be part of the received
texture or drawn as a 3D object. When set to Disabled, borders will be displayed as
part of the map texture. When set to Local the Viz-DB and Scene parameters are
made available and the shapes added in the WME will be drawn as a 3D object by
Viz. When set to Global, the global border designs and holder will be used to create
the 3D border objects.

Note: The global designs and holder are defined in the 3D Map Setting Plugin
scene plugin.

Recursive level: Sets the filter level for border details. If None is selected, all
border data is drawn. If Region is selected, Sub Region data will not be drawn. If
Country is selected, region and sub-region borders will not be drawn.

e Viz-DB: Sets the border source to be a merged object from Viz objects library,
containing the border designs.

¢ Scene: Sets the border source to be a group container in the scene hierarchy,
containing the border designs.

On Map Designs: Defines the source of the 3D Line objects that are displayed on
the map. When Viz DB is selected, define the path to a merged object, containing
the border designs, in Viz object library. When Scene is selected, drag a group
container with the border designs to the container place holder.

On Map Holder: This parameter is a container used for grouping all the generated
3DBorder objects on the map. When a map with borders is selected, the plugin will

Copyright © 2016 Vizrt Page 209



Viz World Client and Server User’s Guide

duplicate the border designs and create the 3D Line objects. The duplicated borders
will be placed under the On Map Holder container.

3D Objects and Shapes

ugin (13.0.0)

|7 iz Wirld Fap Editor(WHE) | Rsfresh Hap | Rafresh ap (Force New) | e
[~ Testure | Lsbels | SDOBEEET] Wiscelaneous | Tmagery
[ Regions | Borders  [OUSREREETTY|  moads | Advanced

+ 3D Designs & Holder: Defines whether the shapes will be part of the received
texture or drawn as a 3D object. When set to Disabled, shapes will be displayed as
part of the map texture. When set to Enabled the Viz-DB and Scene parameters are
made available and the shapes added in the WME will be drawn as a 3D object by
Viz.When set to Global, the global shape designs and holder will be used to create
the 3D shape objects.

Note: The global designs and holder are defined in the 3D Map Setting Plugin
scene plugin.

* Viz-DB: Sets the shape source to be a merged object from Viz objects library,
containing the shape designs.

¢ Scene: Sets the shape source to be a group container in the scene hierarchy,
containing the shape designs.

¢ On Map Line Designs: Enables the user to add vector line data to the map. Either
by using the draw option in the WME (Add Shape), or from selecting an existing line
data (e.qg. street).

¢ On Map Area Designs: Vector area designs. This option has support for the area
draw option in the WME.

¢ On Map Line Holder: Defines the source of the 3D Region objects that are
displayed on the map. When Viz DB is selected, define the path to a merged object,
containing the shape designs, in Viz object library. When Scene is selected, drag a
group container with the shape designs to the container place holder.

* On Map Area Holder: This parameter is a container used for grouping all the
generated 3DShape objects on the map. When a map with shapes is selected,
the plugin will duplicate the shape designs and create the 3D Region objects. The
duplicated shapes will be placed under the On Map Holder container.

Page 210 Copyright © 2016 Vizrt



Viz World Client and Server User’s Guide

3D Objects and Roads

+ 3D Roads: Defines whether the road data will be drawn on the map and the way
the roads will be drawn. Available options are None, Crop To Map and All.

* None: The roads data will not be available to be drawn on the map.

* Crop To Map: Enables the Visibility Filter and Visibility Factor (%) settings,
limiting the roads data.

¢ All: Loads the selected road data.
e Labels Only: only the road labels will be drawn.

* Crop Visibility Filter: Sets the highest level of road type that will be cropped.
Available options are Freeway, Primary, Main, Secondary and Other.

* Freeway: Crops all roads rated as freeways and lower (that is all roads) using
the Visibility Factor.

¢ Primary: Crops all roads rated as primary roads and lower (that is primary,
main, secondary and other) using the Visibility Factor.

¢ Main: Crops all roads rated as main roads and lower (that is main, secondary
and other) using the Visibility Factor.

* Secondary: Crops all roads rated as secondary roads and lower (that is
secondary and other) using the Visibility Factor.

¢ Other: Crops all roads rated as other roads (that is none of the above) using the
Visibility Factor.

* Visibility Factor (%): Defines the cropping area of the roads on the map. 100%
means the roads will be cropped at the map edges and cover the entire map area.
A lower value will cause the selected road types in the Visibility Filter to be cropped
(evenly from the map edges).

* Simplify Threshold (Meters): Applies a simplifying algorithm on road data. The
number represents the biggest allowed error.

¢ Ignore Filter: Disables creation of roads that are lower or equal to the selection (i.e.
Freeway, Primary, Main, Secondary, and Other).

*« Roads Mode: Applies one set of road design for all roads (Global), or uses a design
per CWMClient (Design).

¢ Source: Sets the source for road designs. Available options are Viz-DB and
Scene. Viz-DB sets road source to be a merged object from Viz objects library,
containing the road designs. Scene sets road source to be a group container in
the scene hierarchy, containing the road designs.

* On-Map Designs: Defines the source of the 3D Roads objects that are displayed
on the map. When Viz-DB is selected, define the path to a merged object,
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containing the road designs, in Viz object library. When Scene is selected, drag a
group container with the road designs to the container place holder.

¢ On Map Holder: This parameter is a container used for grouping all the
generated 3D Roads objects on the map. When a map with roads is selected,
the plugin will duplicate the road designs and create the 3D Roads objects. The
duplicated roads will be placed under the On Map Holder container.

3D Objects and Advanced

WMClient Plugin (14.0.0
mmmm

" Tedire [T isbels T PSTIOBEEE | Wiscellsnsous |
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Regions Visible Filter: Defines whether all the selected regions will be created
(when using 3D regions) or only the regions that are visible on the selected map.

Sort Regions: Defines how the labels and 3D Objects will be duplicated in the
scene tree.

¢ No: Creates the duplicated labels and 3D objects in the scene tree grouped by
geographic levels that is for each country, first the country, then the regions,
then the sub regions, and so on.

* Ascending: Creates the duplicated labels and 3D objects created in the scene
tree sorted by ascending geographic levels, that is first the sub regions, then the
regions, then the country container.

* Descending: Creates the duplicated labels and 3D objects in the scene tree
sorted by descending geographic levels, that is first the sub regions, then the
regions, then the country container.

Copy Map To Region: Sets if a map of the region will be applied to the 3D Region
object.

Auto Borders: Defines whether borders will be added automatically to the map
and the level of the borders:

e Off: No borders will be added.

¢ Highest: Draws country borders for the selected area (or region borders if only a
region was selected).

* Intermediate: Draws region borders (or sub-regions if only a region was
selected).

¢ Lowest: Draws sub-region borders.

Auto Regions: Automatically adds region designs based on location.
* Off: No regions will be added.

¢ On Screen: Automatically adds region on screen,

¢ On Map: Automatically adds region on map.

Auto Regions Level: The level which should be created when creating auto 3D
Regions.

Set 3D Models: Determines whether or not the 3D models plugin will be called to
generate 3D buildings in the selected map area.
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13.8.4

Miscellaneous

o)
Viz World Map Editor{WME) Refrash M!D Refresh Map (Force New) WME (Classic)
Labels 30 Objects

The Miscellaneous section includes additional general parameters of the map.

WME Aspect- Defines the aspect of the map in the WME window:

* Image: When enabled, the aspect is set by the texture size defined in the
texture screen of the CWMClient plugin.

* User: When enabled, the user can manually set the aspect. When selected, the
Aspect parameter will be enabled. The aspect is modified by changing the aspect
value.

+ Camera: Sets the aspect to be the same as the current camera in use. Selecting
this option will therefore open the WME in the same aspect as the current
camera.

* Auto: When enabled, the plugin will look for a Navigator plugin in the hierarchy,
above the CWMClient plugin. If a Navigator is found the camera aspect will be
used. If the Navigator plugin was not found, the image aspect will be used.

Freeze: When enabled (On), the map retrieved from the server will be saved as an
image in the Viz image library and used as a static geo-referenced image. All map
dynamic parameters will be hidden.

Obey Hops Manager: When turned ON, all the settings of labels/regions/3D
Objects will be defined in the Hop Manager Plugin. When set to OFF these settings
will be local to this CWMClient Plugin.

Transition Logic Mode: When set to Off, the plugin will request the map from the
server or cache when the scene is loading. If Transition Logic Mode is enabled (On),
the scene will load without requesting a map since the control application (e.g. Viz
Trio or another external application) will send the parameters for a map to use. This
option saves time during initialization of scenes using a dynamic map.

Lock Project & Style: Will lock the CWMClient Plugin to only use the selected TPL
and style sheet and ignore any changes made from the WME.

Is Linked to Master Map: When the Is Linked to Master Map parameter is set the
CWMClient (slave) is controlled by another CWMClient (master). To control another
CWMClient, drag and drop a container with a CWMClient (slave) plugin onto the
CWMClient (master) plugins’ Linked Map placeholder (see next parameter).

Is Linked To Master Map
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¢ Linked Map: When set, this parameter is a container placeholder that defines
the map (slave) that will be linked to the current map (master). The linked map is
another CWMClient container that will receive the same map as the map selected
from the WME.

* Linked Map Size: Defines the size of the linked map as a percentage from the
main map, that is if 50% is defined the linked map will show half of the area defined
in the main map.

* Linked Type (advanced): Should the link type only include bounding box or should
it include all the data (regions, labels etc.).

¢ Shared Memory Link: Defines which is the master (source) and client (target)
when the same Shared Memory Identifier is used.

+« Shared Memory Type: Defines the accessibility of the shared memory.

¢ Global: Memory is accessible to all scenes currently loaded in memory. This is
useful when working with Transition Logic scenes where your Viz World map can
be one scene and the locator a different one and data can easily be transferred
between the two.

¢ Scene: Memory is only accessible locally and to the current scene. Every scene
has one shared memory map that can be used to exchange data among the
scripts in the scene.

¢ Distributed: Memory is accessible to all computers connected to one Viz
Graphic Hub.

+« Shared Memory ldentifier: Defines the identifier for the shared memory map.

* Url Images: Container holding the Url Image manager which will be invoked when
the map changes.

* Always Fetch Terrain Data: When enabled the plugin will always fetch terrain
data.

* Terrain Tessellation Locked: Appears when a C3DTerrain plugin is combined with
the CWMClient plugin.

¢ Tessellation is the terrain resolution, which is the number of polygons used to
build the terrain object. The higher the tessellation, the more detailed the terrain
will be. Use the Width Tessellation and Height Tessellation parameters to fine
tune the quality versus the performance of the scene.

* When set to On, only the Width Tessellation parameter can be changed; hence,
the setting will apply for both Width and Height.

¢ When set to Off, the parameters can be set individually.

13.8.5 Imagery

The Imagery section includes multiple imagery configuration options.
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13.8.6

13.8.7

« Data Source: Defines the source of the imagery. Available options are Bing
(Mlicrosoft Bing server), CMR (Curious Multi-Resolution imagery), Digital Globe (DG)
or Blom.

When enabled (On) additional parameters are made available, and the WME button
is disabled.

« Data Resolution: Available resolutions in pixels (i.e. width).
« Temp Folder: Sets a temporary download folder.

« Data Type: (Visible when Data Source is Bing). Available data types are satellite,
map or a combined type of imagery.

¢ CMR: (Visible when Data Source is CMR). Defines a CMR file to be used as a
source for the map.

+ Digital Globe Projection: (Visible when Data Source is DG). Allows you to
select the DG project. Currently available as Mercator and Unprojected.

* Longitude: Sets the map longitude.

¢ Latitude: Sets the map Latitude.

¢ CMR Units: Sets the Curious-Multi Resolution imagery’s units to degrees,
kilometers, miles or nautical miles.

* Width (deg): Sets the area width in degrees, kilometers, miles or nautical miles.

e Status: Displays the current CMR operation status.

* Get Image: Retrieves the defined imagery (of the area defined by Lon, Lat and
Width parameters).

¢ Center Longitude Latitude: When clicked, the CMR will be created with the
longitude and latitude values as the center of the CMR.

Note: The longitude and latitude values must be within the CMR area. If the
values are not within the CMR area no map will be created.

Buttons
The following default buttons apply to the plugin as a whole.

¢ Viz World Map Editor (WME): Opens the WME. WME connects to Viz World Server
that is defined in Viz Config, and retrieves the current map or opens the defined
default project if no map exists (fresh plugin instance).

* Refresh Map: Re-draws the map and refreshes the related Viz objects using Viz
World Client (WoC)plugins in the scene hierarchy. For example if a label design has
been changed in Viz Artist, clicking Refresh Map will redraw the map with the new
label design without opening WME.

* Refresh Map (Force New): Re-creates the map on the server and saves it to
the cache. This operation will force the map creation, even if the map exists in the
cache folder.

« WME (Classic): Will open WME Classic interface instead of the new WME

Search Order

The CWMClient can hold designs for labels and 3D objects such as regions, borders and
shapes. As the designs can be stored in the scene or on the Viz Graphic Hub (i.e. Viz-
DB) you need to understand the order in which these designs are searched for.

The following rules apply when searching for designs under the Design holders.
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Example | - Add Label Map Tool Bar

]

=
Aam1o>
- EFE

. Traffic_Accident

€ Traffic_Construction
© Traffic_Incident

M Traffic_Slippery_Road

A Traffic Cone

If, when using the World Map Editor or Map Editor Classic, you add a label and set the
style to be Traffic_Accident, the search order will be based on the following rules:

1. Search the Scene - that may have multiple designs where each design has a name
that corresponds to its design.

2. Search Viz Graphic Hub (i.e. Viz-DB) - that may have multiple designs stored in a
design folder where each design is a merged object with a name that corresponds
to the design.

First the Scene design holder is searched (if used) in the following order:

1. By Style
2. By Design (Point_Label)
3. By Default Design (Default_Design)

This means that it will search for and use:

1. Traffic_Accident, and if not found then
2. Point_Label, and if not found then
3. Default_Design

If none were found, the Viz-DB design holder is searched in the same order.

Example Il - Add label Search Tab

Sydney : Matural Earth l » I.

¥ Filter

B NEW/SOUTHIWALES
1 Minor Towns o

B Other

| Sydney, Australia

> Web Results: 6

If, when using the World Map Editor or Map Editor Classic, you search for and add a
Town with more than 1 million (Towns > 1m) inhabitants as a label to the map and
for the CWMClient set the style to be “Bigtown” the search order will be based on the
following rules:

1. Search by style only if different than Place
2. By detail (Capital / Town_1m / Town_100k / Town_10k / Town_1k / Town)
3. By default town design (Default_Town)
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4. By style (if = Place)
5. By default design (Default_Design)

This means that a search will search for and use:

Bigtown, and if not found then
Town_1m, and if not found then
Default_Town, and if not found then
Place,

u ke w N e

Default_Design

Naming conventions

Note: Names using letters other than [a-z A-Z 0-9] will be converted to _
(underscore).

type:

1 Capital

2 Town 1M

3. Town 100K
4. Town 10K
5 Town 1K

6 Town

* Search by style only if different than Place
* By detail (Capital / Town_1m / Town_100k / Town_10k / Town_1k / Town)
* By default town design (Default_Town)
* By style (if = Place)
* By default design (Default_Design)
7. Region:
* By style
* By region level (Country / Region / Sub_Region)
* By detail (Region)
* By default design (Default_Design)
8. Point Label:
* By style
* By design (Point_Label)
* By default design (Default_Design)
9. None of the above:
* Search by style only if different than Place
* By default design (Default_Design)
10. All Others:
e Search by style only if different than Place
* By detail (Region / Region_Name / River_Name ...)
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* By style (if = Place)
* By default design (Default_Design)

List of details name:

¢ Capital

e Town_1m

* Town_100k

* Town_10k

* Town_lk

e Town

» Tourist_Attraction

* Reserve_Or_Park

* Region_Name

¢ Physical Area_Name
* Physical_Water_Name
* River_Name

* Mountain_Name

* Label

* Street Address

* Intersection

» Traffic_Incident

* Traffic_Accident

» Traffic_Construction
» Traffic_Speed

* Point_Label

* None Of The Above
* Region

13.9

Page 218

Focus On Map

FocusCinMa

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The FocusOnMap plugin is used to create a single “hop” (high resolution map over

a large referencing map) without using a navigator plugin and with no animation.
This plugin is used when creating a large map (reference map) with 3DObjects over it
(roads, shapes, and so on). It enables the user to display a high resolution area of the
large map without recreating the 3DObjects when changing the displayed area.

The FocusOnMap plugin has three different tabs:

e Position : Enables the parameters for the requested map area where the Position
Source defines the source of the viewed area.

Copyright © 2016 Vizrt



Viz World Client and Server User’s Guide

¢ Camera : Defines the camera parameters such as camera number and minimal and
maximum distance of the camera from the map.

* Labels : Defines label parameters for how labels should be displayed.

13.9.1 Position

* Map: Fits the selected map in the FocusOnMap container to the screen according to
the Fit To Screen By selection.

Fit To Screen By: Sets the map attribute that will be used to fit the map to the
screen: Width, Height, Min (the minimal value of the map’s width and height),
Max (the maximal value of the map’s width and height), Average (the average of
the map’s width and height).

Longitude Offset: Sets a longitude offset from the center of the selected map
Latitude Offset: Sets a latitude offset from the center of the selected map
Distance Offset: Sets a distance offset from the center of the selected map
Pan: Sets a pan value for the camera.

Tilt: Sets a tilt value for the camera.

¢ Absolute: Enables the user to manually set the parameters for the viewed area:

Longitude: Sets the Longitude of the viewed area (center).
Latitude: Sets the Latitude of the viewed area (center).

Distance offset: Sets a fixed distance offset from the selected map.
Distance: Sets a distance from the map.

Diameter: Sets the desired view as Diameter (and not distance).
Pan: Sets a pan value for the camera.

Tilt: Sets a tilt value for the camera.

* Geometry: The selected map in the FocusOnMap container will be fitted to the
screen according to the Fit To Screen By selection.

Fit To Screen By: Select the 3DRegion attribute that will be used to fit the map
to the screen: Width, Height, Min (the minimal value of the map’s width and
height), Max (the maximal value of the map’s width and height), Average (the
average of the map’s width and height).

Longitude Offset: Sets a longitude offset from the center of the selected
3DRegion.

Latitude Offset: Sets a latitude offset from the center of the selected 3DRegion.
Distance Offset: Sets a distance offset from the center of the selected 3DRegion.
Pan: Sets a pan value for the camera.

Tilt: Sets a tilt value for the camera.
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Note: Pan and Tilt parameters will be disabled unless the Pan & Tilt Animation
parameter in the Navigator plugin is enabled (On).

* Geometry Offset X/Y: Offset from the true position of the geometry in
geometry units.

* Min/Max Distance: Sets the min/max distance from the camera to the map.

Camera

FocusOnMap Plugin (14.0.0)

Camera

Navigation Method

Clipping Plane Control

Camera: Defines the camera number that will be affected by the position
parameters.

Navigation Method: Allows you to select whether the camera or the container
should be moved when a map changes position. If you select camera, the camera
will move when you reposition the map, potentially moving other objects out of
frame. If you select container, you will move the container instead of the camera
keeping other objects in view as the camera will be still. In other words you are
moving the base map instead of the camera in order to see other parts of the map.
Setting it to container also means you do not have to use the front layer using two
cameras in order to achieve the same effect as when moving the container. Also
you will not have to reload borders and other elements on the map as it can be
preloaded once for the base map. Note that you can only do this with a flat map
(not a globe).

Clipping Plane Control: Defines the selected camera’s clipping plane. Static
(Viz) draws the objects within the clipping plane values defined in Viz. For Viz 3.x
see Scene Settings->Renderer->Camera Clipping Plane. FocusOnMap adjusts
the clipping plane values according to the camera position. This is automatically
done by the Focus On Map plugin based on the Near Distance and Far Distance
parameters.

* Near distance (%): Defines the minimal distance of the camera from the map.
¢ Far Distance (%): Defines the maximal distance of the camera from the map.

If Position Source is set to Absolute then the parameter Diameter can also be set
here.

If Position Source is set to Geometry then the parameters Geometry Offset X/Y
and Min/Max Distance can also be set here.
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13.9.3 Labels
FocusOnMap Plugin (14.0.0)
Labels
Label Camera
[Getmap [ 7"
¢ Labels: Defines how the labels will be displayed:
¢ Overlay: Labels are displayed as a layer on the screen not affected by the
camera movement when a new area is selected.
¢ On Map: Labels are displayed on the map, moving with the map as the selected
area is changed.
* Label Camera: Defines the camera number used for displaying the on screen
labels.
e Get Map: When clicked, the camera will jump to the defined area.
¢ If Position Source is set to Absolute then the parameter Diameter can also be set
here.
e If Position Source is set to Geometry then the parameters Geometry Offset X/Y
and Min/Max Distance can also be set here.
13.10 GeoDataReader

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps-Adv

This plugin gets a geodata stream or file (.shp/.kml/.kmz/.gdb/.mdb) and inserts the
data into Viz. The plugin can use local scene containers or the global ones that were
defined in the 3DMapSetting manager for the design and data. The shapes can be
grouped into different containers, by their geometry, or grouped together in one
container.

The names of the available services can be found inside the Name tag under
FeatureType:

<FeatureType>
<Name>glacier outlines</Name>

</FeatureType>

For example:

http://nsidc.org/cgi-bin/atlas_south?
service=WFS&version=1.1.0&request=GetFeature&stypename=glacier outlines
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Properties

eader Plugin (14.1.0)

Source Type: Sets whether the source is a local file or a web stream
<Geometry> Design & Holder:

« Disable: Do not add this type

* Local: The design and the holder containers are local

¢ Global: The design will be taken from the Graphic Hub

Design Path: Path to a design folder that is placed inside the Graphic Hub

Style Field Name: The name of the field that contains the style name that each
feature has

<Geometry> split:

« Disabled: All features will be grouped in one container

* On: Each feature will have its own container

¢ By Style: The features will be grouped by the style name
Clear existing features on read:

* Disable: The features will be added on each Read command

e Enable: The container that holds the sources' features will be erased, and then
the new features will be added

Example

Mag 5.6

13.11
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The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The GeoText plugin is used to display the longitude and latitude values received from a
variety of sources. The geographic data is displayed in two text objects (or one) defined
by the longitude and latitude containers.

Properties

The Source defines the source of the geographic data that will be displayed in the
defined containers under the Containers tab.

e User: Sets the value manually in the Compass, Longitude and Latitude parameters
for the position and range values. The Compass, Longitude and Latitude parameters
will be enabled only when Position is set to User.

e WQPosition: The defined Containers display the values received from the World
Position plugin on the same container as the GeoText plugin.

* Navigator: The GeoText plugin receives the geographic data from the Navigator
plugin in the scene. The received data from the Navigator plugin is the location of
the center of the Navigator point of view and the difference between the edges of
the current Navigator map. The GeoText plugin also has placeholders (all requiring a
running Viz World server) for defining the administration levels:

¢ Country: Gets the current Country

* Admin 1: Gets the current administration level 1 (e.g. Region)
¢ Admin 2: Gets the current administration level 2 (e.g. Town)

¢ Location: Gets the lowest administration level (e.g. Place)

* WPoint: The defined Containers display the value received from the WPoint plugin
on the same container as the GeoText plugin.

Note: WPoint is a Viz Weather plugin which is not covered in this manual.

¢ Map: When placed on a map container, the GeoText plugin will send the center of
the map data to the Longitude and Latitude containers and the difference between
the edges of the map to the range containers.

¢ Line: When placed on a 3DLine container, the GeoText plugin will send the center of
the line data to the defined containers in the Containers tab.

Position

Copyright © 2016 Vizrt Page 223



Page 224

Viz World Client and Server User’s Guide

Position: Defines the position text format. Select the required format from the
Degrees Format list.

E

ddimmss W/E

Range: Defines the range text format. Select the units for the displayed values
and select the required format from the Degrees Format list. If Kilometers, Miles or
Nautical Miles are selected, Dot or Comma can be selected as a separator with a
fixed decimal point.

ext Plugin (14.0.0)

[EErT| Weosition || Navigator Wroint map [ Line
[ Posten | RGN Cortner |
0.0 ]

Miles Neutical Miles

Containers: defines the font objects that will display the longitude and latitude
values of the position and range:

* Longitude Position: When set, this parameter is linked to the text object
displaying the longitude position data received from the GeoText plugin.

¢ Latitude Position: When set, this parameter is linked to the text object
displaying the latitude position data received from the GeoText plugin.

« Compass: When set, this parameter is linked to an object that will be rotated to
show the North (based on navigator direction).

* Longitude Range: When set, this parameter is linked to the text object
displaying the longitude range data received from the GeoText plugin.

* Latitude Position: When set, this parameter is linked to the text object
displaying the latitude range data received from the GeoText plugin.

* Legend: When set, view width and view height values will be scales based on
the object used for the legend.
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* Length: When set, this parameter is linked to the text object displaying the
length of the line object as received from the GeoText plugin.

13.12 Globe Zoom
pezoen
R
The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps-Obs.
IMPORTANT! This plugin is included in World Map Editor package for
compatibility reasons, and is not maintained. It is recommended to use the
Navigator and NavFinder plugins for designing new scenes.
13.13 Hoplt
a
This is a utility plugin which connects the specific design with a hop. It is used when the
designs (e.qg. labels, regions etc) were not generated from the hop you want to connect
them to (or from no hop at all).
Hoplt Plugin (14.0.0) i
Hop Mode Fl!I!lll!!!.!IIIIIIIIIII.
Hop Point |_
Hop-1
Hop Point Hop-2
[Update]
This connection can either be done using manual mode or automatic (based on
searching all hops locations and connecting to the one which is closest).
The 3 plugins that are influenced are Hop Sync, 2D Label and Label It.
13.14 Hop Sync
H c

|
fine.
HopSyne

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The HopSync plugin is used to coordinate between labels and other 3D objects with
built-in animations and hop animations. The HopSync plugin is applied to the same
container as the Label It plugin, or to a container above the label design containers but
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below the top design container which will be used to create the label merged object.
To use HopSync plugin, the label designs must include a merged object containing the
design. The plugin defines a point in the label animation that will be matched with the
hop point in the Navigator animation.

Properties

HopSynec Plugin (14.0.0)
Director
Animation Start Time (Seconds Before Hop Point
Order offset

ion Order Offset Time (Seconds Extra)

[ SEEFighiight Time |

* Director: Defines to which director the label animation will be copied to.

* Navigator: Copies the label animation to the Navigator director. This option is
used when the label animation should end before or at the time the Navigator
animation has reached a hop point. When the navigator director reaches a hop
point and Continue is pressed (or pause time will end) the label animation will
also continue, causing the label to disappear.

* Hop Director: Copies the label animation to a new director. This option is used
when the label animation should end after the hops animation has stopped (or
paused). If the label animation will be copied to the Navigator director, the label
animation will stop before the entire label was revealed.

¢ Separate: Copies the label animation to a new director (not the Hop or
Navigator director) in order to give you more options. Note that it will not
perform animation offsets.

* Animation Start Time: Defines the point in the label animation that will be
matched to the hop point in the Navigator animation. The value is set by typing in a
number (in seconds), or clicking and sliding the mouse over the parameter until the
animation point is reached. Another option is to use the Set Highlight Time button.
Play the animation and when reaching the requested point in the label animation,
stop and click the Set Highlight Time. The current label animation value will be
copied to the Animation Start Time field.

* Order Offset: Enable/disable an offset between the animation of the objects.

¢ Animation Order Offset Time: How much time to offset the animation, e.g when
setting this value to 1.2, the 3rd detail animation will start after 2.4 seconds after
the animation has reached the destination.

13.15
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Hops Manager

]

weldt

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps-Man.

The Hops Manager plugin is used to control from one interface multiple instances of
several plugins. The plugin should only be used if all parameters for the control plugins
should be the same. If for any reason different values are needed the plugin should not
be used.
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The plugin controls the CWMClient plugin, Map Pyramid plugin and NavFinder plugin;
however, only instances which are part of a hop will be controlled. The plugin has two
main options; global values and hops.

Properties

Global values are used in order to update values globally on all control plugins.

HapsManager Plugin

e B
IO Hap yramid |

Wiz World Map Editor{WME) WME (Classic) | Refresh Map Refresh Map (Force New)
I Temure |  labels || 30 Objecs 30 Roads Miscallaneous
PEEREspais | spiewe || mDTz | HDIoso |

[ Disabled  |OREGRON] width | Aversoe

=l
— =l - .
PHERE| DxTi{Opaque) || Obsolete | DXTS(Alpha)
T Gner R

Refresh AN Maps Add Destinstion Add Absalute Destination Rermove Destination

Under the global values tab all parameters are the same as those found in the actual
plugins you want to control. For more information see:
» CWMClient

e Map Pyramid
¢ NavFinder

Hops are used to jump to a specific hop. From this tab you can select and refresh a
map and fine tune NavFinder’s pan values.

HopsManager Plugin

Stian
Fit To Screen By [Twidth [ Height |[PUMm| " Max | Average
Longitude Offs 0.0 i f |

Latitude Offset

Distance off:

Geometry Off:

Geometry C

giny Manag l_
" Refresh Al Maps P o3 [ %ml To Hops

XML Hops Data

¢ Multi Hop: If the Multihop button is pressed, The Multihop Editor in World Map
Editor will be opened (see Enable the Multihop Editor).

13.16 KML Reader

e
KMLReader
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The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps-Man.

The KMLReader plugin is used to add objects from KML files to the scene. KML files are
XML formatted files containing information about geographic objects: labels, shapes,
lines. The KML Reader plugin reads the files and generates objects according to the
file's content.

General

KMLReader Plugin (14.0.0)

Hop Control Proxy
KML File

| ||
Line Designs & Holder ’W'TE
Line Split of | on  ™EysmET|
Connect Labels Into Line ET

BT Enabled
Ider Disabled [ geal | Global |

Label Designs

Label Holder

¢ KML File: Defines the path to the KML file.
* Line Designs & Holder: Defines the graphic designs for lines.
+ Disabled: No line designs are used. Lines found in the file will not be drawn.

* Local: Specific line design containers and holder will be used. When selected
additional parameters will be enabled: Line Designs and Line Holder. Assign the
required designs and holder to the plugin.

¢ Global: The global line designs and holder container will be used. The global
designs and holder are defined in the 3D Map Setting Plugin plugin.

¢ Line Split:
¢ Off: all lines go into one container.
¢ On: every line gets its own container.
¢ By style: lines that share a style, share a container
e Connect Labels Into Line: Create a line by connecting all labels into a line

* Update on Load: Sets whether or not the data will be read when the scene is
loaded.

* Label Designs & Holder: Defines the graphic designs for labels.
« Disabled: No label designs are used. Labels found in the file will not be drawn.

¢ Local: Specific label design containers and holder will be used. When selected
additional parameters will be enabled: Label Designs and Label Holder. Assign
the required designs and holder to the plugin.

¢ Global: The global label designs and holder container will be used. The global
designs and holder are defined in the 3D Map Setting Plugin plugin.

+ Shape Designs & Holder: Defines the graphic designs for shapes.
« Disabled: No shape designs are used. Shapes found in the file will not be drawn.
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¢ Local: Specific shape design containers and holder will be used. When selected,
additional parameters will be enabled: Shape Designs and Shape Holder. Assign
the required designs and holder to the plugin.

¢ Global: The global Shape designs and holder container will be used. The global
designs and holder are defined in the 3D Map Setting Plugin plugin.

* Georef Images: Defines whether georef images found in the KML file will be used.
* Disabled: Images found in the file will not be drawn.

¢ Enabled: Images defined in the file will be drawn and geographically referenced.
When selected an additional parameter will be enabled: Georef Images Holder.
Assign the required holder to the plugin.

Hop Control
KMLReader Flugin (14.0.0)

Set Navigator Hops

Exclude Hops

Point Data Diameter (KM)

Debug Printings

* Set Navigator Hops: Create hop points based on the information in the KML.
Select which information to use, i.e. line, shape, etc.

* Exclude Hops: Excludes the hop animation for the following labels; None, First,
Last, or First & Last. Manual Shift allows you to define which destination will be your
starting point (limited to a selection of 30 destinations).

e Start Hop: Starting point for the hop.

¢ Point Data Diameter (KM): The diameter used for each hop point when creating
hops based on labels.

* Set Navigator Hops: Enables the scene to do a hop animation between the labels.

* Debug Printings: When set to ON, debug messages will be printed to the Viz
console.

¢ Read File: Triggers the plugin to read the files and re-draw the objects.

Proxy

* Use Proxy: Defines the network uses a proxy server. If set ON, additional
parameters will be enabled:

¢ IP: Sets the IP address of the proxy server.
¢ Port: Sets the port number to be used.
* Username, Password: Sets the login credentials.

13.17

Label AddOn
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The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps-Adv

The Label AddOn plugin can be used to assign images, geometries and text based on
label parameters. Labels can have up to 4 extra parameters.

¢ Label parents: Country, Adminl, Admin2 (see also Place Finder plugin)
¢ Label type: Type

Based on the container name (case sensitive) the CWMClient plugin will update the
Value field in the plugin with the correct value.

So if for example you have selected London and you have a Label AddOn plugin on a
container named “Country” it will receive the value of United Kingdom and if you have
another Label AddOn plugin on a container named “Type” It will receive the value of
“Capital”.

A use case for this plugin is whenever you want to have flags for all countries in the
world in a folder and use the right flag based on the country.

Another use case is having different images for different types and using the correct
image based on the type.

Properties

LabelAddOn Plugin (14.0.0)

Value |
Prefix

Suffix

Hide If Empty (WG SR

¢ Type: Options are Image, Geometry and Text
* Images can be applied from the database on a local container
*« Geometries can be applied from the database on a local container
¢ Text can be changed on the local container
¢ Value: Values used to seraph the object or set the text. Can be edited for testing.

* Prefix: Prefix used for searching the database. For example MyImages/Flags/
Suffix Or _small

* Hide If Empty: Hides (Off) the container if an object/image is not found
¢ Update: Tests the prefix and suffix

13.18
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Label It

Labellt

e

Labelk

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The Labellt plugin is used for managing 3D labels and place indicators. The plugin
creates a hierarchy under its container for adding a caption, body and pointer objects.

Copyright © 2016 Vizrt



Viz World Client and Server User’s Guide

13.18.1

This section contains information on the following editor views and user information:

* Caption

e Overlay

* On Map Scale
¢ Fade

e Practical Use

Caption

Captiondefines the relation between the label components (text and pointer). When
disabled, duplicated labels will use the label design exactly. When enabled the labels
will use the following options:

¢ Caption Pivot: When caption is moved (rotated along the tip) the two options,
Fixed and Edge, define the connection point between the caption and the body.
Fixed sets the connection point to be the center of the caption. Edge sets the
connection point to depend on the correct rotation. If the caption is above the tip,
the connection point will be the middle lower side of the caption. If the caption is on
the right side of the tip it will be on the left side of the caption. For example: A line
moving from the tip to the center of the caption and where it crosses the caption
bounding box is the connection point.

¢ Rotate Labels: Defines whether labels, created in Viz (3D labels), will be rotated
like the labels in the Map Editor. If set to Disabled, all labels will be displayed
horizontally. If set to Enabled, labels that were rotated in the Map Editor will also be
rotated in Viz.

* Caption Source: The options Default Position, WME Directions and Label
Manager Presets include the properties described below.

Default Position
This will be used when adding labels in WME when no direction is selected.

¢ Direction (deg): Sets the angle of the label in relation to its geographic position.
« Distance (cm): Sets the distance of the label from its geographical position.

« WME Offsets Distance: Enables the WME to offset the distance (default ON).
When disabled (OFF) only the direction offsets from WME is used and the distance
ignored.

WME Directions

This allows you to set and fine tune offsets for every direction available in WME. When
selected, the labels will be placed as they were placed on the map in the Map Editor.
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When manually set inside WME they will always take priority over the presets and
Default Position settings.

The default pointer direction (angle) and default distance between the pointer and
the label is set by the map label parameters and used by the Map Editor (WME). If the
direction and distance are changed while using the WME the Default Direction and
Default Distance values will be ignored.

« WME Compass Rose: Corresponds to the available directions inside the WME, as
shown in the following image.

? New Detail

* Direction Offset (Degrees): Values for fine-tuning the position of the label

¢ Distance (Viz units): Distance offset for fine-tuning the position of the label

Label Manger Presets

When this is selected, the LabelManager plugin will use the defined presets to place the
labels over the map. The LabelManager plugin will optimize the label position such that
the labels will not overlap.

« Number of Presets: Defines the number of label position presets available to the
user (one to four presets). This parameter will be enabled only when Caption Mode
is set to Controlled.

¢ Current Preset: Selects the preset number to be configured, using the Direction and
Distance parameters. Each preset should be selected and the label position should
be adjusted.

¢ Direction (deg): Sets the angle of the label in relation to its geographic position.
¢ Distance (cm): Sets the distance of the label from its geographical position.

e Collision Mode: Defines how the labels will be placed when an overlap or collision
between two labels occur. With Tip, the pointers of overlapping labels can cross or
touch, but no overlap of label bodies are allowed. With Bounding Box, a bounding
box is calculated around the entire label (label body and pointer). An overlap
between labels bounding boxes is not allowed.

Overlay

Navigator Overlay defines how the label will be displayed over the map. Available
options are Disabled, Fixed, Scaling, Near Scale and Far Scale.

Labellt Flugin (14.0.0)

« Disabled: Places the label on the map using its geographical referencing.

¢ Fixed: Places the label by keeping its geographical referencing but using a different
camera (either with dynamic image or with a front layer). The label size will remain
fixed.
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¢ Scaling: Places the label by keeping its geographical referencing but using a
different camera (either with dynamic image or with a front layer). The Label will
scale trying to imitate the camera movement.

¢ Near Scale: Defines the maximal size of the label on the screen (that is when
zooming in what will be the final size of the label).

¢ Far Scale: Defines the minimal size of the label on the screen (that is when
zooming out what will be the final size of the label).

13.18.3 On Map Scale

Labellt Plugin (14.0.0)

Caption Overlay

Scale IW‘E

« Static Map Scale: Defines a scaling factor for the duplicated labels on a static map
without camera movement. When disabled (Off), no scaling will be used.

13.18.4 Fade

Stand Alone

Labellt Plugin (14.0.0) i

Caption Overlay On Map Scale E

Controlled
Fade On Time Disabled | [ EREBIEE|
lalp,

Time To Hop(%) 25.0

Fade On Di [PVGESEEE | Enabled |
Fade On Lat/Long Disabled | Enabled |
Lat/Long 20.0 ":

[7

* Fade: Defines the fade effect parameters to be used with the duplicated labels.
Available options are Stand Alone and Controlled. Stand Alone enables the user
to define the fade parameters of the labels, while Controlled can be enabled to
define the fade parameters when working with the Label Manager Plugin plugin.

« Fade On Time: Defines a label fade effect, beginning at a relative point to the
defined hop duration. An additional parameter will be enabled, Time To Hop,
defining when the fade will occur.

* Fade On Distance: Defines a label fade effect, beginning at a relative distance
from the hop final location.

Note: The Fade On Distance parameter is enabled only if Overlay is set to
Scaling.

« Fade On Lat/Long: Defines a label fade effect, beginning at a Longitude and
Latitude offset from the hop final location. An additional parameter will be enabled,
Lat/Long, defining the offset from in degrees.
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Controlled

ciscted Label Timings [INARERGNI] [CIESTER WA [WENAREEN

Lal

Labellt Plugin (14.0.0)

[ Stand Alane | [FEGRBEE |
[T GnFop |

s PEEE Normal | High | Aways

Step: Controls when the label will fade in and out in relation to an animation. In
general the fade can be based on the camera distance (for example; capitals are in
view when distance is below 1000KM) or on timing in relation to the hop:

Auto: When a label is of type point (added by the user) it will fade in and out
based on distance to hop. If the label is of type place/region it will be faded in
and out based on the distance set in Label Manager Plugin plugin. If the hop is
not close enough for the label to show and the label was added by the user it will
be faded in based on hop timing and not distance.

On Hop: Links the fade to the hop timing.

Point 1/Point 2: These are reserved for labels where the distance is configured by
the Label Manager Plugin plugin.

Hop and Above: Turns on at the hop and stays on thereafter.

Selected Label Timings: Sets one of the timing options for the fade to occur:

At End: the label will fade after the animation stops and before it continues.

Close To End: Fades the label just before the animation stops and just after the
animation continues.

Ahead: Fades the label before the animation stops and after the animation
continues.

Well Ahead: Fades the label long before the animation stops and long after the
animation continues.

Label Priority: Sets the duplicated labels priority. This parameter is used when the
number of labels on the screen is high and not all of the labels can be displayed.
The priority levels define which labels will be displayed and which labels will be
hidden:

Auto: Priorities are set by the Label Manager Plugin plugin.

Normal, High: Priorities are set to normal and high.
Always: Labels will always be displayed.

13.18.5 Practical Use

Page 234

When adding a Labellt plugin, three containers will be added under the Labellt
container: CAPTION, BODY and TIP. Drag a text object under the CAPTION container.
The BODY container is the pointer’s body and the TIP is the pointer’s end.

IMPORTANT! A text object under the label design must be named “label” to
receive the name of the object from the CWMClient plugin.
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13.19 LatLongGrid

R

/ |

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->

Maps.

The LatLongGrid plugin is used to draw latitude and longitude lines on the map. The

lines are generated using the 3D Line Plugin.

LatLongGrid Plugin
Spacing
Spacing Units
Longitude Spacinc
Latitude Spacing
Ongin Longitude 0.0
Origin Latitude 0.0
Prune Longitude Lines At Pole WE
Latitude/Longitude Designs WE

[TRebuild |

Properties

¢ Spacing:
¢ 20/10/5 Degrees: Spacing in degrees for each line in the grid.
¢ Manual: You can define the Spacing Units (Degrees or Meters) and also define

separate spacing for longitude and latitude lines. as well as the Origin
Latitude/Longitude (starting point for the grid).

* Prune Longitude Lines at Poles: When Disabled it will continue to draw lines in
the poles instead of pruning (cropping) the geometry at the poles.

* Latitude/Longitude Designs: When set to Single, both Longitude and Latitude
lines will be drawn using the same 3DLine plugin. When set to Separate it will allow
you to use separate 3DLine plugins for each in order to achieve a different look for
long and lat lines.

13.20 Locator Control
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LocatorCtl

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The LocatorCtl plugin is used to link an object positioned on one map to another map,
showing its position. The object marking the point on the linked map must reside under
a geographically referenced map. The linked object will show the position of the linked
map or object on the map its parent map.

* Position Type defines the link between the object and the map. Available options
are Map, Navigator, WPosition, WPoint and User.
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Map

Position Type
Remote Container
Control Size

in Size

Max Size

Shared Memory

Type
Identifier THE_LOCATOR

Map links the object to a map, showing its entire area over the parent map.

* Remote Container: Defines the linked map container.

¢ Control Size: When disabled (Off), the entire area of the linked map will be
marked on the parent map. When enabled (On), the size of the marked area can be
controlled.

¢ Basic Size: Defines the percentage of the linked map area to be marked.
¢ Min Size: Defines the minimal size of the linked map area to be marked.
¢ Max Size: Defines the maximal size of the linked map area to be marked.

« Shared Memory Link: Defines which is the master (source) and client (target)
when the same Shared Memory ldentifier is used.

¢ Type: Defines the accessibility of the shared memory.

* Global: Memory is accessible to all scenes currently loaded in memory. This is
useful when working with Transition Logic scenes where your Viz World map can
be one scene and the locator a different one and data can easily be transferred
between the two.

* Scene: Memory is only accessible locally and to the current scene. Every scene
has one shared memory map that can be used to exchange data among the
scripts in the scene.

¢ Distributed: Memory is accessible to all computers connected to one Viz
Graphic Hub.

* Identifier: Defines the identifier for the shared memory map.

Navigator

Navigator links the object to a Navigator plugin, showing its position on the parent
map. The plugin will locate the navigator container above it in the scene tree. The
Navigator tab displays the same settings as Map with the exception of the Remote
Container setting.

WPosition

WPosition links the object to a WPosition plugin, showing its position on the parent
map. Remote Container defines the linked WPosition container.

WPoint

WPoint links the object to a WPoint plugin, showing its position on the parent map (The

WPoint plugin is used in Viz Weather). Remote Container defines the linked WPoint
container.

Copyright © 2016 Vizrt



Viz World Client and Server User’s Guide

User

=
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User enables the user to position the object on the map.
* Map Center Longitude: Defines a Longitude value for the object.

*« Map Center Latitude: Defines a Latitude value for the object.

* Tangent To Globe: When enabled (On), the controlled object will be rotated to
match the globe surface.

Note: Tangent To Globe is only visible when the locator is under a globe object.

13.21 Map Layers
Srplayes

Map Layers

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The MapLayers plugin is used to expose map layers to an external application. Map
layers are labels, regions, and so on.

Properties

MapLayers Plugin (14.0.0)

Wiz World Map Editor{WME) WME (Classic)
[t | e |
[EREM| xTi(Opaque) || Obsolete || DXTS(Alpha) |
" Unear [T
Linear

2 [ 3 | & 5

[
Al
=
]
[o#
[o#
[o#
[o#
o
[o#
[o#
o]
o]
o
[

g

Build Tiles

¢ Mode: Defines the layer maps mode Static and Dynamic.

e Static: Enables maps to be imported to Viz Artist’s image library and saved with
the scene.

* Dynamic: Enables pyramid maps to be loaded from the cache and temporary
folder. When the CWMClient plugin receives a new map, all layers will be
updated.
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Texture Compression: Sets the compression level for the texture (DTX5 is the
highest compression level, which is less texture quality).

Texture Quality: Sets linear for using the same image resolution in the entire
zoom range, or Mipmap to change resolution according to the distance from the
image (managed automatically in Viz Artist).

Edited Layer: Sets the layer number for editing. Each layer is then assigned map
properties to display.

Active: Activates or disables the selected layer.
Container: Assigns the container for holding the created layer map.

Flags: Enables (On) the requested property to expose the map property or feature
in the selected layer. Flags refer to all the settings from Base Map to Overlay Data.

Build Tiles: Builds the map layers.

13.22 Map Layers Control
1 1
i

I\!1apLal,lersC
The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.
The MapLayersControl plugin is used to control map layers in an individual map and
in map tiles (Pyramid or MapTiler tiles). The plugin should reside on the CWMClient
container which generates the maps and tiles.

Properties

MapLayersControl Plugin (14.0.0)

Control

Selected Borders

Labels

LEL S

Rail

Land

::;Lr_\ng Grid

Overlay Data

Event Imagery

Zero Sea Alpha I

[Refresnmap || 7

Select an option to configure: Map or Tiles. Each can be enabled and configured
separately. When Control is enabled, the layer parameters will be enabled. See Map
Layers plugin for the layers description.

13.23 Map Pyramid
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The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The MapPyramid plugin is used to build a set of map layers for displaying an area in
high resolution when zooming into a specific area. The maps are created as Geolmage
(flat map) or Globe objects and placed under a low resolution map of the entire area
for geographical referencing. The Map Tiler plugin is also used for managing Pyramid
object maps when used in a scene.

Properties

MapPyramid Plugin (14.0.0)

" Viz World Map Editor(WME) | WME (Classic) |
Mode @

Ic
Map Style [ Souree || Target  |[mSgeTT|

satellite Threshold (Deg) 0s =
=

Max Pyramid Height 3 |'—'|q
Pyramid Factor
Pyramid Steps

Create Hole

esolution

Apply Fade
Fade Range

¢ Viz World Map Editor (WME) : will open the new WME
* WME (Classic): will open the WME Classic Interface
¢ Mode: Defines the maps mode. Available modes are Static and Dynamic.

* Static: Enables the maps to be imported to Viz Artist’s image library and saved
with the scene.

* Dynamic: Enables the pyramid maps to be loaded from the cache and
temporary folder. When the CWMClient receives a new map, the pyramid will be
generated.

¢ Map Style: Defines the map style to be used for the pyramid maps:

¢ Source: Uses the top CWMClient container ( Map Tiler ) style selection when
creating the pyramid maps.

¢ Target: Uses the hop CWMClient style selection when creating the pyramid
maps.

¢ Split: Splits the pyramid layers style, based on image latitude and longitude
size. If the image size is smaller then the threshold the target style will be used,
if larger then the source style will be used. Additionally, it is possible to turn on
the color correction option in Pyramid Control which will color correct the target
image to match the source images. Set the Satellite Threshold (deg).

* Max Pyramid Height: Defines the maximal number of maps that will be created in
the pyramid. The optimal number of pyramid maps is calculated by the MapPyramid
plugin. If the optimal number exceeds the Max Pyramid Height value, then the
plugin will generate the maximal number defined.

¢ Pyramid Factor: Calculates the number of maps required defining the size factor
between the maps of the pyramid.

¢« Pyramid Steps: Defines how the map coverage area grows from pyramid to
pyramid:
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¢ Equal: The size factor will be based on map pyramid height, pyramid factor and
the resolution difference between the base map and the final map. The actual
number might be different than the pyramid factor. The number of levels might
also be smaller than the max pyramid height

¢ Constant: The value of the pyramid factor will be used as is, with the value of
max pyramid height.
* Create Hole: Will create a hole on each pyramid tile
* Image Aspect: (Power of 2). Will calculate the closest power of 2 size, based on the

selected image size of the CWMClient Plugin texture size. Target will use exactly the
same size as the CWMClient Plugin texture size.

¢ Auto Hide Local Texture (Hide Lower Resolution): Defines whether the map
created by the CWMClient plugin, located on the MapPyramid container, will be
turned off when the texture resolution of that map is lower than the Globe or
Geolmage map tiles resolution. If it is enabled (On), the maps with lower resolution
will be turned off automatically by the MapPyramid plugin. If it is disabled (Off), the
MapPyramid will not turn off the low resolution maps.

* Apply Fade: Defines whether the maps used in the pyramid will use soft edges.
Available options are Off, Target and Pyramid.

* Off: No soft edges will be used. The transition between the maps will be visible
(the maps will have sharp edges).

* Target: Sets the last map (target) to have soft edges only.
* Pyramid: Sets all maps in the pyramid to have soft edges.

 Fade Range: When Apply Fade parameter is used, the Fade Range is used to set
the fade level (the area of the image that the fade will be applied to).

e Build Tiles: Triggers a rebuild of the pyramid maps.

13.24
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Map Tiler

I .!ipﬁler
)

LS
hapTiler

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The Map Tiler plugin is used to build a set of map tiles for displaying an area in high
resolution. The maps are created as Geolmage (flat map) or Globe objects and placed
under a low resolution map of the entire area for geographical referencing. The Map
Tiler plugin is also used for managing Pyramid object maps when used in a scene (see
the Map Pyramid plugin for more information).

This section contains information on the following tabs and buttons:

e Default
e Custom
e Buttons
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See Also

* Geolmage
¢ Globe

¢ Map Pyramid

13.24.1 Default

MapTiler Plugin (14.0.0)

* Selected Region: Defines the area of the map for which the tiles will be created.
¢ World: Creates tiles for the entire world.

* Selected Map: Creates tiles for the area of the selected map in the CWMClient
plugin attached to the MapTiler container.

* Region List: When Region List is selected, a list of regions will be displayed. An
item from the list can be selected to create map tiles for the selected area.

¢ Long Lat: Sets the Longitude and Latitude minimum and maximum values. The
map tiles will be created for the defined area. When Long Lat option is selected,
additional fields will be enabled.

¢ Map Status: Displays plugin status messages. When configuring the tiles, the Map
Status field will display the number of tiles required and tile size according to the
current plugin setup.

* Requested Number of Tiles (2K*2K): Allows the user to set the number of tiles
to create

« Geometry Type: Selects the object type of the created tiles.
* Globe: Creates the tiles using the Globe plugin.

¢ Flat: Creates the tiles the Geolmage plugin.
Selected Map

¢ Texture Compression: Sets the compression level for the texture (DTX5 is the
highest compression level which is less texture quality).

* Get Map Resolution/(Classic): Use the WME editor (New or Classic) to zoom to
the closest level you want the tiles to support. If you change the extent (in Selected
Map mode) you will need to set the resolution again.

Region List

* Region Area: Select the region you want to build tiles for.

Long Lat

¢ West: Sets the Longitude value for the western edge of the map.
* East: Sets the Longitude value for the eastern edge of the map.
* South: Sets the Latitude value for the southern edge of the map.

Copyright © 2016 Vizrt Page 241



Viz World Client and Server User’s Guide

North: Sets the Latitude value for the northern edge of the map.

13.24.2 Custom

13.24.3

Page 242

The following additional parameters are available:

Radius/Map Size: Sets the size (in Viz units) of the globe or map tiles (all
together).

Tessellation: The number of polygons used in the object. The higher the number is,
the smoother the object is drawn.

Texture Quality: When set to Linear the same image resolution will be used in the
entire zoom range. When set to Mipmap the resolution is changed according to the
distance from the image (managed automatically in Viz Artist).

Overlap (%): Percentage for overlapping each tile.
Build Terrain: Builds terrain data for the created tiles

Smooth Terrain: Smoothens terrain edges so they blend with the base map
surface. When enabled (On) the Terrain Smoothing Factor will be enabled.

Terrain Smoothing Factor: Sets the percentage of the smoothed area.

Terrain Height Scale: Sets the scaling factor for terrain height. The higher the
factor is, the more extreme the terrain will be.

Terrain Resolution: Sets the total terrain resolution for all tiles. A high resolution
value will result in a more detailed terrain (effecting performance).

Buttons

Build Tiles: Build the geo-reference map and tiles.

Change All Maps: Builds the geographical reference map, tiles and applies style
changes made in the CWMClient plugin to all child containers (recursively) under
the MapTiler container.

Build Tiles (Force New): Builds the geographical reference map and tiles without
checking the cache for existing maps (from the server).

Change All Maps (Force New): Builds the geographical reference map, tiles

and applies style changes made in the CWMClient plugin to all child containers
(recursively) under the Map Tiler container, without checking the cache for existing
maps (from the server).

Calculate Tiles Info: Calculates the tiles information, without building the tiles,
and displays it in the Map Status field.
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13.25 Map Zoom

Map Zoom

N

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The Map Zoom plugin is used to build single destination animated scenes. Because
the scene is treated as an independent Map Object it can be added into any graphic
including Transition Logic scenes. The map is created as Geolmage (flat map) and will
add all necessary plugins to the hierarchy.

MapZoom Plugin (14.0.0)

Zoom m FF

Labels  WEREET Auto Scale |

Properties

e Zoom: This property defines the zoom in percent (0-100%), in order to animate to
the final destination.

* Labels: When set to Fixed the size of the label will be taken from the original
design and when set to Auto Scale the size will be calculated based on the size of
the map.

13.26 Mute

Mute

e
hte

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Tools.

The Mute plugin is used to determine if a container will be drawn or not. The difference
between using the Mute plugin and setting the visibility off is that when using the
plugin only containers with the plugin will not be drawn, but all child objects will

be drawn and the geometry properties will be used in the hierarchy (geographical
reference, and so on). When setting the visibility off the entire container and its child
containers will be set off and not be used in any way.

Properties

Mute Plugin (14.0.0)

Draw Geometry “

« Draw Geometry: When enabled (On), the geometry will be drawn. When disabled
(Off), the geometry will not be drawn but its child containers will be drawn.
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13.27

13.27.1
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NavCom

MauCom

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps-Adv.

The NavCom plugin is used for controlling the Navigator plugin. The plugin is an
example showing how to externally control the Navigator plugin when special
applications should be used to control the scene. An example for a special case where
external control of the Navigator plugin is required is Elections. When using Viz 3.x
scripting, complicated logics and commands can be used with the NavCom plugin.

This section contains information on the following tabs and examples:

¢ Commands
e Control
e Advanced

e NavCom Scripting

Commands

The Commands tab is used for communicating with the Navigator plugin in means of
sending formatted commands and receiving formatted responses from the Navigator

plugin:

Plugin (14.0.0)

PSSR Cortrol | Advarced |

Command

Immediate Response Enabled
Execute Command | Initialize | ?

The Command text field is where you enter the command. The NavCom plugin receives
predefined, fixed syntax, commands and returns a reply from the Navigator plugin.

The Response field contains the reply returned from the Navigator plugin. The format of
the reply is defined in the Advanced tab.

The Immediate Response option defines whether the command will be sent while
typing (every change to the command field will sent the command to Navigator), or
only after pressing the Execute Command button.

The following is a list of commands, example commands and return values:

Mouse To Lon Lat: Converts screen coordinates to Long/Lat values from the map. This
needs the Navigator plugin.
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¢ Command: MTLL x y
* Response: lon lat

MTLL 360 288
-116.998 38.088

Mouse To Region: Returns the region name in which the given screen coordinates
reside. This command requires the Navigator plugin.
e Command: MTR x y

* Response: CountryID "Country Name" RegionID "Region Name" SubRegionID
"Sub Region Name"

MTR 360 288
1000000000003600 "United States of America™ 1000000000038901 "Texas"
1000000000111302 "Atascosa County"

All Fly To commands require the Navigator and the NavFinder plugin. Also set the
Navigator plugin’s Interactive Anim setting to On (see Miscellaneous ).

Fly To Region ID: Triggers a Navigator animation from the current location to the sent
region (RegionlD).

¢ Command: FTRID RegionID
FTRID 81000000000F8285

Fly To Country: Triggers a Navigator animation from the current location to the sent
country (country name).

¢ Command: FTC "country name"

FTC "united states of America"

Fly To Region: Triggers a Navigator animation from the current location to the sent
region (Region name).

¢ Command: FTR "country" "Region"

FTR "united states of America" "Texas"

Fly To Sub Region: Triggers a Navigator animation from the current location to the
sent sub region (by name).

¢ Command: FTSR "country" "Region" "Sub Region"

FTSR "united states of America" "Texas" "young county"

Fly To Lon Lat Level: Triggers a Navigator animation from the current location to the
sent level area (country, region, or sub region) that the long/lat data resides in.

¢ Command: FTLLL lon lat level
FTLLL -116.998 38.088 1

Search database: Searches the map database and as a response generates an XML.
This command requires a running Viz World server.

¢ Command: SMDB <query>
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Search web: Searches the web and as a response generates an XML. This command
requires a running Viz World server.

¢ Command: SWEB <query>

Search All: Searches both resources (map database and web) and as a response
generates an XML. This command requires a running Viz World server.

e Command: SALL <query>
* Shared memory reply: WS_REPLY

Nearby: Searches locations in the vicinity of the coordinates of your “mouse” and as
a response generates an XML. This command requires a running Viz World server. This
command requires the Navigator plugin.

¢ Command: NEARBY [mouse-x] [mouse-y]
* Shared memory reply: NAV_NEARBY REPLY

Shared Navigation memory of the Navigator plugin can be activated by setting
Publish Geo Data to Bounding box or Location. If Bounding box is selected you
will, in addition to Bounding box data, get Center and Distance data. If Location is
selected you will, in addition to the Location data, get all the others. If None is selected
no data is shared.

All can be used with scripting to define e.g. the administration levels the script should
fetch from the shared data and consequently display it on screen. For interactive
scenes such as touch screens this can be used for adding graphics to maps based on
your selection (thereby avoiding over-populating the map with information).

For testing you can enable the interactive mode by clicking the E button in Viz Artist’s
Scene Editor.

Navigation location: Shared data holding the current geographic location(s) of the
Navigator plugin. To enable it, select Publish Geo Data’s Location option. The data is
updated when the camera is not moving. Navigation location also generates an XML
with the current geographic location(s) (in the same format as SMDB, SWEB, SALL and
NEARBY). This requires a running Viz World Server.

* Name: NAV_LOCATION DATA

Navigation bounding box: Shared memory data holding the current (frame by
frame) geographic bounding box (lat lon) of the Navigator plugin. To enable it, select
Publish Geo Data’s Bounding box or Location option.

* Reply: NAV_BB_DATA

Navigation center: Shared memory data holding the current (frame by frame)
geographic center of the Navigator plugin. To enable it, select Publish Geo Data’s
Bounding box or Location option.

* Reply: NAV_CENTER_DATA

Navigation distance: Shared memory with the current distance to world of the
Navigator plugin. To enable it, select Publish Geo Data’s Bounding box or Location
option.

* Reply: NAV_DISTANCE DATA
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Navigation direction: Shared memory with the current pan and tilt direction of the
Navigator plugin. To enable it, select Publish Geo Data’s Bounding box or Location
option.

* Reply: NAV_DIRECTION_DATA

13.27.2 Control

The Control tab is used to directly control the Navigator plugin by changing the values
of the parameters

NawCom Plugin (14.0.0)

["Commands |
Lon 314 R.
(F.13 24.6
Distance 400.0
Pan 0.0

Tilt o=

L=
Interactive Mode [ Edtor [ On-Ar |[OAREyE

Input ultiToud

Minimal Distance

Center

Momentum Mode

[Execute Command | Initalize || 7

* Lon: Sets the longitude value for the Navigator plugin. The Navigator camera will
move to the specified longitude value.

e Lat: Sets the latitude value for the Navigator plugin. The Navigator camera will
move to the specified latitude value.

» Distance: Sets the Navigator distance from the map. The Navigator camera will
move to the specified distance value.

¢ Pan: Sets the pan value of the Navigator camera.
¢ Tilt: Sets the tilt value of the Navigator camera.

¢ Interactive Mode: Defines the interactive behavior of Viz. Available modes are
None, Editor, On-Air, Always.

* None: Disables interactive mode.
¢ Editor: Enables interactive mode during scene editing.
* On-Air: Enables interactive mode when Viz Engine is in On Air mode.

¢ Always: Enables interactive mode during scene editing and when Viz Engine is
in On Air mode.

¢ Minimal Distance: Sets the minimal distance from the map in Viz units.
e Zoom Center: Used in interactive mode.

¢ Position: The map zooms to center on the position of the fingers.

¢ Center: The map zooms to the center of the map.

¢ Momentum Mode: When set to Linear you can set how much friction should be
applied to the momentum.

Note: The Navigator control parameters effect the Navigator immediately.
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13.27.3 Advanced

Page 248

The Advanced tab is used for defining the NavCom plugin’s general behavior patterns.

NavCom Plugin (14.0.0)

Shape File Support

Limit Picking

Shared Memory
d Memory Prefix

Use Quotes

Suffix FIPS

Publish Geo Data [HGRE™ | Boundingbox || Location |
[Exeaite Command [ Totaiee [ 7]

Shape File Support: Defines whether the NavCom plugin will include shape
objects information in the respond. The Shape objects must reside under the
NavCom container. When the Shape File Support is Limited, the plugin will scan the
shape files below the container. When a command is received, the NavCom plugin
will return, in the response string, information about the shapes that overlap the
requested data in the command. When the Shape File Support is Only, the plugin
will scan the shape files below the container. When a command is received, the
NavCom plugin will return, in the response string, only the information about the
shapes that overlap the requested data in the command.

Limit Picking: Limits the geographical area that the NavCom plugin will perform
any of the commands on. When Limit Picking is enabled the Limit to Country
parameter will be enabled.

¢ Limit to Country: Sets the country name. If the requested data in the command
does not exist for the defined country area, the command will not be executed.
Only commands relating to points within the country area will be executed.

Shared Memory Prefix: This parameter should be used when using more than
one NavCom plugin in the scene, and when using scripting to send and receive
information from these plugins. In each NavCom plugin, set the Shared Memory
Prefix to a different prefix (up to four) to distinguish between the data sent to each
plugin.

Protocol Mode: Defines the data displayed in the Response field.

¢ Full: Includes data on names and IDs for countries, regions and sub-regions.

* Name: Includes data on names for the countries, regions and sub-regions.

¢ ID: Includes only ID data (as defined in the Viz World Server) for the countries,
regions and sub-regions.

Protocol Separator: Defines the separating character between the Response data.
The defined separator will be used between country and region, region and sub-
region, and so on.

Use Quotes: Defines whether the response string will be quoted or not.
Suffix FIPS: Used for USA regions and sub-regions.

Publish Geo Date: Allows you to publish navigation data to shared memory based
on your interaction with the graphics scene (e.g. touchscreen or mouse). Shared
Navigationmemory can be activated by setting Publish Geo Data to Bounding
box or Location. If Bounding box is selected you will, in addition to Bounding box
data, get Center and Distance data. If Location is selected you will, in addition to
the Location data, get all the others. If None is selected no data is shared. See the
available Navigation data under the Commands section.
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13.27.4

« Execute Command: When pressed, the defined command will be executed.

¢ Initialize: This button is used when using shape file support. If the shape objects
under the NavCom container is changed, press the initialize button to re-scan the
shape objects.

Na

vCom Scripting

Viz 3.X scripting ability is a powerful tool for implementing complex logic into a scene.
In a Navigator scene, NavCom can be used in the scripts to enable such advanced
Navigator operations. The following script example demonstrates how to send and
receive data from the Navigator plugin through to the NavCom plugin.

dim
dim
dim
dim
dim
dim
dim
dim
Sub

End
Sub

level as Integer
ignore as Integer
CurCountry as string
CurCountrylId as string
CurState as string
CurStateld as string
CurCounty as string
CurCountyId as string
UpdateCurrent (temp As String)
dim position as Integer
dim temp2 as String
println temp
CurCountryld = temp.left (16)
position = temp.Find("\"")
temp = temp.GetSubstring (position+l, temp.Length- (position+1)
temp2 = temp
position = temp2.Find ("\"")
CurCountry = temp2.Left (position)
println "<" & CurCountryId & "><" & CurCountry & ">"
position = temp.Find ("\"")
temp = temp.GetSubstring(position+2, temp.Length- (position+2)
CurStateld = temp.left(16)
position = temp.Find ("\"")
temp = temp.GetSubstring(position+l, temp.Length- (position+1)
temp2 = temp
position = temp2.Find ("\"")
CurState = temp2.Left (position)
println "<" & CurStateId & "><" & CurState & ">"
position = temp.Find ("\"")
temp = temp.GetSubstring(position+2, temp.Length- (position+2)
CurCountyId = temp.left (16)
position = temp.Find("\"")
temp = temp.GetSubstring(position+l, temp.Length- (position+1)
temp2 = temp
position = temp2.Find ("\"")
CurCounty = temp2.Left (position)
println "<" & CurCountyId & "><" & CurCounty & ">"
Sub
OnInit ()
ignore = 0
level =1
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if Scene
Scene
End If
if Scene
Scene
End If
if Scene
Scene
End If
if Scene
Scene
End If
if Scene
Scene
End If
if Scene
Scene
End If
if Scene
Scene
End If
if Scene
Scene
End If

.Map.
.Map.

.Map.
.Map.

.Map.
.Map.

.Map.
.Map.

.Map.
.Map.

.Map.
.Map.

.Map.
.Map.

.Map.
.Map.
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ContainsKey ("MTR") = false Then
CreateKey ("MTR")
ContainsKey ("FTRID") = false Then

CreateKey ("FTRID")

ContainsKey ("FTC")

CreateKey ("FTC")

= false Then

ContainsKey ("FTR") = false Then
CreateKey ("FTR")

ContainsKey ("FTSR") = false Then
CreateKey ("FTSR")

ContainsKey ("FTLLL") = false Then
CreateKey ("FTLLL")
ContainsKey ("MTR REPLY") = false Then

CreateKey ("MTR REPLY")

ContainsKey ("FTRID REPLY")

CreateKey ("FTRID REPLY")

Scene.Map.RegisterChangedCallback ("MTR REPLY")
System.Map.RegisterChangedCallback ("REGION L")

End Sub

Sub OnSharedMemoryVariableChanged (map As SharedMemory,
println mapKey
dim temp as String

If mapKey = "REGION L" Then
println "ignore pre"
ignore =1

else If mapKey = "MTR REPLY" Then
temp = Scene.Map["MTR REPLY"]

UpdateCurrent (temp)

println System.Map["REGION L"]

if System.Map["REGION L"] = "1" then
Scene.Map ["FTRID"] = CurCountryId
elseif System.Map["REGION L"] = "2" then
Scene.Map ["FTRID"] = CurStateld
elseif System.Map["REGION L"] = "3" then
Scene.Map ["FTRID"] = CurCountyId
End If
End If
If mapKey = "MTLL REPLY" Then
println Scene.Map ["MTLL REPLY"]
End If
End Sub

sub OnLButtonDown ()
dim temp as String

if System.MouseX <

Scene.Map["MTR"] =
System.MouseY

end 1if
end sub

(String)

(System.RenderWindowWidth:

System.MouseX &

120

)

= false Then

mapKey As String)

then
& (String)
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13.28

13.28.1

Copyright © 2016 Vizrt

NavFade

HauFade

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The NavFade plugin is used for defining the visibility of an object that the NavFade is
attached to in a Navigator scene. The Navigator point of view (distance from the map)
will determine when the object will become visible. The NavFade uses an Alpha plugin
to control the object’s appearance. The Alpha plugin will be added automatically when
adding NavFade to the container.

The NavFade plugin has the following fade modes:

e Height
* Hops
e Distance

e Angle
¢ Movement

Height

MNavFade Plugin (14.0.0) i
Fadie Mods o oa 1 Angle | Wevemant |
Fade Invert
Fada Time (Fields) B =

Visibility Range [EEEwT|  Above || Range |

Height 10.0 EF
[ setheight |
=

The object will fade in or out depending on camera height (above the map).

¢ Fade Invert: If On, perform a fade from 100% alpha to 0% alpha instead of from
0-100%.

¢ Fade Time: Defines the fade transition duration in fields.

* Visibility Range: Defines how the fade point is calculated:

¢ Below: The object will be visible when the defined height is higher than the
current Navigator distance from the map.

¢ Above: The object will be visible when the defined height is lower than the
current Navigator distance from the map.

¢ Range: The object will be visible between the defined low and high values.

Below or Above
When Visibility Range parameter is set to Below or Above:

* Height: Defines the height value that the NavFade plugin will use as the show/hide
point of the object when Visibility Range parameter is set to Below or Above.

¢ Set Height: When clicked, the current camera height will be inserted to the height
field.
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Range

When Visibility Range parameter is set to Range:

Low/High: Sets the lowest/highest value of the height range that the object will be
visible in. If the current Navigator height is between the low and high values, the
object will be visible.

Set Range High/Low: The current Navigator height value will be copied to the
High/Low parameter.

Hops

The object will fade in or out depending on the defined hop point and the animation
time to/from the selected hop point.

NavFade Plugin (14.0.0)

Hop To Link

Hop And Above

Fade Invert: If On, perform a fade from 100% alpha to 0% alpha instead of from
0-100%.

Fade Time (Fields): Defines the fade transition duration in fields.

Time to Hop (%): Sets the point in which the object will appear/disappear. The
time is set as a percentage of the hop duration.

Hop Mode: defines whether the NavFade plugin will effect the manually selected
hop or if the hop will be auto selected when the designs copied by CWM client.

Hop To Link: Sets the number of the hop points that NavFade will use as a
reference. When animating to and from the selected hop, the object will appear/
disappear.

Hop and Above: When enabled, all hops which number is higher than the selected
hop will be considered as the selected hop. Defines whether the NavFade plugin

will affect the manually selected hop or if the hop will be selected by the NavFade
plugin. The Constant option will cause the object to fade on at Hop to Link and stay
on from that point onwards. The Related option allows you to relate hops to a set of
containers. You can for example use the NavFinder plugin to define three hops, and
then add three Text containers as sub-containers of a container holding the NavFade
plugin. Setting NavFade to Related will allow the NavFinder hops to relate to the Text
containers found under the NavFade container and fade them in and out as part of
the hop animation.
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13.28.3 Distance

MNavFade Plugin (14.0.0)
| Height Hops Angle Movement
I s L
L |y
i
mdon | Abewe [RERGE
T Ll
10.0 =

F
High 10.0 ,’:F

Set Range High Set Range Low
|

The object will fade in or out depending on the distance from the map.

¢ Fade Time: Defines the fade transition duration in fields.

+ Visibility Range: Defines how the fade point is calculated. Available options are
Below, Above and Range.

* Below: The object will be visible when the defined distance is higher than the
current Navigator distance from the map.

e Above: The object will be visible when the defined distance is lower than the
current Navigator distance from the map.

¢ Range: The object will be visible between the defined low and high values.

Below or Above
When Visibility Range parameter is set to Below or Above:

« Distance: Defines the distance value that the NavFade plugin will use as the show/
hide point of the object.

¢ Set Distance: The current Navigator distance value will be copied to the Distance
parameter.

Range
When Visibility Range parameter is set to Range:

* Low/High: Sets the lower/higher value of the distance range that the object will be
visible in. If the current Navigator distance is between the low and high values, the
object will be visible.

* Set Range High/Low: The current Navigator distance value will be copied to the
High/Low parameter.

13.28.4 Angle

MNavFade Plugin (14.0.0)

[ Height Hops Dist  VERGIE™™| Movement |
R

= Er
[ eon | Above  [PURERGE™

10.0

=l
10.0 ,’:F

Set Range High Set Range Low
|

The object will fade in or out depending on the angle between the camera and the
map.

¢ Fade Invert: If On, perform a fade from 100% alpha to 0% alpha instead of from
0-100%.
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¢ Fade Time: Defines the fade transition duration in fields.

* Visibility Range: Defines how the fade point is calculated. Available options are
Below, Above and Range.

* Below: The object will be visible when the defined angle is higher than the
current Navigator angle between the camera and the map.

* Above: The object will be visible when the defined angle is lower than the current
Navigator angle between the camera and the map.

¢ Range: The object will be visible between the defined low and high values.

Below and Above
When Visibility Range parameter is set to Below or Above:

* Angle: Defines the angle value that the NavFade plugin will use as the show/hide
point of the object.

* Set Angle: The current Navigator angle value will be copied to the angle
parameter.

Range
When Visibility Range parameter is set to Range:

* Low/High: Sets the lowest/highest value of the angle range that the object will be
visible in. If the current Navigator angle is between the low and high values, the
object will be visible.

* Set Range High/Low: The current Navigator angle value will be copied to the
High/Low parameter.

13.28.5 Movement
NavFade Plugin (14.0.0)
Fade Mode [Heght | Heps || Dt | Angle | PWousmERey|
Fade Invert
Fade Time (Fields) e = .
=
Alpha values will fade on/off based on if Navigator is currently moving or stationary.
13.29 NavFinder
NavFinder
F "'\‘ 1
.«Na\rFinder
The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.
The NavFinder plugin is used for setting hop points over a given map. The NavFinder
must reside under a Navigator plugin container and a map.
This section contains information on the following topics:
 Common Properties
e Map
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13.29.1

13.29.2

Absolute

Geometry
Link

Common Properties

Hop Point: Sets the hop point in the hop sequence. Note that the animation will be
built in the same sequential order as the list of Hop Points (Map-Start, Destination-1,
Destination-2, and so on). If two hops use the same Hop Point, the animation will not
work properly.

Position Source: This parameter defines how the hop location will be set. Available
options are Map , Absolute , Geometry and Link .

Buttons

Goto Map: Jumps to the defined hop point on the map.

Take Current Values: Takes the current position and uses that as the hop position.
This option is normally used with interactive mode in the Navigator plugin. The user
moves the object to the required position and sets the values for the NavFinder.

Fly To Map: Creates an instant animation and run from the current map location to
the current hop point defined by the NavFinder plugin. This feature is active only if
the Interactive Anim parameter in the Navigator plugin is enabled (On).

Get Map: The user can navigate manually to any destination and by pressing the
Get Map button, the currently viewed map will be used. CWMClient must be on the
same container and if a pyramid plugin is used, the pyramid layers will be built.

Add Linked Hop: Adds a hop (container with NavFinder set to Link) under the
current NavFinder container. See Link tab description for more information.

Tip: Take Current Values can be used in interactive mode. The user can position
itself using the mouse and then tell NavFinder to use the current values.

Map

Hap Point

The Position Source Map uses the current location from the map (center of the screen
values) and adds offsets for fine tuning.

Fit To Screen By: Defines what the end frame of the animation (hop) will be. When
the hop is defined as a 3D Region object on the map, the animation will end when
the bounding box of the object fills the frame. Available parameters for defining how
the bounding box will be calculated are Width, Height, Min, Max and Average.
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¢ Width: Uses the width of the object’s bounding box to calculate the last frame of
the hop animation.

+ Height: Uses the height of the object’s bounding box to calculate the last frame
of the hop animation.

¢ Min: Uses the minimal value between the width and the height of the object to
calculate the last frame of the hop animation.

¢ Max: Uses the maximal value between the width and the height of the object to
calculate the last frame of the hop animation.

¢ Average: Uses the average value between the width and the height of the
object to calculate the last frame of the hop animation.

* Longitude offset: Defines Longitude offset based on the current position.

« Latitude offset: Defines Latitude offset based on the current position.

* Distance offset (%): Changes the distance zoom from the map (zoom in or out).
¢ Pan: Sets a pan value for the camera.

* Tilt: Sets a tilt value for the camera.

Note: Pan and Tilt parameters will be disabled unless the Pan & Tilt Animation
parameter in the Navigator plugin is enabled (On).

Absolute

NavFinder Plugin (14.0.0)

Absolute sets the Longitude and Latitude values of the hop point location. Changes
the Distance and Distance Zoom parameters:

* Longitude: Defines the Longitude for the hop position.

* Latitude: Defines the Latitude for the hop position.

 Distance Offset (%): sets an offset to the distance of the camera from the
destination.

* Distance: Changes the distance from the map.

* Diameter: Sets the desired view as Diameter (and not distance)
¢ Pan: Sets a pan value for the camera.

¢ Tilt: Sets a tilt value for the camera.

Note: Pan and Tilt parameters will be disabled unless the Pan & Tilt Animation
parameter in the Navigator plugin is enabled (On).
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13.29.4 Geometry

[ Wep | Absolwe | Gemmem|  Gnk |

weght TR wax | Averase

M

Goto Map | Map| Take Current Values Fly To Map |r‘ﬂt LEL]

Add Linked Hop || 7|

Geometry uses the current location from the 3D Region plugin (center of the region
values). Add offsets for fine tuning.

See the Map and Absolute sections for descriptions of the parameters.

Note: Pan and Tilt parameters will be disabled unless the Pan & Tilt Animation
parameter in the Navigator plugin is enabled (On).

13.29.5 Link

KavFinder Plugin

T Mol | Geomety  ERER
Region Level Up Tnterpolation | [INGHEEE

M

2 nce |—
I'Geto Map|| Take Current values | Fly To Map |[Get Map
Add Linked Hop || 7|

The Link mode is used when one hop resides as a child of another hop. the child
hop is set to link. When changing the top hop, the child hop will change accordingly,
maintaining the same animation that was created during the design.

[UEERERT Region | l.evel I.Ip Tnterpolation
R Height || | Max [ average
L] e

In Country and Region mode the navigator position will be based on the country or
region where the destination (link source) is, whereas in Level up mode the navigator
position will be one administration level (e.g. Place is leveled up to Town) above the
destination (link source). In Country, Region and Level Up mode you have the following
settings:
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+ Distance Offset: Sets an offset from the calculated distance after the top hop was
changed.

¢ Pan Offset: Sets an offset from the calculated pan after the top hop was changed.
« Tilt Offset: Sets an offset from the calculated tilt after the top hop was changed.

In Interpolation mode you have the following setting:

* Interpolation: Navigator position will interpolate between the gap above and
below (useful for a drill down with a pause in the middle)

In Offset mode you will have the following settings:

¢ Longitude Offset: Sets an offset from the calculated hop longitude location after
the top hop was changed.

* Latitude Offset: Sets an offset from the calculated hop latitude location after the
top hop was changed.

¢ Min Distance/Max Distance: Sets the minimum and maximum distance from the
map. Using the same parameters for both settings gives you a fixed distance.

See the Map and Absolute sections for descriptions of the other parameters.

13.30

Page 258

Navigator

.
e,

Mavigator

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The Navigator plugin enables the user to create realistic animations from one point
to another on the map (for example fly over a flat map or globe). It is also used for
navigating on a map (moving the camera) to a defined location using pan and tilt
values.

Note: Only containers with a NavFinder plugin will be refreshed.

Note: Orthographic cameras are not currently supported by Viz World.

This section contains information on the following plugin editor views and buttons:

e Camera

¢ Animation
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13.30.1

e Miscellaneous
e Advanced
e Common Buttons

¢ Known issues

Camera

Position

Navigator Plugin (14.0.0)

w Miscellaneous | Advanced

Camera
Longitude
Latitude

Calculate Animation Center Map | Refresh All Maps || 7 |

The Position button displays the camera position parameters.

* Camera: Defines the camera that will be affected by the position parameters.
* Longitude: Defines the Longitude camera position on the map/globe.

¢ Latitude: Defines the Latitude camera position on the map/globe.

¢ View: Defines the Camera’s view distance from the map.

e Pan: Defines the Camera’s pan value.

» Tilt: Defines the Camera’s tilt value

Advanced

a Flugin (14.0.0) i
POCERERE Animation || Miscellansous | Advanced
" postion I Ravanegd ™|
——
View Units | Distance M

Navigation Method
Update Frol er Transformations [ DisaBiEd 0 INERSEENNN

| Calculate Animation Center Map | Refresh All Maps [l

The Advanced button displays the advanced camera parameters.

¢ Roll: Sets the roll value of the camera. This parameter is enabled only if the Keep
The Horizon Horizontal parameter is set OFF.

* Keep The Horizon Horizontal: When set ON, the horizon will always be horizontal
and roll movement will be disabled.

¢ View Units: Sets the way the number entered in the View field (see Position) will
be treated. Distance defines the number of Viz units from the camera to the map.
Visible View is based on the view (i.e. how many km/miles and so on) you see in
units defined by the 3D Map Setting Plugin plugin.

* Clipping Plane Control: Defines the distance range that will be drawn by the
camera. Objects located closer to the camera than the Near parameter and objects
located farther that the Far parameter will not be drawn.
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e Static (Viz): Draws the objects within the clipping plane values defined in Viz.
For Viz 2.x see Setup->Camera->Camera Clipping Plane. For Viz 3.x see Scene
Settings->Renderer->Camera Clipping Plane.

* Navigator: Adjusts the clipping plane values according to the camera position.
This is automatically done by the Navigator plugin based on the Near Distance
and Far Distance parameters.

* Near Distance (%): Defines the percentage of the camera distance from the map,
which will be used as the Near distance of the clipping plane.

¢ Far Distance (%): Defines the percentage of the camera distance from the map,
which will be used as the Far distance of the clipping plane.

+ Navigation Method: Allows you to select whether the camera or the container
should be moved when a map changes position. If you select camera, the camera
will move when you reposition the map, potentially moving other objects out of
frame. If you select container, you will move the container instead of the camera
keeping other objects in view as the camera will be still. In other words you are
moving the base map instead of the camera in order to see other parts of the map.
Setting it to container also means you do not have to use the front layer using two
cameras in order to achieve the same effect as when moving the container. Also
you will not have to reload borders and other elements on the map as it can be
preloaded once for the base map. Note that you can only do this with a flat map
(not a globe).

¢« Update from Container Transformations: Used in interactive mode. When
enabled and the navigator container is moved or scaled, the values (lat, long,
distance) in the Navigator plugin are updated.

13.30.2 Animation

Page 260

The Animation button displays the camera animation parameters. There are two
parameter tabs: Basic and Advanced.

Basic

Navigator Plugin (14.0.0)

« Number of Hop Points: Sets the number of key frames (hops) used in the
animation.

*« Hop Duration Mode: Defines the time gap between two key frames.

¢ Fixed: Uses the same duration as set in the Hop Duration parameter for all
hops.

¢ Auto: Automatically calculates the duration of the animation between hops.
Minimal hop duration will be based on the Hop Duration parameter and the Hop
Min Time parameter.

¢ Manual: Disables the Hop Duration parameter. Enables the user to set hop
duration manually in the stage editor.
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* Hop Duration: Sets the animation length, between one hop to another, in seconds.

* Hop Min Duration (%): Sets a minimal time for each hop when Hop Time Mode is
set to Auto.

¢ Stop Type: Defines the animation behavior at each hop.
+ Disabled: Enables the animation to only use stage properties.

e Stop Points: Enables the animation to stop at each hop point and wait for a
continue command.

¢ Pause Points: Adds a pause point to each hop. An additional parameter, Pause
Time, will be added to define the pause length in seconds.

* Flyover: Simulates a flight pass over the hop points in a spline path, using the
Flyover Minimal Height parameter. When selected, additional parameters will be
enabled.

* Per Hop: The user will set the hop stop type in the NavFinder plugin. Different
stop types can be set for each hop.

e Stop At First Hop: Defines whether a stop point will be added to the first hop (the
beginning of the animation). The parameter is enabled only when using Stop Points
or Pause Points as the Stop Type value.

* Pan & Tilt Animation: Enables or disables the pan and tilt values of the camera of
each hop in the animation. When enabled (On) this setting will enable the Pan and
Tilt values for the NavFinder plugin.

* Progress Profile: Defines timing profile between stop points of animation. Smooth
option causes the animation to ease in and out of hop points.

Basic - Flyover

Disabled || Stop Foints Pause Paints | [INFGUERN| PerHop |
Stright [T Emall Curve | PHEdmCorve™  Large Curve |
[lREEET|  FastPass | SlowPass | Pause Points |

[POWEE st ([ Gast [ Firstélast

a0 SR

* Flyover Path Profile (Stop Type is set to Flyover): Defines flying curve profile
(curvature) of animation path.

* Lag On Point: Similar to "Flyover Path Profile" button, but defines timing profile of
the flyover animation.

¢ Flyover Minimal Height: Sets the minimum flyover height in centimeters.

Advanced

WEvEr | On Stops || On Start Enimation
i B West

Calculate Animation || Center Map | Refresh All Maps || 7|

The Advanced tab:
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Preferred Flight Height: Defines the camera height that will be used in the
animation between the hops.

Preferred Flight Style: Defines the camera movement between the hops.

e Zoom: Enables linear movement from hop point to the high point and back into
the next hop point.

¢ Auto: Calculates the movement according to distance, height, and so on.
¢ Flyover: Enables a smooth movement from one hop to another.

Preferred Landing: Defines the animation behavior when approaching the hop
points.

¢ Helicopter: Uses a steeper approach to the hop point.
¢ Auto: Calculates the approach according to distance, height, and so on.
« Airplane: Uses a flatter approach to the hop point.

Note: The drifting options allow camera pan and tilt drifting during the
animation. This option is used to give the animation movement a kind of
satiate feeling.

Pan/Tilt Drifting (deg): Defines the amount of pan/tilt change for each cycle. The
cycle is defined by the parameters Drifting Pan Time (Frames) and Drifting Tilt
Time (Frames).

Drifting Pan Time (Frames): Defines the time to complete a full turn of the pan.
Drifting Tilt Time (Frames): Defines the time to complete a full turn of the tilt.

Drift Phase Shift (%): Defines the offset between the pan movement and the tilt
movement.

Drifting Pause: Defines whether the drifting should stop at the start point or during
stop points. If Never is selected drifting will not stop.

Flight Direction: force the direction of the flight. Default is the shortest route to the
next hop. If East or West is selected, flight route will be set according to the selected
option.

Miscellaneous

The Miscellaneous button displays the editor view for setting interactivity and label
related parameters.

Interactive

[ Caleutats Anmation | Centar vap || Rafrash Al aps [ 7]
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¢ Interactive Mode: Defines the interactive behavior of Viz. Available modes are
None, Editor, On-Air, Always Fly To and On “i".

¢ None: Disables interactive mode.
* Editor: Enables interactive mode during scene editing.
¢ On-Air: Enables interactive mode when Viz Engine is in On Air mode.

* Always: Enables interactive mode during scene editing and when Viz Engine is
in On Air mode.

* Fly To: Defines destination properties. Available Fly To options in Interactive
mode are Country, Region, Sub Region and Home. Country makes the camera
animate to the country in which the mouse was clicked. Animation will stop when
the camera reaches a distance from the country as defined by the Extra Zoom
Country parameter. Region makes the camera animate to the region in which
the mouse was clicked. Animation will stop when the camera reaches a distance
from the region as defined by the Extra Zoom Region parameter. Sub Region
makes the camera animate to the sub region in which the mouse was clicked.
Animation will stop when the camera reaches a distance from the sub region
as defined by the Extra Zoom Sub Region parameter. Home makes the camera
animate to the position defined by the Home Lan, Home Lat and Home Distance
parameters.

¢« On “i”: Enables interactive mode during scene editing and when Viz Engine is in
On Air mode, when pressing the “i” key while using the mouse to navigate.

* Interactive Anim: When enabled (On), user activated animation from the current
map position to the current selected hop is enabled. This animation is triggered
by the user in the NavFinder plugin, by pressing the Fly To Map button. The Fly To
option will enable the user to select a point on the map, by clicking the mouse, and
the animation will run from the current camera position to the selected point.

* Extra Zoom Country: Defines the extra zoom value added to the camera
animation when animation destination is a country. The camera will zoom in to the
selected country until the bounding box of the country will fill the render window.
The extra zoom will define an additional zoom value to the final camera position
calculations.

« Extra Zoom Region: Defines the extra zoom value added to the camera animation
when animation destination is a region. The camera will zoom in to the selected
region until the bounding box of the region will fill the render window. The extra
zoom will define an additional zoom value to the final camera position calculations.

* Extra Zoom Sub Region: Defines the extra zoom value added to the camera
animation when animation destination is a sub region. The camera will zoom in
to the selected region until the bounding box of the sub region will fill the render
window. The extra zoom will define an additional zoom value to the final camera
position calculations.

« Home Lon: Defines a longitude value for a home point.
« Home Lat: Defines a latitude value for a home point.
« Home Distance: this parameter defines a distance from a home point.

Labels

Labels [ovEET R CI R onves | Onwasalng
2 =y
T

Label Camera F

* Labels: Defines the label behavior. The Labels setting will override all labels (in all
levels of the hierarchy) under the navigator container.
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¢ Overlay: Places labels on a plane in front of the map (see Label It for
description). When this mode is selected an additional parameter will enabled,
Label Camera, which defines the camera to be used for the labels.

¢ On Map: Places labels on the map.

13.30.4 Advanced

Page 264

Navigator Plugin (14.0.0)

Helicopter Lift Duration 10.0 ,:F

[ Hard T G Sof

[ Herd T WG Sof ]
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100.0 =
1000.0 TEF
Update Stage In OnAir [off | moR|
World Center Mode mg
World Center Longitude 0.0 EF
World Center Latitude 0.0 J‘EF
| Update World Center || Use Current Values |
[""Calculate Animation || Canter Map || Refresh All Maps || 7 |

The Advanced button displays additional animation parameters.

* Helicopter Lift Duration: Sets the time, in seconds, for the helicopter to go out
from a hop point to the high point in the middle.

¢ Helicopter Smooth Level: Sets the animation smoothness between one hop to
another. This parameter will affect the animation path when a helicopter flight is
simulated.

¢ Airplane Smooth Level: Sets the animation smoothness between one hop to
another. This parameter will affect the animation path when a Airplane flight is
simulated.

* Tilt Smoothing: This parameter is enabled when the Pan & Tilt parameter in the
animation tab is enabled. When set to On, an additional parameter, Tilt Smoothing
Rate, is enabled. Set the required smoothing value for the tilt animation,

* Distance Mode: Defines how the camera distance from the map during the
animation and at the hop points will be calculated:

* Regular: Sets the distance that is calculated by the Navigator plugin based on
the hop locations and distance from map as set by the user.

¢ Fixed: Sets a fixed distance for the camera while animating between the hops
and at the hop point. When set to fixed, User selected distance at the hop point
is ignored.

¢ Minimal: Sets the minimal distance to which the camera will descend at the
hop points and during the animation. If the calculated distance is larger than the
minimal value, the camera will use the calculated distance.

* Boundaries: Enables you to define a minimal and maximum distance.
¢ Min Distance: Sets the minimal distance value.
* Max Distance: Sets the maximum distance value.
* Face North: The camera will always face towards the map’s north.

* Update Stage in OnAir: Defines whether the stage will jump to the hop position
when updating a map in OnAir mode.

e World Center Mode: Offset the world center to use the values entered instead of
the center of the base map.
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* World Center Longitude/Latitude: The values you would like to use to set the
world center.

« Update World Center: After changing the values you need to press this to
update all plugins.

¢ Use Current Values: Take the current values from current camera position and
use them.

13.30.5 Common Buttons

* Calculate Animation: Re-builds the animation between the hops using the
parameters defined in the plugin.

¢ Center Map: Aligns the center of the map with the center of the screen.

¢ Refresh All Maps: The Navigator plugin will search its sub-tree for containers with
CWMClient and NavFinder and refresh the CWMClients maps.

13.30.6 Known issues

* Rotation, scaling and translation above the Navigator container might affect the
plugin behavior. Do not apply any rotations above the container in the hierarchy
and use only the pan/tilt parameters of the plugin to control the orientation of the
camera.

13.31

NavScale
NavScale
N

Mavscale

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The NavScale plugin maintains the scale of an object, related to the screen, during the
Navigator animation. The plugin is placed on a child container under the Navigator
plugin, and it will maintain the its defined scaling throughout the animation.

Properties

NavScale Plugin (14.0.0)

Scale On Distance Factor 100.0] FF

e

¢ Scale On Distance Factor: Sets the value of the Scale On Distance Factor
parameter to the required number by modifying the scale factor and checking the
result in the renderer.

Note: This factor does not use any measurement units, but it calculates the
object’s scaling using a number of parameters from the Navigator plugin.
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13.32 NavSlave
=
v |
Na\rS‘I’a\re‘j
The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps-Adv.
The NavSlave plugin creates a relation between its container and a Navigator plugin
container in the scene. This plugin will lock the NavSlave container to the longitude and
latitude values of the Navigator plugin. The plugin will search the hierarchy above it for
the navigator container.
Properties
NavSlave Plugin (14.0.0)
Altitude
Tangent To Globe -
=
* Altitude: Defines the altitude of the object in relation to the Navigator container.
« Tangent To Globe- When enabled (On) sets the object to move over the globe
surface.
13.33 Place Finder
Finder
A
L/
The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.
The PlaceFinder plugin is used to generate a map or map animation without having to
actually select the map, but using “rules” in order to define what map you will get.
There are two ways of selecting a map location. The first is simply by entering
longitude and latitude values, whereas the second is based on searching the map
database for the location and using the first value (that was ranked the highest). Since
you as a user cannot select the final location out of a list it is important to enter more
information in order to make sure the correct location is found.
If you are looking for Paris, Texas in USA, and you are simply entering “Paris” you will
end up in Paris, France because the capital of France is ranked the highest. Searching
for “Paris USA” will give you a town named Paris in the USA; however, searching for
“Paris TX USA” or “Paris Texas” will give the result you are looking for.
This section contains information on the following topics:
e Location
e Labels
¢ Regions
* Advanced
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13.33.1 Location

Longitude

Latitude

Lat/Long

Adminl Admin2 Default Size

* Longitude: Map center Longitude. Changing the value will not affect the map until

you hit “Take”.

¢ Latitude: Map center Latitude. Changing the value will not affect the map until you
hit “Take”.

* Long/Lat Format: Set the format of the incoming data as either Long/Lat or Lat/
Long.

* Longitude/ Latitude: Map center Longitude and Latitude in one field (very useful
for external control). Changing the value will not affect the map unless the last
characteris ;.

¢ Search: Map location to search for. Click the Take button to perform the search.

* Frame by Search Result: If enabled (On) the result of the search is used to frame
the location.

e Zoom level: How the map should be framed. This option is relevant if the map
center is based on longitude and latitude values (and not a search location), or if the
“Frame by Search Result” is not used.

» Default size is based on Default Map Size.

e Country, Adminl, Admin2 is first trying to find the relevant information (e.g.
country and so on) and will fail for example if map center is in the sea. Next it
will use the bounding box of the user selection (please read about the Texas
example in the Place Finder introduction section).

e |f the user selects Admin2 the map’s frames will be based on Lamer County
which is Admin2 in that specific Longitude and Latitude.

e |f user selects Adminl the map’s frames will be based on Texas which is Adminl
in that specific Longitude and Latitude.

e If user selects Countryl the map’s frames will be based on USA which is the
country for that specific Longitude and Latitude

¢ Map Center: Allows you to center the map based on a point or a frame. If you
search for Beijing, China your map can be centered around the point identified as
Beijing. This may, depending on your zoom level, leave parts of Beijing out of the
frame. Alternatively, you can center your map based on the frame that captures the
entire Beijing area in view.

* Default Map Size (Deg): Defines a default map size for those areas that cannot
be framed using predefined administration levels (e.g. international waters).

 Extra Zoom: Adds an extra zoom to the map in percentage (0.001-100%).
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13.33.2 Labels

13.33.3

13.33.4

Page 268

PlaceFinder Plugin {14.0.0) F
T Towaton BRI Regions || Advanced

tLobel [T G| SR Tg
s o BT

Add Search Result Label: Adds a label based on the search result.
Add Region Label: Adds a region label based on the Zoom level you selected.

Note: Short will only add the location name, while Long will add more
information (e.g. country and so on).

Add Event Label: Adds event based labels (e.g. floods, fire, festival). In order to
use different designs you can use a pipe symbol ( | ) as separator, e.g. “Fire|Fire in
LA” will use a design named Fire and the text will be Fire in LA. Changing the value
will not affect the map unless the last character is ;.

Label Designs: Location for Label designs. Normally the plugin resides next to
CWM client plugin and it will use its designs, or the global designs.

Label Holder: Location for Label holder. Normally the plugin resides next to CWM
client plugin and it will use its holders, or the global holders.

Auto Labels Holder: Defines the location of the Automatic Labels Holder.
Automatic labels are labels generated based on the boundaries of the map.

Regions

FlaceFinder Plugin (14.0.0)

T laton [ sbels |[REgRTT|  Advanced |
[ Dlssbied | PEREORIPIN Frame And Belew | Rl

3DRegions: Should 3D regions be added? Relevant only when “Zoom level” is set
to one of the region types (i.e. Region/Country/Admin1l/Admin2/Sub_region).

3DRegion Designs: Location for 3D region designs. Normally the plugin resides
next to CWM client plugin and it will use its designs, or the global designs.

3DRegions Holder: Location for 3D region holder. Normally the plugin resides next
to CWM client plugin and it will use its holders, or the global holders.

Advanced

PlaceFinder Flugin (14.0.0)

[ mten [ ke R | PmERETT
[ Ter0E  PwSEEROE  Twemsl | Vb

| Enabled
e T

i

Copyright © 2016 Vizrt



Viz World Client and Server User’s Guide

¢ Search: Defines which server data to search in (i.e. map data base, street data
(map data base + street data), or Web) This works the same way as in the Classic
client.

* Immediate Response:

« Disabled: (default). To initiate the search, either type the term with ’;" at the end
or press the take button.

¢ Enabled: Changes the search so that every letter typed will initiate a search.
¢ Status: Provides the status of the search.

13.34

Publish To Design

oDes

PublishTeDe

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps-Adv.

Enables updated parameters to be set directly to the design they came from (either
container hierarchy or object pool) by pressing Publish To Design or create a new
design out of modified data by assigning a new name under the New Design tab.

Properties

PublishToDesign Plugin (14.0.0)

Publishing Target | original Design || NEW BasigA|

Design Name

:De.signs

_ Town_1m
Designs Town_100k

* Publishing Target: Publish using the original design or create a new design.

 Design Name: Sets the new name for the new design or select a design from the
Designs list.

* Publish To Design: Sends the label back to where it came from but it does not
refresh the scene.

¢ Publish And Refresh: Sends the label back to where i came from and refreshes
the scene.

13.35

Region to Texture

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The plugin is used to simulate shadow effects for 3D regions. This is achieved by
creating a texture of a region’s contour. The plugin works in two modes: by creating a
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single texture that applies to all regions in the scene or by creating multiple textures
that applies to each individual region.

In order to work with a single texture the plugin must be placed on the Region Holder
container.

In order to work with multiple textures the plugin must be placed on a container
above the 3D Region container.

This section contains information on the following topics:

e Properties
¢ Working with Region to Texture

Properties

Shift Amount

* Dynamic Shift: Shifts shadow texture more when Navigator is farther away. This
could be used to better see the shadow from farther distances.

*« Dynamic Shift Amount: Sets the extent of the Dynamic Shift.

* Attach to Light: When enabled, light direction will be considered according to
the positioning of the shadow texture. When disabled, Shift Direction allows you to
manually set the direction of the shadow.

* Light ID: Sets the ID of the light to be considered.

* Texture Size: Sets the size of the shadow texture. The larger the texture, the
better is the visible quality; however, it also requires more rendering time.

¢ Blur Amount: The extent to which the texture will be blurred to resemble the
appearance of a shadow.
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Shift Direction: Sets the shift direction of the shadow manually and according to
the region. This setting can only be used if the Attached To Light setting is disabled
(Off).

Shift Amount: Sets the amount of shift.

13.35.2 Working with Region to Texture

To create a simple Region to Texture scene

10.

11.

[Virtual Set’

MapBuilder Plugin (13.0.0)

Add the Map Builder Plugin plugin to the Scene Settings
Save the scene
Open the Map Builder Plugin editor and click Launch Wizard

¢ This will open the Map Builder. Note that it may open behind Viz Artist.
From the Choose Scene Type dialog box select Navigator

Click the Base Map

e This will open the Viz World Maps Editor

Select a stylesheet for your map and click OK

Click the map for Destination 01

e This will open the Viz World Maps Editor

Click the Browse Map button (see Map Tool Bar) and select two regions (e.qg.
Trentino-Alto Adige and Lombardia in Italy) and click OK

Click Build
Save the map template file to your desired location (e.g. C: \Temp\Maps\)
¢ Once saved, the map scene will be generated

For creating a single texture do the following:

1. Navigate the scene tree to the Region-Holder container found under
object -> MapAndHops -> GeoReferenceMap -> Holders ->

2. Add the Region to Texture plugin to the Region-Holder container
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12. For creating multiple textures do the following:

1. Navigate the scene tree and split the Region__<name> container found
under object -> MapAndHops -> GeoReferenceMap -> Holders ->
Region-Holder -> Destination-n

2. Add a new group as a sub-container of the Region__<name> container
3. Add the Region to Texture plugin to the new group container
13. Open the Publish To Design editor and click the Publish and Refresh button

14. To adjust the textures, split the merged region containers and adjust the settings
available in the Region to Texture editor

13.36

Page 272

Screen Scale

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps-Obs.

Caution: The ScreenScale plugin is no longer supported (discontinued) and
should not be used. The plugin is installed for compatibility reasons only. The
NavScale plugin should be used instead of the ScreenScale plugin.

The ScreenScale plugin is used in order to keep an object in the same size regardless of
the camera movement.

Screen Lock Off

screenScale Plugin (14.0.0)

[GRT  Size lock | Pixel Lock

Other

* Screen Lock: Defines the way the screen and the ScreenScale object interact:

e Off: Scales the object holding the ScreenScale plugin normally with camera
movement. When enabled (On) the Camera parameter is made available.
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¢ Camera: Defines the camera for which the object will keep its scale when the
camera is moved.

Size Lock

¢ Size Lock: Locks the object scaling, and sets the Scale Factor to resize the object
while keeping the scale fixed.

¢ Scale Factor: Sets the scale factor.
Pixel Lock

* Pixel Lock: Locks the object according to the defined number of pixels by the Lock
Size (px) parameter, by Width or by Height.

* Lock Size (px): Sets the number of pixels for the Pixel Lock.

Caution: The ScreenScale plugin is no longer supported (discontinued) and
should not be used. The plugin is installed for compatibility reasons only. The
NavScale plugin should be used instead of the ScreenScale plugin.

13.37 Trace lt

4
Tracelt

The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The Tracelt plugin is used to place the 3D object it is attached too over a line, created
with the 3D Line or Shape to Spline plugin, and follows the line’'s end point. The object
will follow the line animation as the object with the Tracelt plugin move with the 3D
Line/Shape to Spline end point.

This section contains information on the following options:

e General
e Camera

e Advanced

13.37.1 General

Tracelt Plugin (14.0.0)
I Garers | Advenced
Progress 0 .Cl ;r
Height 0.0 ;r
Smooth Direction (%) 10.0 ;r

Quality . T T
— ovgeter | Save | Waser

* Progress: Indicates the animation position of the 3D Line/Shape to Spline object.
This field is disabled and cannot be modified.
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When using Shape to Spline, Tracelt uses the ShapeToSpline field Trim End to control
the progress. Trim Start and Trim Offset must be '0'. Also, if the data originates from
a KML file, the progress is calculated in geographic units, otherwise viz units.

* Height: Defines the 3D object’s height in relation to the line object.

* Smooth Direction (%): Defines the object’'s motion behavior when changing
direction. When set to a low value the direction will change faster.

¢ Quality: Tells the plugin which resolution to track when tracing a border that by
default has 3 levels of detail (LOD). Available options are High, Medium and Low.

* 3DLine: Defines the 3D Line/Shape to Spline container that the Trace It plugin will
follow.

e Previous: Follows the animation of the 3D Line/Shape to Spline plugin in the
previous container.

* Above: Follows the animation of the 3D Line/Shape to Spline plugin in the above
container.

¢ Container: Follows the animation of the 3D Line/Shape to Spline plugin in the
container dragged to its container place holder.

* Progress Control: Defines how the object’s progress will be controlled:
* None: The progress id manually created by the user (stage animation).
* Navigator: Follows the animation of the Navigator plugin.
* Slave: Slave to the 3Dline plugin which is the source of the trace.
¢ Master: control the 3D line plugin progress which is the source of the trace.

Camera

Tracelt Plugin (14.0.0)

[ General [T Advanced

Progress 0.0 ;r

2O
2O

Start Hop

Map-Start

The Camera tab defines the mode for camera tracking.

* Progress: Indicates the animation position of the 3D Line/Shape to Spline object.
This field is disabled and cannot be modified.

* Trace Camera: Manually driven (standalone) or control a navigator’'s animation
between a specified hop and the corresponding one. Available options are Off,
Navigator, Standalone, General and Locks.

Note: When using Shape to Spline, no tracing is possible in non-geo mode, either
with camera or without

« Off: No camera tracing.
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Navigator: trace the camera animation between the selected hop and the
following hop.

Standalone: trace the camera animation between the selected hop and the
following hop.

¢ General: the general tab defines the tracing parameters:

Smooth Camera Position (%): Smooth camera position path
Smooth Camera Direction (%): Smooth camera direction path

Start Hop: Select a hop in the Navigator animation. The camera trace will be
inserted between the selected hop and the next one.

Update Hop Data: updates data in NavFinder plugins where the camera trace is
inserted (actually sets start and end values of the tracing route to insert camera
trace smoothly to the navigator animation).

* Locks: the locks tab enables the user to lock camera animation parameters:

Lock Pan: when set ON, the camera pan will follow the path direction. When set
Off, pan animation will be use the navigator parameters.

Pan Offset: Set the pan offset to path directions.

Lock Tilt: when set ON, the camera tilt will follow the path direction. When set
Off, tilt animation will be use the navigator parameters.

Tilt Offset: Set the tilt offset to path directions

Lock Distance: when set ON, the camera distance from the map during the
animation will be use the Distance parameter value. When set Off, the distance
during the animation will use the navigator parameters.

Distance: Set the distance to use during the animation.

13.37.3 Advanced

Tracelt Plugin (14.0.0)

| General | Camera  WRGvBRESA™

— oo

Overlay

e

* Segmentation: When tracking, a line can be split into different segments (for
example a region might have several islands) the segmentation option tells the
Trace It plugin what segment to track. Available options are Auto, Largest, Sectioned
and All.

IMPORTANT! Maximum number of line segments are 10000. Shape files that
exceed this limit will result in lines not being drawn.

Overlay: Transfers the object from a position on the actual map to a position in a

different camera (similar to the Label It plugin’s Overlay options).

Note: Shape to Spline has no button for controlling splitting dateline (whereas 3D Line
uses Enable World Periodicity).
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13.38 World Image Refresh
=
Yy
image Refrsh
The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Weather.
The WimageRefresh plugin is placed on a map container and when the map is changed
the WimageRefresh plugin will refresh objects residing under the map container. This
action will cause all the geographically referenced objects, under the map container, to
recalculate their position and move to the correct position according to the new map.
This plugin has no parameters.

13.39 World Position

ition
oy
-
B\
WMrPosition
The plugin can be found in the folder: Viz Artist 3: Built Ins -> Container Plugins ->
Maps.

The WPosition plugin is used to place an object over a geographically referenced map
by setting the Longitude, Latitude and Altitude parameters. When the object is moved
over the map, the current values of Longitude, Latitude and Altitude will be updated in
the WPosition plugin. The object with the WPosition plugin must be placed under a map
in the hierarchy.

This section contains information on the following options:

e Simple

e Advanced

13.39.1 Simple
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WPosition Plugi